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What is KBPublisher?

KBPublisher is a knowledge base which allows you to share information with employees, customers and partners.

A fully featured knowledge base that combines powerful WYSIWYG editing with easy to use functionality
Unique design and workflow enables you to create and approve articles and files before they are made available to other
users
The separate File feature means that your existing documentation can be easily inserted
Can be integrated into your company intranet or internet
Repeatable, reusable content through templates, file attachments and categories
KBPublisher is highly customizable
Full control of users, what they can do, and what they can see
Can be configured to work in almost any language
Import facility allows you to import users and articles from your old system in bulk
Remote authentication allows you to integrate your current user authentication system with KB Publisher.
An area to post announcements
Subscription facility allows users to be notified of changes
Version history that allows you to keep track of changes to articles
Export facility allows you to export articles or whole knowledgebase to PDF or HTML
Reports that provide statistics on users and articles

Public area

Where site visitors, staff read articles, view files, supply/request feedback
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KBPublisher navigation gives you quick access to:

Articles - read articles in the knowledgebase
Files - view attached files
News - read announcements
Feedback - ability to contact administrator
Glossary - a glossary of terms
Comments - users can add comments to articles
Ratings - users can rate content
RSS feeds
Email notifications - users can be notified when an item is changed

Administration area 

Where staff create, edit and publish articles, upload files, moderate the
knowledgebase and manage users
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Where those who prepare and approve the content:

Create articles
Have them approved and published (or publish them direct)
Schedule them to go live at on a specified date
See history of changes to articles and revert back to earlier versions if required
Upload files
Automatically add any file uploaded to you server to the knowledgebase
Moderate feedback
Manage comments
Bulk import articles from other sources
Manage categories
Manage users
Import users
Generate statistical reports
Access log files
Export articles as PDF or HTML files
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KBPublisher Uses

Attach it to your company web site or use it standalone in order to:

Share information with customers and partners
Provide support for products
Answer a list of frequently asked questions
Create a user manual, technical reference or APIs for your software

Use it with your intranet or standalone in order to:

Share information with employees or other team members
Set up and use policies and procedures
Use it as a support help desk
Manage project documents and other content
Provide training materials
Share other company information

The three different category types allow you to display the knowledgebase in a standard knowledgebase format, as FAQs on a page,
or as a table of contents for a book or online help.

KBPublisher is highly customizable. You can use it straight out of the box, or you can customize it to match your company design and
requirements. The ability to create your own categories means you can organize your topics any way you wish. You also have
complete control over who sees content, and when they see it.

KBPublisher can be pretty much anything you want it to be
It's a knowledgebase

First and foremost, KBPublisher is a knowledgebase. Use it to share knowledge with others. Articles, white papers, user manuals,
business processes, FAQs, online help, APIs and any other type of information you need to share.

It's a content management system

This user manual was written in KBPublisher.

We created repeatable, reusable chunks of content with templates and inserted them into articles where needed. We used the link
and attach features to link to articles and files. We used categories to place each article exactly where we wanted it to be in multiple
sections of the manual. We used privileges and types to control who could edit and who could view which sections of the manual.
Had we wanted to, we could have used templates to create standard page formats to force our authors to use a consistent style
throughout. Lastly, we used content type 'Book' to display the articles as a table of contents.

A help desk

You can use the Feedback option to create a simple help desk request system where the user logs a support request and you supply
an answer either by emailing them back, posting an answer on the knowledgebase, or both. Other users can add comments to any
postings. You can use the Supervisor function to route different requests to different people to answer. If you are really keen (and
know a bit about HTML forms), you could set up forms in templates and have the user post these as help desk requests.
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Public Area (front-end)

The public area in KBPublisher is what people who are reading the articles or looking at the files see (as opposed to the admin
area, which is what authors, editors, moderators and administrators see).

Whether or not a user has to log in to view the public view depends entirely on how you have set up your knowledgebase. It can be
set up in any of the following ways:

Everyone who accesses your site can read the knowledgebase
Anyone who wants to read the knowledgebase must register and login
Part of the knowledgebase is available to anyone who visits your site while you must log on to view other parts.

Below is a screenshot of the public view.

Login details are in the top right-hand corner

1. If you are a registered user you can login. Once you are logged in this section shows who you are logged in as, and the option
changes to logout. If your login has author, contributor, editor or administrator privileges, this will also include a link to the
admin view.

If you knowledgebase administrator allows it, you can also register as a user to get access to non-public areas of the
knowledgebase.

This area also contains My Account, which is where you can change your password and user name, manage subscriptions
and personalize some settings.

Menu options (table of contents) can on the left-hand side, on the top menu or above the listed articles, depending on how the
knowledgebase is set up. In this case, it has been set up so that menu options are in tabs across the top of the page.

2. When you first enter the screen the Knowledgebase tab is highlighted, meaning that articles are displayed. Articles are
content that people have authored directly to the knowledgebase.

3. Click on News to see a full list of news items.
4. Click on Downloads to display a list of files instead. These files have been uploaded and may be text (e.g. Word documents,

PDF files), graphics or other file.
5. Click on Glossary to display items in the glossary. While you are reading articles you will come across red words. These words

have been defined in the glossary.
6. Ask a question allows the reader to contact the knowledgebase administrators. You might do this if, say, you couldn't find the
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information you were looking for, had problems using the system, or even if you had an idea for an article.
7. Tags are keywords and phrases which help readers easily find articles related to specific topics.
8. Site Map allows visitors to get the whole map of your knowledgebase and quickly find required section.

Add article

9. If you have contributor or author access, you will also have an icon. When clicking, a menu of commands opens to allow you to
quickly add articles, news, files, etc.

Search

10. The knowledgebase has both quick search and advanced search. Type text or an article ID into the search field for a quick
search, or you can search on other options using the advanced search.

Categories

11. The Categories section is the table of contents. The user clicks on category items to see sub-categories. Articles in each
category are displayed in the main part of the screen.

Breadcrumb trail

12. The breadcrumb trail at the top of the screen shows you where in the article or file hierarchy. You can click on this links to
move back to a higher level.

The actual content is in the main screen

13. News is displayed at the top of the screen.
14. Categories may also be displayed on the main screen. They can be on the left menu, on the main screen or on both.
15. When you first enter Public area, or click on Knowledgebase or Downloads, the main screen contains two columns. The first

column lists the five articles or files that have been viewed most often.
16. The second column lists the last five articles or columns added. You can click on any of the articles to open the article to read

it.

When you click on an actual article the article is displayed in the main screen, and the article that you are viewing is
highlighted in the left menu.

17. The floating action block displays options you can do to this article. As a viewer you can share the article through socials, email
it to a friend, print the article, export in PDF, add a comment, add to Favorites. Print brings up a clean copy of the text without
associated headings and menus which you can then print using your print button. Email to friend allows you to email a link
to the article to one or more others. You can include your own message with the email.

If you have author or editor access you may also update the article, or see all other articles in that category.

18. The article block displays additional information about the article. The block shows who wrote the article, the date it was
written, who last updated it and when and whether or not the article is public or private. There are more options at the bottom
of the screen. You can rate the article here. When you add a rating, a comment box opens allowing you to say why you rated
this article the way you did.

19. Other users' comments are displayed at the bottom of the screen. The full comment may be displayed, or just a link to it.
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Admin Area (Back-End); Common Actions

This article describes the Admin area home page and reviews the standard information you see and actions you can perform
throughout the Admin area.

Home page
When you log in to the Admin area you see the Home page:

This page has two tabs: Dashboard and Statistics.

To add the information that appears on the Dashboard or Statistics tab, select that tab, then click the Add a module  block. In the
form that appears check the check boxes beside the information that you want to display. Any changes you make take effect when
you dismiss the form.

Dashboard tab

This tab displays a summary of content created by or assigned to you, including your articles and files in draft form, published
articles, and articles and files assigned to you for approval. The content is grouped within each category by status. Click any link to
see a detailed list of the content in that category and status.

Statistics tab

This tab displays counts of articles, files, and users in various categories. Click on any link to see more details. If you are logged in as
an Admin user, you see information for the whole knowledgebase; otherwise you see statistics for your own articles and files only.

Common actions in the Admin area
This section reviews information you can see and actions you can take in the Admin area of KBPublisher. The image shows the
articles screen because it has the most functionality, but the explanations are applicable for working with files and feedback in
the knowledgebase as well.
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The main section of the display is a list, in this case of the articles in your knowledgebase.

To create a new  record, click the [ + ] icon and complete the form that appears.

You can perform certain actions on the articles in the list. Click the [ ... ] on the right in the Action column for an article and choose
from the available options, such as Preview and Edit.

For many columns, you can sort the list by the values in that column by clicking the column header. Click again to reverse the sort
order.

You can adjust how many items appear on each page by changing the number in the Records per page  field.

You can browse from page to page using the << and >> buttons, or by choosing a number from the Pages dropdown list.

Filtering 
You can filter the list using one or all of the fields at the top of the tab:

Category - select a category to display only records in that category. Check the box to the right of the field to also display
records in subcategories of the category you select.
Status - select a status to see only records with that status.
Type - select:

All types (the default, indicated by __)
a type to see records with that type assigned.
Any type assigned to see records which have any type assigned to them.
No type assigned to see only records that do not have a type assigned to them.

Search - enter keywords to search for content with that text in their title or body. Put an asterisk (*) as a wildcard before
and/or after the string you enter to broaden the search. For example, *health* would return content with "health", "unhealthy",
and "healthcare", among other words.

Click the [ → ] button to filter the list. To return to the full list, remove entries to all filter fields and click → again.

Bulk Actions
You can also perform some actions, such as Set Status, on several articles at the same time. To do this, check the check box at the
left end of the row for each article you want to act on, and pick the action from the Actions with selected menu which appears at
the bottom of the page.
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Adjustable List View
The list display gives you information about each article (in this example), including:

Item ID.
If the article is scheduled, indicated by a clock icon.
If the article is private, indicated by a key icon.
When the article was posted and last updated.
The article's title. Click the title to see the article.
The article's category. If it is in more than one category, the number of categories also appears in square brackets. Click the
category name to see just the articles in that category.
The number of views the article has had.
If readers have rated the article, its rating and the number of votes received.
The article's status, indicated by a block of color. Hover over the color to see what the color represents.

List fields are adjustable. Right-click the blue header row and select Customize List to adjust list fields. You can add, remove, and
re-order the fields.
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Searching Knowledgebase

How search works
By default, KBPublisher's search functionality uses MySQL full-text searching, which is a natural language search that allows you to
type in a question or sentence that describes the information you are searching for. The program uses logic to determine the
keywords in the sentence.

Optionally, you can use Sphinx search engine. Sphinx is a full-text search engine that provides fast and relevant full-text search
functionality. For more information, see How to enable Sphinx Search.

What it searches
If you did not specify any search options, the search functionality examines the following:

Article: title, content, meta description, keywords (tags)
File: title, file name, content , keywords (tags)
News: title, content, keywords (tags)

The advanced search allows you to narrow your search to a specific content type or date range, or to restrict your search to titles,
keywords/tags, or entry IDs. In addition, depending on the content type you've selected, extra options let you choose categories or
article types to search.

Special search
If you enter a numeric value in the search box, the search identifies articles or files with this ID number. To find numeric values in
article contents, type the number with quotation marks, such as "123". You can change this behavior in Settings -> Common by
checking or clearing the "Search by Article ID" checkbox.

To force search by article id, type id:[entry_id], which will search articles with this ID, if article exits it will be opened.
To force search by file id, type file_id:[entry_id], which will search file with this ID.
To force search in title only, type title:[search string], which will search articles, files, or news in titles only, depending on which
section you search.
To force search by tags, type tags:[tag1],[tag2], which will search articles, files, or news with these tags, depending on which section
you search.

If special search is applied search string will be highlighted in green, like this.

Search results
The search results page shows the number of results found. For each result, you can see the item's title, a content preview, the
item's location in the knowledge base, the date the item was last updated, and number of article comments.

Search suggest
As you type in the search field, the search engine offers suggested results based on popular content or spelling variations. To have
this option you should follow the steps to enable searching spell suggest, which is off by default.
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User privileges

Any user can read articles, but in order to create articles and to publish them to the knowledgebase, users must have certain
privileges.
For example, to actually write articles a user must have author or contributor privileges. 

To publish the article for other users to read, they must be in the author, editor or moderator privilege groups. KBPublisher comes
with five default privilege groups, and you can also create your own.

There are five default privilege groups.

Administrator sets up the system, controls user accounts, designs the site and so on
Moderator has access to every part of the system except Settings and Import/export. The moderator generally creates users,
organizes categories and manages the knowledgebase on a day to day basis
Editor can add, edit and delete their own and other users articles, files, comments and visitors' questions. This is the person
responsible for the overall content of the knowledge base.
Author provides the actual content. An author can add, edit, delete or publish their own articles and files. When they have
completed an article and published it, the article appears immediately in the article list
Contributor also provides content, and can add edit or delete their own articles and files but the articles and files do not
appear in the knowledgebase immediately. They must be approved by an editor or a moderator. Once an article or file is
approved, the contributor can no longer edit it.

You can also create your own privilege groups.

Here is a quick chart of default user types in KBPublisher

Privilege levels
Each user type has a privilege level. The privilege level defines who can edit users of this level. Users cannot edit other users with
a privilege level lower than or equal to their own.

Admin users always have a privilege level of 1. They can edit any other user.  In the standard setup editors have a privilege level of
3, while authors have a privilege level of 4 and contributors 5. This means that an editor could--if he had edit user access--edit
author and contributor users while a contributor could not edit any users except other contributors (again, and only if he had edit
user access).  None of them can edit admin users.
This gives an extra level of security when editing users.

* Adding comments, rating articles and sending emails to the administrator are all options that can be turned on or off in the
settings. Hence while these options are available, they must also be turned on if you wish to use them.
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User roles

Roles allow you to set up a hierarchy of users and to control which articles users can see.

Roles are set up as tree structures, and when you mark an entry as private to a specific role then users with this role and with
parent roles have access to the article. Any role below it in the tree, and roles that do not belong to 'current tree', will not be able to
access the article.

For example, suppose you have the following roles:

In the above tree the Contractors role has a sub-role of Manager, and below that sub-sub-roles of Beta Tester, Tech Writer and
Programmer.

Users can be assigned to multiple roles.  Thus your programmer could also be an employee. 

If you mark an article private read and assign to it a role of 'Programmer', then contractor managers and programmers will be able
to access the entry. No one else will have access to this article.

Note:

Users with administrator privilege have access to any article in any category.
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Category types

Category type controls how articles in this category are displayed in the public view.
There are four category types.

Standard
The Standard (default) type displays a list of articles, along with one or two lines of text.
If the category has sub-categories, these are displayed above the list.

 

Book
The book type displays items as a table of contents.

 

Quick FAQ
The Quick FAQ type displays all articles in the category on the same page.
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Quick FAQ (interactive)
While the Quick FAQ (interactive) type displays all articles in the category on the same page as well, but with only the titles
displayed initially. Click on the title to display the article, click on it again to hide it. 
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Ask Question and Quick Response

Ask a Question
If you still cannot find the information, you can use KBPublisher's "Ask a Question" feature. As you type in the Question / Comment
textbox, KBPublisher will display articles that might answer your question. If that list doesn't provide the answer you're after, click
Send to email your question to the knowledgebase administrator. Questions can be targeted, too, so that questions will be sent to
different users in your knowledgebase based on the item selected in the Subject dropdown box.

For more information on configuring recipients for Ask a Question submissions, see the following articles:

Set Who Receives Emails
How Can I Route a Question Based on the Subject?
Add New Feedback Subject
 

 Quick Response
By "connecting" your contact form with your knowledge base, your visitors can get instant answers to questions that they would
normally send you via email.

If a user clicks on Ask a question, when they start typing their query into the Question/Comments field, KBPublisher checks what
they are typing and searches for articles that may answer the question.
It presents the five best matches at the bottom of the screen under a heading called 'Do these answers help?'

The five articles returned change as the user types more words.

User Manual v7.5 24

https://www.kbpublisher.com/kb/entry/137/
https://www.kbpublisher.com/kb/entry/336/
https://www.kbpublisher.com/kb/entry/185/


Turning off quick response
This option can be turned off in Settings if you prefer a basic feedback form without this feature.

Go to Admin Area
Click on the Settings menu
On the  Common tab, under Feedback, uncheck Enable 'quick response'.
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Subscriptions

Subscriptions allow you to be notified when:

A single article is changed
Any article in a specified category is changed, or when new articles are added to the category
A single file is changed
Any file in a specified category is changed, or when new files are added to the category
News is added or changed
A comment has been added to an article or file.

When you set up a subscription for a specified item or category, then KBPublisher sends you an email when that file or category is
changed.

You can see what you have subscribed to on the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Article history

KBPublisher keeps a history of all changes you make to the content of an article. 
When you update an article, you can add revision comments to easily track changes.

You can view earlier versions and compare them against the current version to see what has changed.
You can roll back to earlier versions.
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Export articles

You can also purchase our optional plug-in that allows you to export articles in your knowledgebase to PDF or to html pages.

You can do this for the complete knowledgebase or for only one category
You can tailor the export to be generic or to display only those articles a specific type of user/customer can see

Note:

This plugin is an optional extra. It must be purchased separately.
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Custom Fields

You can customize your knowledgebase by adding custom fields.

These custom fields can be defined for:

Articles
Files
News
Feedback form

For articles, the custom fields can:

Be displayed at the top of the article
Be displayed at the bottom of the article
Be displayed after the rating block
Or they can be hidden, for internal use only

For files, fields are for internal use only.  That is, you can see them when you add the file, but the user cannot see them.

Depending on where the field is displayed, you can also include text around the field.  For example, the field may be 'Department',
and the valid value in the field might be 'Sales', but the user might see this as 'Contact the Sales Department for further
information'.

You can show or hide any field in a search form.
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Mobile View

Mobile View is specially optimized working with KBPublisher on your mobile devices - smartphone or tablet. All news and articles are
shown as a list to simplify access. Mobile View is enabled for Public Area only.

Some screenshots below.  

The KBPublisher home page has two banners for navigation and to manage your account: News and Recent Articles.

Main menu opens by clicking on Options (hotdog) button.
You can choose any module or return to home page.
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Settings opens by clicking on User button.
You can switch to the full view or go to your account.
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Map View

 

----------------------------------------------------------------------
This functionality works in version 5.0 and above

User Manual v7.5 32



Automations

Use automations (automated tasks) to check your content regularly and perform certain actions as needed. You can make sure your
articles are up to date, and alert staff to review them when they are not. You can let authors know when articles have been
approved for publication, or let managers know when articles are ready for review.

To access your automations, select Tools from the menu bar. Then select the Automations sub-tab.

Essential facts for automations
Automations are time-based: they act when a time-based event occurs, such as the time since an article was edited exceeding
a specified maximum time.
Automations run daily, at midnight.
An automation must contain a condition that is true only once, or an action that nullifies at least one of the conditions;
otherwise, the automation will run daily, possibly sending unwanted duplicate alerts every time it runs.
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Workflows

Workflows automate processes for reviewing, approving, and publishing articles. This can save you time and make sure articles that
may be ready to publish, but need approval, are not overlooked. If the item requires review and approval before it is published, a
workflow can transfer the item to the worklist of the person who is responsible for approving it. That person can approve the article
or send it back for further edits.

Workflow Flowchart
The image below shows the path the draft of an article or file might have to follow if, after the author has written or uploaded it, one
or more people have to review and approve it before publication.

Essential facts for workflows
Workflows are applied to drafts of articles and files only 
You cannot delete or edit a workflow which in use (is applied to some drafts).
You can have as many approval steps in a workflow as your project's process requires.
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Drafts

The Drafts module lets users create new articles, or modify existing published articles, without interfering with live publications.
Users can create and modify drafts in a separate area until each draft is finished and ready to go live.

The Drafts module lets you require specific contributors to create drafts that must be approved before publication, rather than
publishing their material directly.

To learn about creating and managing your drafts, see Manage drafts.

Essential facts about drafts
Users with admin privileges can create, approve, reject, or delete any draft at any stage in the approval process. 
If a draft has been sent for approval, the author cannot update it until the review is complete. 
Your knowledgebase records approval decisions in a log for future reference.

Drafts and Workflows
When a draft is ready to publish, an approval workflow can route the document or item to the assignees, one or more people
assigned to review such material before publication.

Assignees can approve the article for publication or send it back to the author for more work. They can also provide feedback on an
article. The feedback is compiled and sent to the person who initiated the workflow.

Possible scenarios when a user adds a draft
1. There is a matching workflow

The author of a draft can save the draft repeatedly while working on it until the material is ready to submit. When the user
submits the draft for approval, the workflow assigns it to appropriate assignees. The user has no further access to the draft
until it is approved for publication or returned for further edits.
 

2. There is no matching workflow and the user's privileges do not permit adding articles
The author of a draft can save the draft repeatedly while working on it. However, the user cannot publish the draft, and there
is no way to send the draft for approval. 
 

3. There is no matching workflow, and the user's privileges permit adding articles
The author of a draft can save the draft repeatedly while working on it. When the draft is ready to publish, the user can publish
it. 
Once the draft is published it no longer appears on the list of drafts, and does appear on the list of articles.
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Set up required reading (Must Read)

Must Read functionality allows you to set up a mandatory reading requirement. It allows you to make sure that members receive
information.

When a member signs on to the KB, they are notified that there is a mandatory reading item, and they are directed to it. After
reading the article or news, the staff member acknowledges the new information. The system maintains a list of who has and hasn't
read the Must Read items.
 

Set an item as "Must Read" (required reading)
To set a Must Read requirement for an item:

Create a new article or news item or edit an existing one.
If you are in an article, click the "Advanced" tab.
Select the "Must Read" checkbox.
Fill out Must Read block. For more detail, see the section below.
Click Save.

Set multiple items as "Must Read" (required reading)
In the articles or news listing, check required articles on the left.
From the "Actions with selected" menu at the bottom on the page, choose Set Must Read.
Fill out the Must Read block. For more detail, see the section below.
Click OK.

Must Read input block explained

1. Set or unset reading requirements.
If you update an article set as "Must Read" you have a "Reset read confirmations" option. This resets all read confirmation,
which requires assigned users to confirm it again.
 

2. Select who should read the article.
Audience assignment is very flexible: you can assign all users, all staff users (user with privilege), designate specific users, or
assign to users based on specific roles or privileges.
 

3. Add notes that your users will see with the Must Read notification.
 

4. Set if the reading requirement will expire.
If not checked, Must Read will never expire, and the following rules apply:
- Users who did not confirm it will get a notification until they confirm it.
- All new matched users will get a Must Read notification.

If an expiration date is specified:
- Users who did not confirm it will get a notification until they confirm it or the expiration date is reached.
- All new matched users will get a Must Read notification before the expiration date.
 

5. Force users to read  the article.
OFF (not checked) - Users are notified about Must Read items at login, but are allowed to read them later.
ON (checked) - Users are notified about Must Read items at login, and are not allowed to go further until confirming they have
read all Must Read items. (Exception: Users are still allowed to go to the Admin Area and their own My Account area.)
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Must Read Flowchart
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Installation
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System Requirements

KBPublisher has minimal requirements and should work on any modern server.

Client Side:

Operating System: Windows, Mac or Linux
Web Browser: Internet Explorer 11+ or Chrome, Firefox, Safari.

Server side

Operating System: Linux, Unix, Windows, Mac
Web Server: Apache Web Server / IIS 7.5 or above
Database: MySQL 5.6.5 - 8.0
Scripting Language: PHP 7.2.5 - 8.0
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Installing KBPublisher

The easiest way to install KBPublisher is to use the installation wizard.

The install script is extremely simple. The only action required on your part is to click the next button when each step is completed
and you will be prompted for each action that is required from your side to proceed with installation. However, there are some things
you need to do before you start to ensure the process runs smoothly.

Before you start

Check that:

PHP is installed on your server
MySQL is installed on your server

If any of these are not, install these first.

Install KBPublisher using the wizard

1. Unpack the distribution package

2. Place it somewhere in your web-server's document root, preferably the parent directory of your root web directory. Usually the
root directory will be public_html, httpdoc or www.

3. You can rename "kb" folder as you wish (it will be a part of your URL for knowledge base)
For example if you rename it to "kbbase" and place it in document root directory (document root/kbbase)
the URL for knowledge base will be www.youdomain.com/kbbase/

4. Type http://yourdomain.com/kb/setup/index.php into your browser address line, where is your domain name, and is either 'kb',
if you retained the default, or whatever folder you renamed it to. For example, if you used the domain name in step 3, this
would be www.yourdomain.com/kbbase/setup/index.php.
The installation wizard comes up.

5. Follow the installation wizard instructions.

After the wizard finishes

Once the wizard completes, you need to set up scheduled tasks to ensure the knowledgebase works smoothly.
If you don't set up scheduled tasks then some functionality in KBPublisher will not work.

Check that everything is installed properly

Use the Setup Tests tab on the Home screen of the Admin area to ensure that everything is installed properly.

Notes

We recommend the following directory structure (and this is what the installation wizard creates).

kb_file - for uploads via "Files" module
kb_cache - for cache files
kb - knowledgebase code (rename it as you wish, it will be a part of your URL for knowledge base)
kb_upload - for uploads via HTML editor

The kb_file, kb_cache and kb_upload directories must be writeable by PHP. The installation wizard creates these directories
if you run a Windows. If you have errors that directories are not writeable you need to set up Write permissions, see this
article. However, if you are a Linux user it may fail due to access problems. In this case you will need to create the directories
manually and CHMOD them to 0777.

We recommend that you place the kb_upload directory in the parent directory of your root web directory. If you later decide
to move your knowledgebase to new location it will help you to keep paths correct for uploaded images.

Wizard will try to create database for you, if it can't do it you need to create it manually. 
At the MySQL console, run the following commands:

CREATE DATABASE db_name [DEFAULT] CHARACTER SET [=] charset_name | [DEFAULT] COLLATE [=] collation_name;
GRANT ALL ON db_name TO 'username'@'host' IDENTIFIED BY 'password';

e.g. 
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mysql> CREATE DATABASE kbp DEFAULT CHARACTER SET utf8 COLLATE utf8_general_ci;
mysql> GRANT ALL ON kbp TO 'me'@'mydomain.com' IDENTIFIED BY 'xda44f54fddGHRECT';

Don't forget to set up scheduled tasks .  If you don't set this up you can still create articles and manage
your knowledgebase, but you will lose some of the advanced features. You won't be able to schedule articles, users won't
receive alerts and you won't get any reports.
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Installing KBPublisher manually

If you don't want to install KBPublisher using the install wizard, you can install it manually as follows:

1. Unpack the distribution package.

2. Place the distribution package somewhere in your web server's document root, preferably the parent directory of your root
web directory. For many systems, this will be the public_html directory.

3. By default, the distribution package is in a folder called kb, and this link will be included in the URL of the knowledgebase. For
example, the default URL of the knowledgebase will be www.your_domain/kb/, where your_domain is your domain name.
You can rename the 'kb' folder as you wish. If, for example, you rename the folder to 'kbbase' and place it in the document
root directory, the URL for the knowledge base will be www.your_domain/kbbase/.

4. Create an empty MySQL database to be used by KBPublisher, or use an existing database.

To create a new database run the following commands in the MySQL console:

CREATE DATABASE db_name [DEFAULT] CHARACTER SET [=] charset_name | [DEFAULT] COLLATE [=] collation_name;
GRANT ALL ON db_name TO 'username'@'host' IDENTIFIED BY 'password';

e.g. 

mysql> CREATE DATABASE kbp DEFAULT CHARACTER SET utf8 COLLATE utf8_general_ci;
mysql> GRANT ALL ON kbp TO 'me'@'mydomain.com' IDENTIFIED BY 'xda44f54fddGHRECT';

5. Create your directory structure:
1. Create a directory to store files users upload with the File option. We recommend that you name the directory kb_file

and place it somewhere outside your document root directory. It should not be accessible to web browsers via http.

2. Create a directory to store files users upload through the HTML editor. We recommend that you name the
directory kb_upload and place it in document root directory.

3. Create a directory to store cache files. We recommend that you name it kb_cache and place it somewhere outside your
document root directory. It should not be accessible via http (web browser).

The structure of directories should look like this:

6. If you are installing a new version of KBPublisher:
Create tables using the db dump file at kb/setup/db/install.sql.
Create an admin user using the file at kb/setup/db/create_user.sql.

7. If you are upgrading from a previous version of KBPublisher:
Back up your existing database before upgrading!
Use the DB dump file kb/setup/db/upgrade_[version]_to_[version].sql.

8. Configure your kb/admin/config.inc.php configuration file.

If you installed KBPublisher in document_root/kb/ directory:
$conf['admin_home_dir'] = '/kb/admin/';
$conf['client_home_dir'] = '/kb/';

If you installed KBPublisher in document_root directory:
$conf['admin_home_dir'] = '/admin/';
$conf['client_home_dir'] = '/';

9. In some cases you have to configure your kb/index.php file to set the correct path for the admin directory and
the kb/rss.php, kb/captcha.php files to set the correct path to the kb installation directory. Normally these will work without
any modifications.

10. Give your kb_upload, kb_file, kb_cache directory full write permissions.
In unix you can type "chmod 777 ". On Windows you must go through your webserver to give it write permissions.

11. Set up scheduled tasks to enable scheduling, reporting and subscriptions.
12. You're done.

The public area screen will be available at www.your_domain/kb/
The admin area will be available at www.your_domain/kb/admin/

Login: admin
Password: demo
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DO NOT FORGET TO CHANGE THE PASSWORD!
13. Log in to KBPublisher and select the Settings tab to configure settings.

Make sure you set the correct email address at Setting -> Email .
14. Read the FAQ
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Upgrading KBPublisher

Before you start
Please note that upgrading via the wizard is possible only for version 2.0 and above.
If you are currently using an older version of KBPublisher upgrade to version 2.0 first.

Option 1 (retain current installation until you have tested the upgrade)
1. Make a copy of your previous KBPublisher installation database. This database will be modified during the upgrade.
2. Unpack the distribution package to a directory with a different name to that of your current knowledgebase directory, for

example to "kb_new".  This ensures that the previous installation is not overwritten.
3. Open your browser and go to http://<your_domain>/<kb_installation_path>/setup/index.php, where <your_domain> is

your domain name, and <kb_installation_path> is the path where KBPublisher is installed that you created in step 2. e.g.
http://mydomainname.com/kb_new/setup/index.php. The installation wizard comes up.

4. Follow the installation wizard instructions.
5. After testing the new installation, rename your current (old) KBPublisher installation directory to something appropriate, for

example to "kb_old".
6. Rename new KBPublisher installation directory to your previous installation directory name.
7. Update configuration file <kb_installation_path>/admin/config.inc.php by setting new values for $conf['admin_home_dir']

and $conf['client_home_dir'].
8. Copy the license file from the previous version into the directory that contains upgraded version,  i.e. copy 'kb_old/key.php'

over 'kb/key.php'

Note that this option creates a new database. If you wish to continue to use the original database, then once you have tested that
everything is working, backup the old database, rename the new one and change the database name in config.inc.php to match the
name of the original.

Option 2 (upgrade directly into the current knowledgebase)
1. Rename your current KBPublisher installation directory. For example to "kb_old".
2. Backup your database.
3. Unpack the distribution package to the directory where the previous version of KBPublisher was installed.
4. Copy the license file from the previous version into the directory that contains upgraded version,  i.e. copy 'kb_old/key.php'

over 'kb/key.php'
5. Open your browser and go to http://<your_domain>/<kb_installation_path>/setup/index.php, where <your_domain> is

your domain name, and <kb_installation_path> is the path where KBPublisher is installed. e.g.
http://mydomainname.com/kb/setup/index.php. The installation wizard comes up.

6. Follow the installation wizard instructions.

Option 3 (replace modified files only)
With some small KBPublisher upgrades, we supply a quick upgrade option called a "Modified Files Only" package. For example, this
package is available to upgrade from v3.0 to v3.0.1 This allows you to simply replace modified files rather than doing a full upgrade.
You can download it from your client area in the same way you can download a full upgrade package.

The modified files package contains:

A kbp folder that contains all modified files to be copied. The structure of the folder and sub-folders is the same as the
KBPublisher directories/files structure
A My-SQL script to run, called db_upgrade_from_[version]_to_[version].sql, that updates the version number of your
database
A file called how_to_upgrade.txt that tells you what you need to do to upgrade
A list of updated files in updated_files.txt.

Standard steps to upgrade:

1. Backup your current KBPublisher installation, directory and database (recommended).
2. Copy the contents of the kbp folder found in downloaded "Modified Files Only" package to your current KBPublisher

installation directory.  We recommend that you copy the files by folder, rather than all at once. 
(ATTENTION: Mac OS users. You should copy file by file. Do not copy folder by folder. It does not work for you and will replace
entire folder(s) and delete non modified files). 

3. Upgrade your database by running the db_upgrade_from_[version]_to_[version].sql file found in downloaded "Modified Files
Only" package. If your KBPublisher tables prefix is not "kbp" then you should update sql file and set you tables prefix.
For example from:
UPDATE `kbp_setting` SET `input_id` = '5' WHERE `id` = 46;

To:
UPDATE `your_prefix_setting` SET `input_id` = '5' WHERE `id` = 46;
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Notes:

The original installation will already have kb_file and kb_upload directories. Check where these are, and during the upgrade
make sure that your kb_file and kb_upload directory paths are the same as for original installation

Here is a recommended directory structure for KBPublisher

kb_file - is for uploads via 'Files' module
kb_cache - is for cache files
kb_upload - is for uploads via the HTML editor

kb_file, kb_cache and kb_upload directories must be writeable by PHP.
On a Windows system this generally is not a problem, but on Linux systems you will need to CHMOD these directories to 0777.

If you using Remote Authentication please keep your file (kbp_directory/admin/lib/custom/remote_auth.php) and copy it to
new installation.
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Installing ionCube loader

For KBPublisher  v4.0.2 and lower ionCube loader must be installed.

On many web servers the Loader can be enabled automatically with no changes to the php.ini file and no server restart required.

If your server does not have ionCube support already enabled, you can obtain Loaders for your server platform from here.
Instructions for installing Loaders can be found here.

You can also you can run the ioncube helper file distributed with kBPublisher.
Run your browser to http:////ioncube/ioncube-loader-helper.php

If you install IonCube loader in the php.ini file you can check if loader installed in phpinfo.

Please see this article for how to create the phpinfo file.
If the loader installed correctly you should see it in the Additional Modules section in phpinfo.
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Setting Up Folder Permissions in Internet Information Services (IIS)

This article explains how to set up write permissions in the required folders for configuring IIS for KBPublisher.

Change rights for TEMP directory
PHP uploads get written to windows TEMP directory, and then MOVED to destination directory, and in some cases permissions are
not correct. Change windows temp directory to give IUSR 'modify' rights.
If it does not help see below.

Change rights for KBPublisher directories
Using the standard folders structure for IIS and KBPublisher set write permissions for following folders:

C:/interpub/wwwroot/kb_upload - for uploads via HTML editor
C:/interpub/kb_file - for uploads via "Files" module
C:/interpub/kb_cache - for cache files

*Note: this is the default category structure. Your configuration might be different. 

For each of the above folders, do the following:

1. Right-click the directory, then choose Properties
2. Go to the Security tab
3. Find the IUSR account

(If IUSR is not in the list, add it by clicking Edit, then clicking Add, and then typing "IUSR" in the "Enter the object names to
select" field.)

4. Highlight the user in the list, click Edit, and grant the account Modify and Write permissions

Script to check directory permissions
Here is a simple PHP script which check if directory writable or not.

1. Download and unzip this file.
2. Upload file to directory where KBPublisher installed.
3. Update file and set required value for variable $dir_to_check

Example: $dir_to_check = 'C://inetpub/kb_cache';
4. Run file in browser like this http://path_to_kb_dir/check_dir_writable.php
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Setting up scheduled tasks

Some parts of KBPublisher simply will not work if you do not schedule tasks. This includes:

Reports. You will not be able to run reports
Subscription processing. Users will not be notified when items are added or changed  
Scheduling. You will not be able to schedule article, news or files
Optimization. Database tables will not be checked/repaired/optimized
Synchronization. Article and file hits will not be synchronized
Search suggest will not work 
Administration. Some system jobs will not run.

How do I schedule tasks?
You can configure scheduling through the Unix crontab command, through scheduled tasks in Windows, or through the Control
Panel provided by your service provider.

When scheduling tasks for KBPublisher there are several files you must run
periodically. 
The files to be scheduled are:

admin/cron/freq.php - every 5 minutes
admin/cron/hourly.php - hourly
admin/cron/daily.php - daily, just after midnight
admin/cron/weekly.php - weekly
admin/cron/monthly.php - monthly

1. By 'crontab' on Unix
# every 5 minutes
*/5 * * * *   /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/freq.php

# hourly
0 * * * *    /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/hourly.php

# daily, after midnight
01 0 * * *    /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/daily.php

# weekly
10 0 * * 0   /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/weekly.php

# monthly
20 0 1 * *   /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/monthly.php

where /usr/local/bin/php is the path to the PHP interpreter, it could differ on your system (you can get it by running 'which php' on
command shell), and [KBP_DIRECTORY] is the absolute path to your KBPublisher installation directory (e.g.
'/home/user_name/www/kb'). Replace it with your value.

OR
# every 5 minutes
*/5 * * * *   /usr/bin/curl -s http://example.com/kb/admin/cron/freq.php

# hourly
0 * * * *    /usr/bin/curl -s http://example.com/kb/admin/cron/hourly.php

# daily, after midnight
01 0 * * *    /usr/bin/curl -s http://example.com/kb/admin/cron/daily.php

# weekly
10 0 * * 0   /usr/bin/curl -s http://example.com/kb/admin/cron/weekly.php

# monthly
20 0 1 * *   /usr/bin/curl -s http://example.com/kb/admin/cron/monthly.php

If you are using HTTP requests, as above, you should update the KBPublisher settings to allow HTTP requests and specify the allowed
IP addresses.
Go to Settings -> Admin tab and check "Allow HTTP requests". Then enter the allowed IP addresses into the "Allowed IP's for HTTP
requests" field.

You can insert these crontab records by executing 'crontab -e' and editing cron jobs manually, or you can create a file (kbp_cron.txt)
containing these lines and execute 'crontab kbp_cron.txt' from the shell (WARNING: all existing records in crontab will be removed!).
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2. By 'Scheduled Tasks' on Windows
Instead of cron on Windows you can use Scheduled Tasks. Contact your system administrator or hosting provider for additional
details.
To set up Scheduled Tasks in Windows XP, Vista and 7, as well as Windows 2003 Server and later, you can use schtasks.exe. Open
the command line and type in following commands:
schtasks /create /ru "System" /sc minute /mo 5 /st 00:00:00 /tn "KBPublisher freq task" /tr "[PHP_DIR]\php.exe
[KBP_DIRECTORY]\admin\cron\freq.php"

schtasks /create /ru "System" /sc hourly /st 00:00:00 /tn "KBPublisher hourly task" /tr "[PHP_DIR]\php.exe
[KBP_DIRECTORY]\admin\cron\hourly.php"

schtasks /create /ru "System" /sc daily /st 00:01:00 /tn "KBPublisher daily task" /tr "[PHP_DIR]\php.exe
[KBP_DIRECTORY]\admin\cron\daily.php"

schtasks /create /ru "System" /sc weekly /st 00:10:00 /d SUN /tn "KBPublisher weekly task" /tr "[PHP_DIR]\php.exe
[KBP_DIRECTORY]\admin\cron\weekly.php"

schtasks /create /ru "System" /sc monthly /st 00:20:00 /tn "KBPublisher monthly task" /tr "[PHP_DIR]\php.exe
[KBP_DIRECTORY]\admin\cron\monthly.php"

Where: [PHP_DIR] - full path to php.exe, [KBP_DIRECTORY] - full path to KBPublisher directory. Replace it with your values

Example: schtasks /create /ru "System" /sc minute /mo 5 /st 00:00:00 /tn "KBPublisher freq task" /tr
"C:\php\php.exe C:\www\kbpublisher\admin\cron\freq.php"

3. By Control Panel
This depends very much on your hosting provider. You should consult their documentation.

Notes:

admin/cron/freq.php should be run every 5 minutes
admin/cron/daily.php should be run just after midnight.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Enable searching in files

Text-based file searching/indexing (txt, html, etc.) is enabled by default. If you want to include searching PDF or Word documents
then you need to do the following.

Searching in PDFs
 To enable search in PDFs you need to:

Install a program called xpdf
Ensure Settings points to where you installed it
Ensure that PHP has access to your xpdf directory. (Check your open_basedir PHP setting in php.ini)
Ensure that PHP can run the system  function.  (Check your disable_functions, safe_mode_exec_dir PHP settings in php.ini)

Install xpdf

xpdf is available from www.foolabs.com/xpdf/download.html
Download and install it.

Update the setting to point to xpdf

Once you have installed xpdf, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Admin -> XPDF installation path
Make sure that this points to the directory where you installed xpdf. For example: /usr/local/bin/ or c:/wwwroot/xpdf/
Set this to 'off' to de-activate this option.
When you click "Save", test pdf file will be parsed/indexed and error occurs if it failed. 

Test xpdf from command line

Test to see if xpdf is working by running the following command from the command line:

$ /path_to_xpdf/pdftotext -raw file_read.pdf file_write.txt;

Test  xpdf from command line using PHP and included test file:

$ cd /path/to/kbp_directory
$ php -r "system('/path_to_xpdf/pdftotext -raw admin/extra/file_extractors/extract_test.pdf file_write.txt');"

Searching in Word 2007/2010, Excel 2007/2010 or Open Office document files
To enable search in .docx, .xslx and .odt documents you need to:

Install a PHP Zip extension if you do not have one
You can see if you have it installed in Home -> Setup Tests tab  in your KBPublisher installation

Searching in Word 2003 and below files
 To enable search in Word documents you need to:

Install either catdoc or Antiword
Ensure Settings points to where you installed it
Ensure that PHP has access to your catdoc directory. Check your open_basedir PHP setting in php.ini.
Ensure that PHP can run the exec function.  Check your disable_functions, safe_mode_exec_dir PHP settings in php.ini. 

Install catdoc

catdoc is available from http://www.wagner.pp.ru/~vitus/software/catdoc/
Download and install it.

Install Antiword

Antiword is available from http://www.winfield.demon.nl/
Download and install it.

Update the setting to point to catdoc

Once you have installed catdoc, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Admin -> catdoc installation path
Make sure that this points to the directory where you installed catdoc. For example: /usr/local/bin/ or c:/wwwroot/catdoc/
When you click "Save", test pdf file will be parsed/indexed and error occurs if it failed. 

Test catdoc from command line

Test to see if catdoc is working by running the following command from the command line:

User Manual v7.5 50

http://php.net/system
http://www.foolabs.com/xpdf/download.html
http://php.net/manual/en/zip.installation.php
http://php.net/exec
http://www.wagner.pp.ru/~vitus/software/catdoc/
http://www.winfield.demon.nl/


$ /path_to_catdoc/catdoc -w file_read.doc;

Test catdoc from command line using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_catdoc/catdoc -w admin/extra/file_extractors/extract_test.doc');"

Test antiword from command line

Test to see if antiword is working by running the following command from the command line:

$ /path_to_ antiword/antiword -t file_read.doc;

Test antiword from command line using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_ antiword/antiword -t admin/extra/file_extractors/extract_test.doc');"

Turning PDF or Word search off
If you don't want to allow searching on PDF or Word documents, change the setting in XPDF installation path or catdoc installation
path to OFF. 
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Enable Exporting to PDF

To export multiple articles to PDF or HTML files you need to:

Install a program called WKHTMLTOPDF (recomended) or HTMLDOC
Ensure Settings points to where you installed it
Ensure that PHP has access to your HTMLDOC directory. (Check your open_basedir PHP setting in php.ini)
Ensure that PHP can run the proc_open function. (Check your disable_functions, safe_mode_exec_dir PHP settings in php.ini)
Buy the export plugin  or try it in Demo mode
Add the plugin key to your KBPublisher settings

Using WKHTMLTOPDF (recommended)
WKHTMLTOPDF is available from https://wkhtmltopdf.org
Download it and install it

Update the setting to point to WKHTMLTOPDF

Once you have installed WKHTMLTOPDF, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Plugins -> Export -> WKHTMLTOPDF installation path
Make sure the WKHTMLTOPDF installation path points to the directory where you installed HTMLDOC. For
example: /usr/local/bin/.
When you click "Save", test HTML file will be parsed and error occurs if it failed.

Test WKHTMLTOPDF from command line

To convert a single web page type:

$ /path_to_wkhtmltopdf/wkhtmltopdf input.html output.pdf

Test using PHP and included test file:

$ php -r "exec('/path_to_wkhtmltopdf/wkhtmltopdf http://path_to_kbp/admin/extra/plugin/export2/template/export_test.html
output.pdf');"

Using HTMLDOC
Note: At this time there is no commercial support for the HTMLDOC. The windows binaries can be found here.

HTMLDOC is available from https://www.msweet.org/htmldoc/
Download it and install it

Update the setting to point to HTMLDOC

Once you have installed HTMLDOC, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Plugins -> Export -> HTMLDOC installation path
Make sure the HTMLDOC installation path points to the directory where you installed HTMLDOC. For
example: /usr/local/bin/.
When you click "Save", test HTML file will be parsed and error occurs if it failed. 

Test HTMLDOC from command line

To convert a single web page type:

$ /path_to_htmldoc/htmldoc --webpage -f output.pdf filename.html

Test using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_htmldoc/htmldoc --webpage -f output.pdf admin/extra/plugin/export/template/export_test.html');"

Buy the plugin
Export functionality is not available with the default KBPublisher package. You must purchase it separately.
Please see this article how to buy the plugin.

Add the plugin key to KBPublisher

You should have received an email with you plug-in key. If you can't find the email,
you can also get this from the My Licenses tab in your client area on the KBPublisher website.  
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Copy the license key from your client area or the email
Log on to your knowledgebase
Go to the Admin Area
Click on the Settings menu
Click on the Plugins -> Export tab
Paste your key into the Plugin key field
Save.

Tip:

If you want to try the export plugin before you buy, use demo mode to get an idea of how it works.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Enable searching spell suggest

To help you avoid typos when entering search terms, you can install and enable one of the following tools:

Pspell
Enchant
Bing spell suggest service (free or paid versions)

Each of these tools monitors the characters you enter in the search field and suggests words that match what you have typed so far
and that match entries in your system data. You can then select one of the words or ignore the suggestions and continue typing.

You may find by experimentation that one of the tools works better than the others for your system and your data.

To enable spell suggest:

1. Select Settings from the menu bar in the Admin area.
2. In the form that appears, select the Public Area tab.
3. Scroll down to the Search section.
4. Locate the Search Spelling Suggest field and click the "..." button.

The form that appears shows the available spelling tools. If one is already selected and active, it is marked with a check mark. If no
tool is active, you can activate one as described below.

Click Save to save your settings and return to the main form. Click Cancel to abandon your changes and close the Settings form.

Enchant 
Enchant is the PHP binding for the "Enchant" spelling library. Enchant provides consistency among any running spell-checkers, and
adds certain features that may be lacking in any individual provider library. Click the information icon beside the tool's name to see
more information.

Click the icon in the Settings column to display the Settings form. 
In the Settings form you can select the spelling library to use from the two "Active Dictionary" fields at the top of the form.

If you want to exclude some words from Enchant's attention so it does not suggest alternatives, enter the words, separated by
spaces, in the "Exclude word list" field.

To make Enchant the primary spelling suggest tool, check the "Set as Primary" check box. This will deselect any other tool that is
currently selected.

Pspell
Pspell is a spelling-assist tool that will help you enter search terms that will return "hits". Click the information icon beside the tool's
name to see more information.

Click the icon in the Settings column to display the Settings form.
In the Settings form you can select the spelling library to use from the "Active dictionary" field at the top of the form.

If you want to exclude some words from Pspell's attention so it does not suggest alternatives, enter the words, separated by spaces,
in the "Exclude word list" field.

To make Pspell the primary spelling suggest tool, check the "Set as Primary" check box. This will deselect any other tool that is
currently selected.

Bing spelling suggestion
This option uses the Bing API to provide suggestions for spelling search terms to match data in the system. There is a free licensed
version with a limited number of uses per month by your readers, or you can purchase a license that supports more uses per month.
Click the information icon beside the tool's name to see more information, and to learn about obtaining a license.

Click the icon in the Settings column to display the Settings form.

To activate Bing spelling suggestion, you need to obtain a license. Click the information icon, as described above, and either get the
free license or buy one of the license" allowing higher use. When you have obtained your license, enter the information you receive
in the "Bing API Account Key" and "Bing request URL" fields.

You may find that your system runs somewhat slower when using the autocomplete feature in Bing. if so, de-select the "Use in
Autocomplete predictions" check box.

If you want to exclude some words from Bing's attention so it does not suggest alternatives, enter the words, separated by spaces, in
the "Exclude word list" field.

To make Bing the primary spelling suggest tool, check the "Set as Primary" check box. This will deselect any other tool that is
currently selected.
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Setup tests

The Setup Tests screen is available as a tab from the Settings menu. It allows you to check that your knowledgebase has been set
up properly.

To get to the screen:

Log in as an admin user
Click Settings -> Admin 
Click the Setup Tests tab

The Setup Tests tab
When you first install KBPublisher the Setup Tests tab doesn't show much. Click Run Test to get some results.

The Files directory is where files are stored. If this test's status is passed, it means that the folder exists and can be written
to. If you need to check the name of the directory, click Setting. 

The Cache directory is where cached files are stored. This is defined in the php config file. You normally would not change
this. Passed means that the directory exists.

The HTML editor file directory is where images are stored. If the status is passed it means that the directory exists and you
can save images to it. If you need to check or update the name of the directory, click Setting.

XPDF allows you to search PDF files.
If this setting is disabled, then XPDF has not been installed. If the status is failed or error, details of the error will be provided.
If the status is passed, your knowledgebase should be able to search PDF documents.
To install XPDF, see Enable Searching in Files.

Catdoc allows you to search Word 2003 files.
If this setting is disabled, then Catdoc has not been installed. If the status is failed or error, details of the error will be provided.
If it is passed, your knowledgebase should be able to search .doc documents.
To install catdoc, see Enable Searching in Files.

PHP Zip extension allows you to search Word 2007/2010 files and Excel 2007/2010 files and from OpenOffice documents.
If the status is failed or error, then PHP Zip extension has either not been installed or is not installed properly; details of the
error will be provided.
If the status is passed, then your knowledgebase should be able to search docx, xlsx, and .odt files.
To install PHP Zip extension, see this link.

Spell Suggest helps your knowledgebase users when they search for documents or files, by suggesting the correct spellings
of the words the users are entering as search terms.
If the status is passed, then Spell Suggest is installed and end users should see helpful spelling hints. If the status is failed or
error, details of the error will be supplied.

Htmldoc allows you to export KB to PDF, it is required for PDF Export plugin.
If the status is disabled, Htmldoc hasn't been installed. If the status is failed or error, details of the error will be provided.
If this is passed then you should be able to export your knowledgebase as a PDF document and/or as HTML.
See enable exporting to PDF for setup and requirements. 

Wkhtmltopdf allows you to export KB to PDF, it is required for PDF Export plugin.
If the status is disabled, Wkhtmltopdf hasn't been installed. If the status is failed or error, details of the error will be provided.
If this is passed then you should be able to export your knowledgebase as a PDF document and/or as HTML.
See enable exporting to PDF for setup and requirements. 

Scheduled tasks tells you if your cron jobs are set up properly.
If the status is disabled, then you will not be able to schedule tasks or run reports, and users will not be notified of changes
they have subscribed to. Some admin tasks will also not run.
Cron jobs are set up on the server. Click here for how to set them up.
If the status is error, then there is a problem in your setup and some tasks could not execute. Information about the problem
will be listed with the error. 
If the status is passed then your cron jobs have been set up properly and scheduled tasks should run.

Sphinx 
Sphinx Search Server allows you to enable fast full-text search capability.
Click here for how to set them up.

Note:

This set of tests runs as a regularly scheduled task. If there is an error, the knowledgebase administrator is notified by email.

----------------------------------------------------------------------
This functionality works in version 4.0 and above

User Manual v7.5 56

https://www.kbpublisher.com/kb/entry/224/
https://www.kbpublisher.com/kb/entry/224/
http://php.net/manual/en/zip.installation.php
https://www.kbpublisher.com/kb/entry/303/
https://www.kbpublisher.com/kb/entry/303/
https://www.kbpublisher.com/kb/entry/238/
https://www.kbpublisher.com/kb/entry/437/


User Manual v7.5 57



Getting started
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Summary

Welcome to KBPublisher. This section tells you how to quickly get your knowledgebase up and running.

If you haven't already done so, install KBPublisher
Create one or more categories to post articles under
Add some users who will create content and publish it. Use the Default User Privileges article to hyelp determine which type of
user(s) to create. If you already have a list of users in another database, consider importing them in to KBPublisher rather than
adding each one individually.
Add some articles. Likewise, if you have a lot of articles that already exist in another database, consider a bulk import of
articles instead of typing them in individyally.

That's it. Your knowledgebase is ready.
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Add a Category

The quickest way to add a category is to use the Shortcuts menu at the top of your screen.

Click on the drop-down menu in the top right of the screen and choose Add new category .

Or you can do it via the Categories tab in the Admin Area

Click on the Articles menu
Choose the Categories tab
Click on Add New .

You can also add a category while you are in the middle of adding an article or a file

Edit the article or file
Click on the assign categories button (+)
Click on Add New Category .

Once you are on the category screen you must complete the following sections:

Add a Title. This is the name that will be displayed on the left menu or in any table of contents.
Define where it fits in the category hierarchy by choosing a Parent category and an Order. If you don't change these you
will add a new top-level category and it will be placed last.

You may also:

Change how articles are displayed by specifying a category type
Control read and write access through Private and Active
Allow users to comment on or rate articles in the category
Assign a person to approve articles (Supervisor) for the category

You can find out more about each of these fields and how they work in the Category screen explained.
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Add a glossary item

The glossary gives your readers quick definitions or explanations of words or phrases important to your application, but which the
reader might not know.

There are two ways to add a glossary item:

1. Click the Add icon  at the top right of the Admin screen and select Glossary item.
2. On the Articles tab select the Glossary sub-tab, then click the Add new button.

Either method displays the Add new form. Provide the required information for the new item:

Word/phrase - This is the word or phrase that may puzzle your reader. This text will be highlighted in red in articles. 
Definition - Explain the word or phrase. In an article, the definition appears in a yellow box when the reader clicks a word
highlighted in red.

There are two optional settings:

Highlight once  - Select to have the word or phrase highlighted only the first time it appears in an article. Repeated
highlighting may make the article more difficult to read.
Published - This is selected by default. De-select to have this item not display in the glossary.

Click Save to save the new item. Click Cancel to abandon your edits and close the form. Click Preview to see how the item will
appear.
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Add a user

To add a new user

Click on the Users menu
Click on Add New .

Once you are on the Users screen you must complete the following sections:

Give the user a First Name and a Last Name
Add their Email
Give them a Username. If you prefer, you can set their email as their user name.
Set up a Password

The following items are optional:

Assign a Privilege. If you do not assign a privilege the user will have standard read access to the public area.
To classify the user, and provide another level of access, include a Role. 
You can include extra user details such as a Middle Name, Phone and Company
You can add comments about the user or registration
You can automatically subscribe them so that they receive changes to news, articles or files
To give the user immediate access to the system, make this user Active
To send an email to the user after then that their user ID has been created, check Notify User .

You can find out more about each of these fields on the User screen and how they work in the User Screen Explained

Once your user has been set up:

Click Save.

Tips:

If you have a number of users to add from another database, say, you may want to import users instead of adding them
Or you may choose to allow users to register, which effectively allows them to create their own user.
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Final steps

You now have a simple, working knowledgebase. Now users can read your articles.

 From here, you may like to:

Experiment with different category types to see what effect each one has
Consider adding roles to users so that you can control what individual users see
Add items to your glossary
If you have lots of pre-existing documentation that can't be imported as articles, why not upload them as files.

If you are an administrator, you can also fine-tune the system:

Modify the look and feel of your knowledgebase
Add some templates to make creating your articles easier
Take a look at the email templates to see what's in the mails going out from and coming in to the knowledgebase
Manage the RSS feeds
Create your own user privileges and roles
Set some initial user defaults.
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Add an Article

If you are in the Public area, the quickest way to add an article is via the Manage menu in the top right of your screen:

Click on Manage -> Add Article Here

If you are in the Admin area, another fast way is to to use the Shortcuts menu at the top of your screen:

Click on the Add drop-down menu in the top right of the screen and choose Article.

Or you can do it via the Articles tab.

Click on the Articles menu
Choose the Articles tab
Click on Add New .

Once you are on the article screen you must complete the following sections:

Choose where you want the knowledgebase article to be displayed by adding a Category or categories
Add a Title. This is the heading displayed on the knowledgebase screens and in any menus/table of contents.
Type your article in the Article editing box.

The following items are optional:

To help users search within your database, include a Type and Meta Keywords
To optimize web search add Meta Keywords/Tags and a Meta Description
To add links to other web sites, include External links
To add links to other articles in the KBPublisher database, include them as Related articles
To add links to files, include then as Attachments
To force users to log on to read an article, mark it as Private Read. To restrict who can read the article mark it as private
read and then assign specific roles which can access it.  To restrict who can edit the article, mark it as Private Write.
To say where in the list the article is placed, specify the Order
Use the Status field to make the article available to read.

You can find out more about each of these fields and how they work in The Article Screen Explained.

Once your article is complete:

Click Save.

Tips:

If you have a number of articles to add from another database, say, you may want to import articles instead of adding them.
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Single Sign On
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SAML Authentication
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Using SAML SSO Authentication

Security Assertion Markup Language (SAML) is a standard for logging users into applications based on their sessions in another
context. This single sign-on (SSO) login standard has significant advantages over logging in using a username and password. SAML
is very powerful and flexible, but the specification can be quite a handful.

Steps to enable SAML SSO Authentication
See this article for details

Tracking logins
You can see how your remote authentication works in the KBPublisher login logs, located under Logs > Logins.

For debugging, the most recent remote login is logged to a file called last_remote_login.log in the KBPublisher cache directory
(APP_CACHE_DIR in admin/config.inc.php). For example: /home/username/kb_cache/last_remote_login.log
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Setting up SAML SSO Authentication

The following steps assume that you have an account with a supported identity provider. You need to know the SAML Login URL and
have the x.509 certificate supplied by your identity provider. You should also be familiar with the format of the SAML identity
response from your SAML provider.

Enabling SAML authentication
1. As a user with administrator privileges, go to Settings > Authentication Provider .

 
2. On the SAML tab, check Enable Single Sign-On 

(make sure that $conf['auth_remote'] in the file admin/config.inc.php is set to 1)
 

3. Select an Authentication Mode, which defaults to Only SAML Authentication allowed. The available options are:
Both built-in and SAML Authentication allowed  - User will be able to log in to KBPublisher using SSO and/or built-in
authentication.
Only SAML Authentication allowed  - User can only log in using SSO.
Only SAML Authentication allowed, try auto authentication  - User can only log in using SSO and, if possible, auto-
authentication on the SAML server will be applied.
 

4. Enter the following SAML Configuration settings:
Name - The name for your SSO provider, to be presented on the login page.
Issuer - Unique identifier for your Identity Provider (typically a URL). In some cases, this is called the Entity ID.
Single Sign-On Service Url  - The SAML Login URL where the Controller will route Service Provider (SP)-initiated login
requests. This is required.
Single Logout Service Url  - The URL where the Controller will redirect users after they log out. If you do not specify a
logout URL, users will get the KBPublisher login screen when they log out. 
Single Sign-On Service Binding and Single Logout Service Binding  - You can change the binding for login and
logout URLs. Defaults to HTTP-Redirect. The other option is HTTP-POST.
Public X.509 Certificate  - The x.509 certificate from your identity provider configuration.
Authentication Contexts - Set possible auth context values, place a value on a new line. Leave it empty for default
value.
Example: 
urn:oasis:names:tc:SAML:2.0:ac:classes:Password 
urn:oasis:names:tc:SAML:2.0:ac:classes:X509
If empty It defaults to: urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport
For Azure AD set to: urn:oasis:names:tc:SAML:2.0:ac:classes:Password
 

5. In the SAML User Mapping Fields  settings, specify how SAML-authenticated users are identified in the KBPublisher
Controller:

Remote User Id - Unique identifier for the user in the SAML response. This value is responsible to identify user in
authentication requests. It defaults to the SAML NameID element.
First Name - The first name for the user corresponding to the KBPublisher First Name field. Given the sample response,
this value would be User.firstName.
Last name - The last name for the user corresponding to the KBPublisher Last Name field. Given the sample response,
this value would be User.lastName.
Email - The user's email address, corresponding to KBPublisher email field. The value must be unique among all SAML
users. Given the sample response, this value would be User.email.
Username - This value corresponds to the KBPublisher username field. The value must be unique among all SAML users.
Given the sample response below, the value for this setting would be User.email.
 

SAMPLE RESPONSE

<saml:AttributeStatement>
   ...
   <saml:Attribute Name="User.OpenIDName" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">
      <saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="xs:string">adynamo</saml:AttributeValue>
   </saml:Attribute>
   ...
   <saml:Attribute Name="User.firstName" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">
      <saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="xs:string">John</saml:AttributeValue>
   </saml:Attribute>
   <saml:Attribute Name="User.lastName" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">
      <saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="xs:string">Doo</saml:AttributeValue>    
   </saml:Attribute>
   <saml:Attribute Name="User.email" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">
      <saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="xs:string">John.Doo@example.com</saml:AttributeValue>
   </saml:Attribute>
   ...
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</saml:AttributeStatement>

 
6. To map SAML group attributes to KBPublisher privileges and roles, configure the SAML attribute for Privileges  and SAML

attribute for Roles settings. The settings you use depends on the structure of the SAML group attribute in the response.

Note: You can skip this step. If you leave these settings empty they will never be rewritten on user login. You can assign
required privileges and/or roles later in KBPublisher.
 

1. Click the ellipsis button in the SAML attribute for Privileges  field to open the Group-to-Privilege Mapping dialog box.
2. Enter the SAML group attribute name, the SAML group attribute value, and choose a KBPublisher privilege to map to. In

the sample response provided below, we map group User.group with value Editor.
3. Click Add.
4. When you have added all mapping rules, click Done.

 
SAMPLE RESPONSE

<saml:AttributeStatement>
   ...
   <saml:Attribute Name="User.OpenIDName" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">
      <saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="xs:string">adynamo</saml:AttributeValue>
   </saml:Attribute>
   ...
   <saml:Attribute Name="User.group" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">
      <saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="xs:string">Editor</saml:AttributeValue>
   </saml:Attribute>
   ...
</saml:AttributeStatement> 

Attention: If you map SAML groups to KBPublisher privileges, all matched users will be assigned the specified privilege. If you
do not have an Unlimited license and the number of allowed staff users is exceeded, the privilege will not be assigned to the
user.

Use the same steps to map SAML attribute for Roles .

7. Set up Service Provider values.
Metadata - Use this information to register the Knowledgebase with your identity provider.
Public X.509 Certificate  - If your identity provider requires signing and/or encryption, copy the contents of your
certificate and paste it here.
Private Key - If your identity provider requires signing and/or encryption, copy the contents of your private key and
paste it here.
Signing algorithm - Select a signing method for all SAML requests.
 

Additional configurations
Rewrite user on login - This is the time, in seconds, to rewrite user data on login. Enter 0 to disable updates to user data on
login. Enter 1 to rewrite user data on every authentication request.
User account info  - This field indicates whether or not the user is able to update his account info. Available options include:

0 - OFF, user can't update his account info
1 - ON, user can update his account info
2 - AUTO, depends on other remote settings
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Configuring OneLogin as an Identity Provider

1. Log into your OneLogin account.

2. Go to the "Apps" section and then click the "Add app" button.
In the filter box type "SAML" and select the "SAML Test Connector (IdP w/attr)" application.
Change the display name of your app if you wish and click "Save".

3. In your KBPublisher administrator area go to Settings -> Authentication Provider -> SAML.
Find the "Service Provider" section and open the "Metadata" window.
On the Configuration tab of your Onelogin app, match the following settings:
Audience: [Entity Id]
Recipient: [Entity Id]
ACS (Consumer) URL Validator: .*.
ACS (Consumer) URL: [Assertion Consumer Service URL]
Single Logout URL: [Single Logout Service URL]

Click on the "Save" button.

4. KBPublisher settings for attributes names default to Onelogin attributes, but you might need to ensure they are equal.

5. Go to the "SSO" tab, then click on the "View Details" link at the "X.509 Certificate" field.
Copy the certificate contents and paste it into the "Public X.509 Certificate" window in KBPublisher.
Copy the values of "Issuer URL", "SAML 2.0 Endpoint (HTTP)" and "SLO Endpoint (HTTP)" and paste them into the
corresponding KBPublisher fields as shown below.

6.  If you don't already have a user on OneLogin go to the "Users" tab and add one.
Go to the "Applications" tab on the user page and assign the application to him.

7.  On your KBPublisher settings page click the "Test / Debug" button.
If it works, you'll see a greeting message.

8. If click on "App Icon" in Onelogin (or Okta) to login to KBPublisher does not work, fill RelayState field in app settings, it should
be full path to your KBPublisher installation (example: https;//domain.com/kb/)
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LDAP Authentication
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Using LDAP Authentication

LDAP authentication allows you to integrate your organization's authentication system with KBPublisher.
Configuration requires only a few simple steps.

Steps to enable LDAP Authentication
See this article for details

Quick summary of the process
End user goes to site
User fill the login form 
Remote Authentication checks for valid user credentials
KBPublisher authenticates the user

Tracking logins
You can see how your remote authentication works in logs Logs/Logins

For debugging every last login is logged to a file called last_remote_login.log in the KBPublisher cache directory (APP_CACHE_DIR in
admin/config.inc.php ).
For example: /home/username/ kb_cache/last_remote_login.log
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Setting up LDAP Authentication

LDAP Authentication is accessible by administrator in Settings > Authentication Provider > Ldap tab in Admin Area.

Settings
Check Enable LDAP Authentication checkbox.
(make sure that $conf['auth_remote'] in the file admin/config.inc.php is set to 1)

LDAP Authentication. To enable LDAP authentication check Enable LDAP Authentication
Make sure that the config variable $conf['auth_remote'] in the file admin/config.inc.php is set to 1;
You can disable LDAP authentication by setting $conf['auth_remote'] = 0.

LDAP Options. Identify host name of your LDAP server and the port for the protocols. The default port for LDAP over SSL is
636, for LDAP over TCP, UDP, or for TLS it is 389. You can specify Base DN for LDAP server and user DN and password. Leave
User DN  and Password fields empty for anonymous binding.

In order to use nested groups in Active Directory, you should set the LDAP membership attribute to
member:1.2.840.113556.1.4.1941: 
This is a special rule to perform a recursive group search.

For more information, see the following:
https://msdn.microsoft.com/en-us/library/aa746475(v=vs.85).aspx
https://blogs.technet.microsoft.com/...explore-group-membership-with-powershell/

Configuration. Set up the IP addresses for local authentication, specify whether to rewrite user data on login in "Rewrite
user on login" field: 0 - once user created the data in KB will never been updated; 1 - on every authentication request, the
user data in KB will be rewritten. You also can set up the options for updating user profiles and reseting password.

Group Mapping. Here you can set up LDAP group mapping behavior.  LDAP groups can be either static or dynamic. A static
group entry contains a list of its users. A dynamic group is where the user entry contains a list of groups it belongs to.

User Mapping Fields . Define the LDAP attributes - first name, last name, email, remote user id and attributes for privileges
and roles (optional). In your expression use the round bracket to identify the specific characters to parse out the records as the
field. 
For user's privilege and role mapping you can give users privileges based upon their group attributes. Click [...] button to map
LDAP groups to KBPublisher Privileges and/or Roles. 

Please note, if you set mapping LDAP groups to the KBPublisher privileges, all matched users will be assigned the specified
privilege. In case you do not have an  Unlimited license,  the number of allowed admin users could be exceeded and privilege
will not be assigned to user.

Important!  If you leave this field blank, roles and privileges assigned for users in KBPublisher will not be updated upon login.

Test / Debug Options (optional) . Set up data to test / debug authentication for actual LDAP user.

 

Tip: You can disable LDAP authentication by setting $conf['auth_remote'] = 0; in file /kbp_dir/admin/config.inc.php
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Remote Authentication
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Using Remote Authentication

Remote authentication allows you to integrate your organization's authentication system with KBPublisher.

Before you start:

We assume that you have some experience with PHP and with the system you are connecting to.

Steps to enable Remote Authentication​
Click on Settings -> Authentication Provider -> Remote  
Check Enable Remote Authentication checkbox (make sure that $conf['auth_remote'] in the file admin/config.inc.php is
set to 1)
Set required values for constants in file admin/lib/custom/remote_auth.php
Customize the _remoteDoAuth function in the file admin/lib/custom/remote_auth.php to authenticate the username and
password passed to it against your own authentication system
Rename the function _remoteDoAuth to remoteDoAuth

Quick summary of the process
End user goes to site
Remote Authentication checks for valid user credentials

If auto-authentication is set, does this automatically
If auto-authentication is not set, user logs in first

KBPublisher authenticates the user .

Customizing the remoteDoAuth function
In your installation there is a folder admin/lib/custom. Within that folder is a file called remote_auth.php. This file contains the
_remoteDoAuth function. Customize this function to do authentication against your internal system by using the username and
password provided.

Here is a simple example of the function customized to authenticate against a MySQL database:

function remoteDoAuth($username, $password) {
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    $user = false;
    $db = &DBUtil::connect($conf);

    $sql = "SELECT
        id AS 'remote_user_id',
        email, username, first_name, last_name
    FROM your_remote_users_table
    WHERE username = '%s' AND password = '%s'";
    $sql = sprintf($sql, $username, $password);
    $result = $db->Execute($sql) or die(DBUtil::error($sql, true, $db));
    
    // if found
    if($result->RecordCount() == 1) {
        $user = $result->FetchRow();
        $user['password'] = $password; // here you should provide not md5ing password
        
        // assign a priv to user (optional)
        // it is fully up to you how to determine who is authenticated and what priv to assign
        // set to off to not rewrite on login
        $user['priv_id'] = 'off';
        
        // assign a role to user (optional)
        // it is fully up to you how to determine who is authenticated and what role to assign
        // set to off to not rewrite on login
        $user['role_id'] = 1;
    }

    return $user;
}

 Also see examples in attached files.

Tracking logins
You can see how your remote authentication works in logs Logs/Logins

For debugging every last login is logged to a file called last_remote_login.log in the KBPublisher cache directory (APP_CACHE_DIR in
admin/config.inc.php ).
For example: /home/username/ kb_cache/last_remote_login.log
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Using Active Directory for Remote Authentication

It is possible to use Remote Authentication with your LDAP server.

Before you start:

We assume that you have some experience with remote authentication, with PHP, and with lightweight directory access
protocols (LDAP).

Requirements

LDAP support in PHP is not enabled by default. You will need to enable it. For more details check PHP documentation at
http://php.net/ldap.

You may want to use Active Directory/PHP Helper library from http://adldap.sourceforge.net. If you do want to use it, download the
library and place it into the kb_installation_dir/admin/lib/custom directory.

Here is an simple example of the function customized to authenticate against a LDAP server:

function remoteDoAuth($username, $password) {
    
    require_once 'custom/adLDAP.php';
    
    $auth = false;
    if(empty($username) || empty($password)) {
        return $auth;
    }
    
    
    //create the AD LDAP connection
    $adldap = new adLDAP();

    $user = array();
    $ldap_user = $adldap->user_info($username, array(*));

    // if found, populate $user array 
    if($adldap->authenticate($username, $password)){
        $user['first_name'] = $ldap_user[0]['givenname'][0];
        ...
    }
    
    return $user;
}

You can find more examples in kb_installation_dir/admin/lib/custom directory.
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Different ways for Remote Authentication

There are two different types of remote authentication. It is controlled by the KB_AUTH_TYPE constant:

1. Adding/refreshing remote user data to KBPublisher and authenticate user.
2. Authentication by existing KBPublisher user.

Adding/refreshing remote user data to KB and authenticate user
KB_AUTH_TYPE = 1

On success, the authentication function remoteDoAuth should return an associative array with the following keys:

first_name
last_name
email
username
password-- as the user types when they login, that is, not encrypted
remote_user_id -- a unique userID stored in your system
role_id - (optional)
priv_id - (optional) privilege for user. If user has a privilege, he will have access to Admin Area

Authentication by existing KBPublisher user
KB_AUTH_TYPE = 2

On success, the authentication function remoteDoAuth should return.

the user_id of the user in the KBPublisher USER table  (kbp_user)
OR
Associative array with keys (user_id, username), for example: array('user_id'=>7, 'username'=>'Test').

There are also other configuration variables
KB_AUTH_AREA
1 - Enabled for Public area only, remote authentication allowed on Public Area login screen
2 - Enabled for Public and Admin areas

KB_AUTH_LOCAL
0 - never try to authenticate by KBPublisher built in authentication
1 - always try to authenticate by KBPublisher built in authentication first
2 - will try to authenticate by KBPublisher built in authentication if Remote Authentication failed

KB_AUTH_LOCAL_IP
Only users with specified IP(s) are allowed to be authenticated by KBPublisher's built in authentication
it only matters when KB_AUTH_LOCAL = 1 or 2.
You can set a specific IP or an IP range. Use an "-" to separate IP ranges, and a";" to separate individual IP addresses.
For example: 127.0.0.1;210.234.12.15;192.168.1.1-192.168.255.255

KB_AUTH_REFRESH_TIME
The time, in seconds, to rewrite user data, (3600*24*30 = 30 days), works if KB_AUTH_TYPE = 1
0 - never. Once the user is created, data in kb table never updated by script
1 - on every authentication request user data in the knowledgebase will be synchronized with data provided by script.

KB_AUTH_RESTORE_PASSWORD_LINK
Here you may provide a link where your remote users can restore their password.
Set to false not to display the restore password link at all.
KBPublisher will determine whether to set your link or the built-in one.

KB_AUTH_AUTO (Using Auto Authentication)
This variable controls whether or not the user sees a login screen and has to log in to KBPublisher, or whether they are
automatically logged in.
0 - Disabled, user gets login screen
1 - Enabled, user doesn't see login screen
2 - Enabled, in debug mode. User doesn't see login screen. It allows not to block "Auto Auth" if authentication failed.  
     Use only for debugging and don't forget to change back to 1 or 0 when you have authentication working.
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Remote Authentication scenarios

Here are some examples/scenarios for Remote Authentication:

1. On the first authentication request the remote user is added to KBPublisher table of users.
On the second and subsequent requests he/she is authenticated by KBPublisher's built in authentication.
KB_AUTH_LOCAL = 1
KB_AUTH_TYPE = 1
KB_AUTH_REFRESH_TIME = 1.

2. Always authenticate by Remote Authentication and rewrite user data in the knowledgebase.
KB_AUTH_LOCAL = 0
KB_AUTH_TYPE = 1
KB_AUTH_REFRESH_TIME = 1

3. On the first authentication request the remote user is added to KBPublisher users.
On the second and subsequent requests the user is authenticated by remote authentication and his/her KBPublisher data is
synchronized with data provided by your script, depending on the KB_AUTH_REFRESH_TIME.
KB_AUTH_LOCAL = 0
KB_AUTH_TYPE = 1
KB_AUTH_REFRESH_TIME = 3600*24*30 (30 days).

4. KBPublisher tries to authenticate the user by built-in Authentication first.On failure KBPublisher tries to authenticate the user
by Remote Authentication.
KB_AUTH_LOCAL = 1
KB_AUTH_TYPE = 2

5. If user IP matches KB_AUTH_LOCAL_IP range, then KBPublisher tries to authenticate the user by built-in Authentication first. If
the IP does not match, or built-in authentication fails, KBPublisher tries to authenticate the user by Remote Authentication.
KB_AUTH_LOCAL = 1
KB_AUTH_LOCAL_IP = '192.168.1.1-192.168.255.255';
KB_AUTH_TYPE = 2

Adding KB_AUTH_AUTO = 1 to any of these means the user will not be asked to type in their username and password.
System will get that information automatically. See this article how to set up Auto Authentication.
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Using Auto Authentication

Auto authentication allows you to automatically authenticate users.

Steps to enable Auto Authentication
Set the constant  KB_AUTH_AUTO in the file admin/lib/custom/remote_auth.php to 1
Customize the _remoteAutoAuth function in the file admin/lib/custom/remote_auth.php to catch current user data and return
it
Rename the function _remoteAutoAuth to remoteAutoAuth

Customizing the remoteAutoAuth function
In your installation there is a folder admin/lib/custom. Within that folder is a file called remote_auth.php. This file contains the
_remoteAutoAuth function. Customize this function to get the current user's credentials.

On success, the function remoteAutoAuth should return an associative array with keys (username, password) for the user.  For
example: array('username'=>'John', 'password'=>'Test').

Here is a simple example of the function customized using HTTP authentication:

function remoteAutoAuth() {
    
    $user = false;
    
    if(isset($_SERVER['PHP_AUTH_USER']) && isset($_SERVER['PHP_AUTH_PW'])) {
         $user = array();
         $user['username'] = $_SERVER['PHP_AUTH_USER'];
         $user['password'] = $_SERVER['PHP_AUTH_PW'];
    }        

    return $user; 
}

Debugging auto-remote authentication
You can debug auto-authentication by setting KB_AUTH_AUTO = 2, which allows you to continually try relogging in so that you can
fix any problems without having to start over every time. Important: Don't forget to reset this back to 1 (or 0) when you have
finished debugging.
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Social Sites Authentication
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Setting up Social Site Authentication

Use Facebook, Google, Yandex, or VC authentication to log into KBPublisher, and your users will be spared from remembering
another password.

The system uses the email address supplied by these services to match with an existing user in KBPublisher. If no such user is found,
a new user is created.

Enabling Social Logins
1. As a user with administrator privileges, go to Settings > Authentication Provider .
2. On the Social tab, check Enable ... checkbox for required social site.
3. Provide required ID and Secret Key for the social site.
4. Click Save / Debug to verify that it works.
5. Click Save to enable social logins for checked social sites.
6. Go to your KB login screen to test real social login.

Where can I get social site ID and Secret Key?
See corresponding social site documentation for details.

Google
Facebook
Yandex
VK
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Using Social Sites Login

Social Sites authentication allows you to integrate social login systems with KBPublisher. Configuration requires only a few simple
steps.

Steps to enable Social Login
See this article for details.

Quick summary of the process
End user goes to site.
User clicks a button, such as "Login via [Google]".
Popup appears with Social Site login form or, if already logged in, goes to the next step.
Social Site Authentication checks for valid user credentials.
KBPublisher authenticates the user.

Tracking logins
You can see how your remote authentication works in the KBPublisher login logs, located under Logs > Logins.

For debugging, the most recent remote login is logged to a file called last_remote_login.log in the KBPublisher cache directory
(APP_CACHE_DIR in admin/config.inc.php). For example: /home/username/kb_cache/last_remote_login.log
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Importing
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Import users

You can import users in bulk. You might want to do this if you are changing over to KBPublisher from an old system, or if you have
signed up a new company or organization and the company provides you with a list of users to create.

The process is:

Create a file of users to import
Upload a test sample to the system
Import.

Create a file of users to import
First, you need to create your file of users. This is a comma-separated (CSV) text file that consists of some or all of: first name, last
name, email, username, user ID, date registered, middle name, telephone number and an active flag.

The first five fields (highlighted bold) must be included. You can include some, all or none of the others as required.
They do not have to be in the same order as above, but each line in the import file must contain the same fields in the same
order.
The password is encrypted. You cannot import plain text passwords; they must be encrypted in MD5 format. Ensure that the
person providing you with the list encrypts the passwords.
The active flag defaults to '1', which is active, so the only time you would set this is if you don't want the users to be active.
Place the data for each user onto a single line, and separate each field by a comma. Do not include spaces before or after the
comma.
The TestImportUsers.csv file is a sample that shows what your upload file should look like. This file includes the four default
fields only.
Field sizes and types are specific, as per the table below. Your data must fit within these parameters or the upload will fail.

Field Type/size M/O Comments

first_name varchar(50) compulsory

last_name varchar(100) compulsory

email varchar(100) compulsory

username varchar(50) compulsory

date_registered date optional
Format YYYY-MM-DD.
If not supplied will use current
date.

middle_name varchar(50) optional

phone varchar(20) optional

active tinyint(1) optional Default = 1

Create a test file
Don't try to upload the whole file without testing it first. If something goes wrong you may then have to delete all those half-
imported users and try again. Create a test file and run that first.

Copy the first, say, three lines of your text import to a separate file
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)
Upload the file to the server

Import the test file
You are now ready to import the test file to KBPublisher.

Click on the Import/Export menu
This brings up the Import Users tab
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File  in the SQL Load Command  field
Browse for the CSV file on your drive and open it
 

If the import file is on the server,
Choose Load data file
Type the address where the file is located into the Path to file field on CSV file line
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Move the CSV fields around to specify which fields are in the file and what order they are in.
Do this by clicking on the name of the field you want to move and dragging and dropping it into the appropriate place.

For example, suppose you only want the five mandatory fields included. You need to move the date_registered and
imported_user_id fields out of the Fields in CSV  box and into the Available table fields box. Let's start with the
date_registered field.

Click on the date_registered field and hold the mouse down
While holding the mouse down, drag the date_registered field over to the Available table fields box
Drop the field into the box by releasing the mouse

Make sure that you place it in the order it appears in the file.
 

Change CSV options if required.
Click Load.

Once the load is complete you are returned to the Import Users tab. At the top of the screen you see a message telling you whether
the import was successful and how many users were imported.

If the import reports as successful, click on the Users tab to check the result for yourself.

Fix any problems
All going well, you should now have three new users. Check them carefully and ensure that everything worked as you expected.
If you had problems, delete these three users, fix the test file and run it again. Keep fine-tuning until it works, and then update the
real file to match the fixes you made in the test file.
You are now ready to import the rest of the users.

Import users
Import the rest of the users using the same process as for the test file, only this time using the real data file.

Note:

Imported users have no roles or privileges.
If any unique keys will be duplicated during import, records from cvs file will be ignored.
Use the bulk actions option in Users module to change roles, privileges, etc.
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Import articles

You can import articles in bulk.
You might want to do this, say, if you are changing over to KBPublisher from another system.

The process is:

Create a file of articles to import
Upload a test sample to the system
Import.

Create a file of articles to import
First, you need to create your file of articles. This is a comma-separated (CSV) text file that consists of some or all of: title, body,
date_posted, id, author_id, updater_id, meta_keywords, meta_description, entry_type, external_link, date_updated, hits, sort_order,
private and an active flag.

The first three fields (title, body and date_posted) must be included. You can include some, all or none of the others as
required.
They do not have to be in the same order as above, but each line in the import file must contain the same fields in the same
order.
The active flag defaults to '1', which is active, so they only time you would set this is if you don't want the users to be active.
Place the data for each user onto a single line, and separate each field by a comma. Do not include spaces before or after the
comma.
Place quotes (") around text fields such as body, and be sure to check that your text does not have quotes within the text. If
your body, or other text field, does contain quotes, choose a different delimiter and update the fields optionally enclosed
by field to match.
The TestImportArticle.csv file shows a sample of what your upload file should look like. This file includes the three default fields
only.
Field sizes and types are specific, as per the table below. Your data must fit within these parameters or the upload will fail.

Field Type/size M/O Comments

title text M

body mediumtext M

date_posted datetime O Format 0000-00-00 00:00:00

id int(10) O Record ID. If this record ID already exists in the database KBPublisher will
skip the record. It will not overwrite an existing ID.

author_id int(10) O If not supplied, the user currently logged in and importing the articles is set
as the author.

updater_id int(10) O If not supplied, the user currently logged in and importing the articles is set
as the updater.

meta_keywords text O Format should be the same as if you are adding the keywords in add new
article.

meta_description text O

entry_type tinyint(3) O Type.

external_link text O

date_updated timestamp O Defaults to time imported to knowledgebase.

hits int(10) O Defaults to 0.

active tinyint(1) O Defaults to 1.

Create a test file
Don't try to upload the whole file without testing it first. If something goes wrong you may then have to delete all those half-
imported articles and try again. Create a test file and run that first.

Copy the first, say, three lines of your text import to a separate file
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)
Upload the file to the server
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Import the test file
You are now ready to import the test file to KBPublisher.

Click on the Import/Export menu
Click on the Import Articles tab
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File  in the SQL Load Command  field
Browse for the CSV file on your drive and load it

If the import file is on the server,
Choose Load data file
Type the address where the file is located into the Path to file field on CSV file line

Move the CSV fields around to specify which fields are in the file and what order they are in.
Do this by clicking on the name of the field you want to move and dragging and dropping it into the appropriate place.
For example, suppose you want the three mandatory fields included, plus the author ID. You need to move the user_ID field
from the Available table fields box into the Fields in CSV file box .

Click on the user_ID field and hold the mouse down
While holding the mouse down, drag the date_registered field over to the Fields in csv file box
Drop the field into the box by releasing the mouse

Make sure that you place it in the order it appears in the file.
Change CSV options if required.
Click Load

On completion of the load, you will see a message at the top of the Import Articles screen telling you how many files were imported
successfully and how many were skipped.

If the upload was successful, click on the Articles tab to check out the articles.

Fix any problems
All going well, you should now have three new articles in your knowledgebase. Check them carefully and ensure that everything
worked as you expected. If you had problems, delete these three articles, fix the test file and run it again. Keep fine-tuning until it
works, and then update the real file to match the fixes you made in the test file.
You are now ready to import the rest of the articles.

Import articles
Import the rest of the articles using the same process as for the test file, only this time using the real data file.

Note:

Articles are imported with a category name of Imported. If this category does not exist it will be created as part of the upload
process.
If any unique keys will be duplicated during import, records from cvs file will be ignored.
Use the bulk actions option to change the categories, etc.
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Import glossary

If you already have a list of terms and definitions that you would like to use in your knowledgebase, you can upload these terms in
bulk.

The process is

Create a file of glossary items to import
Upload a test sample to the system
Import.

Create a file of glossary items to import
First, you need to create your file of articles. This is a comma-separated (CSV) text file that consists of a phrase, followed by a
definition.

Both fields must be included, and they must be in the order of glossary item name (phrase) first, and then the text that
explains it
Place the data for each glossary item onto a single line, and separate each field by a comma. Include a space after the comma.
If you choose to use something else other than a comma, update the field terminated by field under CSV options to match.

Field Type/size M/O Comments

phrase varchar(100) M The maximum size of a phrase is 100 characters

definition text M

id int(10) O Record ID. If this record ID already exists in the database KBPublisher will skip
the record. It will not overwrite an existing ID.

date_updated timestamp O Defaults to time imported to knowledgebase.

highlight_once tinyint(1) O Defaults to 0.

active tinyint(1) O Defaults to 1.

Create a test file
Don't try to upload the whole file without testing it first. If something goes wrong you may then have to delete all those half-
imported glossary items and try again. Create a test file and run that first.

Copy, say, the first three lines of your text import to a separate file
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)
Upload the file to the server

Import the test file
You are now ready to import the test file to KBPublisher.

Click on the Import menu
Click on the Import Glossary tab
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File  in the SQL Load Command  field
Browse for the CSV file on your drive and load it

If the import file is on the server,
Choose Load data file
Type the address where the file is located into the Path to file field on CSV file line

Change CSV options if required.
Click Load

On completion of the load, you will see a message at the top of the Import Articles screen telling you how many files were imported
successfully and how many were skipped.

If the upload was successful, click on the Articles tab to check out the articles.

Fix any problems
All going well, you should now have three new glossary items in your knowledgebase. Check them carefully and ensure that
everything worked as you expected. If you had problems, delete these, fix the test file and run it again. Keep fine-tuning until it
works, and then update the real file to match the fixes you made in the test file.
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You are now ready to import the rest of the glossary.

Import articles
Import the rest of the glossary using the same process as for the test file, only this time using the real data file.

Note:

If the glossary item already exists, a new item will still be uploaded.  We recommend you do not duplicate.
If any unique keys will be duplicated during import, records from cvs file will be ignored.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Add a Local File

When you want to add files to the knowledgebase, you can upload files from your local computer, or you can link to files that are
already on your server or files located on Amazon S3 server. In KBPublisher such files are known as "local files". If the file already
exists on the server it saves space to reference it rather than uploading a second copy specifically for the knowledgebase.

By adding a reference to a file that may be also be available through your corporate website or some other site (forms, disclaimers,
fair-use and privacy policies, product disclosure statements, catalogues, printable manuals, and so on) you can make the
knowledgebase richer and more useful without taking up additional space.

To add a local file (a reference to a file already on your server):

Select the Files menu
Choose the Add Local Files tab to display the Local add form:

 

Complete the form's fields:

Files -- Click the [+] icon. In the popup window, choose the source directory or Amazon S3 (if enabled; see the "Allow access
to Amazon S3" setting in the Admin tab to enable the Amazon S3 option).

For Directory, enter the name of the directory on your server which holds the files you want to link to.
For Amazon S3, enter the S3 path in format: bucket_name/prefix/... (prefix is optional)
Then click the [ >> ] icon to display files. Check all files or check the checkbox for each file you want to link to, and click
Done.

Category -- Add one or more categories for the files by clicking the + icon to the right of the Category field and selecting from
the list of categories provided.
Title -- Add a title. If you are linking to more than one file in this operation, all files will have the same title.
Description -- Add a description. If you are linking to more than one file in this operation, all files will have the same
description.
Author -- By default you are identified as the author of the files. Click the Delete link to the right of your name to remove it.
Tags -- To add a tag, click [+]. You can add tags one at a time by hitting Enter after typing each tag. Or you can add multiple
tags at a time by separating each with a space as you type. You can join 2 or more words together in one tag by enclosing
them in quotation marks.
To select a tag from your existing list (tags previously used in KBPublisher) click Choose from your tags  and select the tags
you want to use.
Private -- You can opt to restrict either or both read and write access to the files. If you check either check box another field
appears where you can specify which roles users must have to be able to read and/or update the file.
Status -- You  can set the file status as Published or Unpublished.
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When the form is complete, click Add files to add the files to the list on the Files tab.

If you have the correct permissions, you can add the files as drafts. Click Save as Drafts  to add the files to the list on the Drafts
tab. Use this option for files that you do not want to publish yet, or for files that require further review or approval before becoming
available. 

Tips:

The files that are found are controlled by the Allowed/Denied extensions setting on Admin tab under Settings. If you have
said there are no restrictions, then all files in the directory are found. If you have said only image and text files are loadable,
then only image and text files will be found.
The PHP open_basedir setting determines where KBPublisher searches for the files. If you find that Get Files only searches
the directories under the knowledgebase itself, then check your settings to see if PHP restricts it to this.

User Manual v7.5 93



Automatically Add Local Files

The Directory Rules screen allows you to set up the knowledgebase so that KBPublisher automatically checks the specified
directory on the server or on Amazon S3 server every day and adds in KBPublisher links to any new files.

Standard allowed and denied extension rules apply, based on your denied and allowed extensions set in the Files Settings. 

Note: this option doesn't move files, it adds links in KBPublisher to files on your server. If you move a file from the location
KBPublisher linked to, the links to that file in the knowledgebase will be broken. 

To see and manage your directory rules, select Files in the main menu, and then the Directory Rules tab:

If you have a long list of directory rules, you can filter the list by rule status or by the directory the rule applies to, using the fields
above the list of rules.

Managing directory rules
Check the checkbox in the Active column for a rule to enable that directory rule. Uncheck the checkbox to disable the rule.

Click the [...] actions icon in the last column of a row to perform one of these actions on the directory rule in that row:

Edit - update the rule's information. The fields are the same as when you add a new directory rule - see the descriptions
below.
Delete - delete the directory rule.

Adding new directory rules
To add a directory rule, click the Add New  button. Complete the form that appears:

User Manual v7.5 94

https://www.kbpublisher.com/kb/entry/84/


Rule options:

Directory - Choose source Directory or Amazon S3 ((if enabled; see the "Allow access to Amazon S3" setting in the Admin
tab to enable the Amazon S3 option).

For Directory enter the directory on the server. The directory name should be the full server path.
For Amazon S3 enter the S3 path in format: bucket_name/prefix/... (prefix is optional).
Click [→] to verify that the path is correct. If the path is correct, in popup window you will see a list of all files in that
directory.

Parse child directories - Check this option to have the rule monitor all sub-directories in the directory. This is selected by
default.
Description - A description is not required, but you can add one to describe the files that normally appear in the directory, or
information about the directory rule that may be useful to other team members.
Active - This field is selected by default, and once you save the new directory rule it will run at the next scheduled
opportunity. Uncheck this check box to disable the rule. You can also enable and disable a directory rule from the full list of
rules, as described above.

File options:

Category - Add one or more categories to which the links to the new rules this directory rule finds will be added. Click the
[+] icon to the right of the field to add a category.
Author - By default the current user's name appears in this field, and will be associated with the link to any file the directory
rule adds to the knowledgebase. You can select a different user's name as the author, or opt to have no author name.
Private - By default the links the directory rule creates are public. Check one or both check boxes to control read and write
access to the linked file to users with the roles you specify. See private read and write.
Status - By default, files are set to a status of published, but you can change this to unpublished.

To test the settings click Test.

Click Save to save the new directory rule. Click Cancel to abandon your edits and close the form.
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Exporting
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Enable Exporting to PDF

To export multiple articles to PDF or HTML files you need to:

Install a program called WKHTMLTOPDF (recomended) or HTMLDOC
Ensure Settings points to where you installed it
Ensure that PHP has access to your HTMLDOC directory. (Check your open_basedir PHP setting in php.ini)
Ensure that PHP can run the proc_open function. (Check your disable_functions, safe_mode_exec_dir PHP settings in php.ini)
Buy the export plugin  or try it in Demo mode
Add the plugin key to your KBPublisher settings

Using WKHTMLTOPDF (recommended)
WKHTMLTOPDF is available from https://wkhtmltopdf.org
Download it and install it

Update the setting to point to WKHTMLTOPDF

Once you have installed WKHTMLTOPDF, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Plugins -> Export -> WKHTMLTOPDF installation path
Make sure the WKHTMLTOPDF installation path points to the directory where you installed HTMLDOC. For
example: /usr/local/bin/.
When you click "Save", test HTML file will be parsed and error occurs if it failed.

Test WKHTMLTOPDF from command line

To convert a single web page type:

$ /path_to_wkhtmltopdf/wkhtmltopdf input.html output.pdf

Test using PHP and included test file:

$ php -r "exec('/path_to_wkhtmltopdf/wkhtmltopdf http://path_to_kbp/admin/extra/plugin/export2/template/export_test.html
output.pdf');"

Using HTMLDOC
Note: At this time there is no commercial support for the HTMLDOC. The windows binaries can be found here.

HTMLDOC is available from https://www.msweet.org/htmldoc/
Download it and install it

Update the setting to point to HTMLDOC

Once you have installed HTMLDOC, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Plugins -> Export -> HTMLDOC installation path
Make sure the HTMLDOC installation path points to the directory where you installed HTMLDOC. For
example: /usr/local/bin/.
When you click "Save", test HTML file will be parsed and error occurs if it failed. 

Test HTMLDOC from command line

To convert a single web page type:

$ /path_to_htmldoc/htmldoc --webpage -f output.pdf filename.html

Test using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_htmldoc/htmldoc --webpage -f output.pdf admin/extra/plugin/export/template/export_test.html');"

Buy the plugin
Export functionality is not available with the default KBPublisher package. You must purchase it separately.
Please see this article how to buy the plugin.

Add the plugin key to KBPublisher

You should have received an email with you plug-in key. If you can't find the email,
you can also get this from the My Licenses tab in your client area on the KBPublisher website.  
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Copy the license key from your client area or the email
Log on to your knowledgebase
Go to the Admin Area
Click on the Settings menu
Click on the Plugins -> Export tab
Paste your key into the Plugin key field
Save.

Tip:

If you want to try the export plugin before you buy, use demo mode to get an idea of how it works.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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The Export to PDF and HTML Screens Explained

The export to PDF or HTML screen allows you to export your knowledgebase articles to HTML pages or PDF files.

The Summary screen
When you first enter the screen you see a summary of any current exports that have been set up.

1. Export functionality is provided as a plug-in and is purchased separately. If you have not purchased the plug-in you will get a
message telling you that the plug-in works in demo mode - with some restrictions - but otherwise doesn't work.

2. Add New allows you to set up a new export.
3. The records information line contains the usual information, like how many records there are, and how many pages of records

there are.
4. Title is the name of the export.
5. Category is the top-level category that will be exported. Any sub-categories will be exported as well.
6. Last generated shows the last time you generated documentation to export.
7. The options button opens a menu with the commands:

The Details/Download action allows you to view details of the specific export and download the file.
The Update action allows you to update the export.
The Delete action allows you to delete the specific export.

When you click on Add New , you are taken to the Add New Export screen.

The Add New Export screen
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1. Again, if you have not purchased the plug-in, you will get the message at the top of the screen.

Export options

The export options define what data you are actually going to export.

2. Title is the name you are giving to this particular export.
3. The description is displayed on the Export Details screen. Use it for information about how and why this particular document

template was set up.
4. Category to export. You can only export one category at a time but, but all sub-categories are exported as well.

Click on the + to the right of the Category to export field to select the category.
5. Export for user controls which articles are exported. That is, the audience for the published document.

To export all articles in the category and in any sub-categories, irrespective of roles or privileges, choose Admin user . You
might use this for internal documents, or even for proofing.
To export only those articles that the user sees in the Public view, without logging on, select Not logged user.
To export articles that a user in a specified role will see, select Logged in user . If you select this option, you also need to
assign a role.

6. The with role field is only displayed if you choose to export for a logged user. Click on the + to the right of the with role box
to select the role. Again, you can only select one role.

7. If you need help filling out a specific field, click on the ? for that field.

Document options

The rest of the screen is devoted to how the output is produced.

8. Select the Include article info  checkbox if you want article information to be included into the export file (article ID, last
update, etc).

9. When you check the PDF button extra fields are displayed for you to complete. These fields are specific to the PDF output.
10. Orientation allows you to set the page as portrait or landscape.
11. Cover allows you to set the front page of your PDF document.
12. Header allows you to set the header which appears on the top of each page of your PDF document.
13. Footer allows you to set the footer which appears at the bottom of each page of your PDF document.
14. If you choose HTML (single file) your document is produced as one big HTML file.
15. If you choose HTML (multiple files) each article gets its own HTML file.
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16. Click Save to save the template without generating the document.
17. Click Save and Generate to create documents as well as saving the template.

To actually view the generated document you need to go back to the Export screen and click on the template you have saved.
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Export Articles to PDF or HTML

What does export articles do?
Our export functionality allows you to export all or part of your knowledgebase to a PDF or to HTML files. This is ideal if you want to
create a user manual or place some of your content elsewhere.

You can export the whole knowledgebase or a single category and sub-categories, and you can use roles to tailor the articles for a
specific audience.

Producing an exported document is a two-part process. First, you create an export template by defining what articles you want
included and the document format.  Then you generate the file. The two-part process allows you to set up the document once and
regenerate any time you want to include updated content.

To create a new export template
To export:

Click on the Export -> PDF/HTML tab
Choose Add New .

This takes you to the Export screen where you choose the following export options:

Provide a title for the export.
We recommend that you add a description, Once you have a number of exports set up this will help to identify them.
Select a category to export . You can only select one category. Sub-categories will be exported as well.
If you wish to select the whole knowledgebase, select the topmost parent category.
To select a category, click on the + to the right of the category to export field, double-click on the category to move it down to
the assigned category box, and OK.
Choose which user type to export for in export for user.
To export all articles in the category and in any sub-categories, irrespective of roles or privileges, choose Admin user. 
To export only those articles that the user sees in the Public view without logging on, select Not logged user.
To export articles that only users in a specific role will see, select Logged user. If you select this option, you also need to
specify a role as well.

If you are creating a PDF

Add a title. This is displayed on the title page of the document.
If you want the title to be displayed on the header of each page, check Add to header.
If you want an image on the title page, click on the folder to the right of Title image. This takes you to the load image page.
If you need to, load the image from your local drive by clicking Add New  and browsing for the file to upload it.  Once your
image is in the list, click Attach, and then close the load image popup.
Check the PDF option. This opens up some new fields specific to PDF documents.
Use the orientation to choose whether the document is to be in portrait or landscape mode. Default is portrait mode.
If you intend to print the document double-sided, check two sided. This sets up left and right pages.
To add a logo to the header on each page, click on the folder to the right of logo image and select your logo from the list.
Again, if the logo you want is not in the list, you can upload it from a local drive. Once you have selected the logo, Attach it
and close the load image popup to return to the Export screen.
If you wish to password protect the PDF document, add a password.

If you are creating an HTML page or pages.

Add a title. This is displayed as the tab name on html documents.
If you want an image to be added to the title page (index.html), click on the folder to the right of Title image. This takes you
to the load image page.
If you want each article as a separate HTML file, check HTML (many files). If you everything in a single html file, check HTML
(one file).

Save your settings.

Click Save and Generate to save your template setup. You can reuse this setup as often as you like to generate new
documents for these settings. At the same time a first copy of the document is generated.
This returns you to the Export screen with the new export template listed

Tip:

You are not limited to saving in one particular format. You can check all three options if you wish.
If you just want to set up the export rather than generate it right now, click Save rather than Save and Generate when you
have completed all the fields. This sets up the export file but doesn't generate it.
HTML files are zipped.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Export Articles to CVS, Excel or XML

To find the Export Articles tab, select Export from the menu bar. Then select Export Articles from the three tabs available:

What does export articles do?
The Export Articles tab lets you export the articles and information about the articles, in spreadsheet form. You could then review
and work with the material in Excel or any other spreadsheet tool, or use the file to import the data into a database.

To manage your exports
The tab displays a list of your export templates. Click the Action button to the right of an entry for the action options:

Details - Review the details of exports using this template, including the date and status of the most recent export.
Click Generate beside any export type to regenerate the export files.
Click the export type name (CSV, EXCEL, or XML) to download a ZIP file of the exported files.
Click Update to move from here to the Update action, or click Back to return to the list of export templates.

Update - Update the selections or description for the export, following the information for creating a new export, below. Click
Save to save your changes; click Save and Generate to export the data for this export again; click Cancel to abandon your
changes and close the form. 
Delete - When you select this option, a confirmation form appears to make sure you really want to delete this export
template. Click OK to remove the record; click Cancel to keep the template and end the process.

To create a new export template
To create a new export template, click Add new to open the Export options form. Complete the form to export the articles you
want, and the metadata about them you select.

Title - Required. Provide a title for this template.
Description - Optional. Provide a description for this template.
Category to export - You must select at least one category. Click the + button and select from the options available. If you
need to export all KB, choose "All categories (All KB)".
Export for user - Some articles may be invisible to certain user types. Select the user type to filter the categories you chose
to include just the content that user type can see. Options are:

Admin User - Export includes all content in the selected categories. The system ignores any private attributes for the
user.
Not logged in user - Export includes content a user who is not logged in can see.
Logged in user - When you choose this option you can specify roles to limit the export to the content a user with a
selected role can see. To add a role, click the + button and select from the options. If you specify no role, then the
export includes all content a logged-in user can see.

Columns - Select the columns to include in the export by dragging the names of the columns you want from the "Columns not
included in table" list to the "Columns included in table" list. To remove columns from the export, drag the column names back
to the left-side list. You can rearrange the columns in the export table by dragging the column names higher or lower in the
right-side list.
Encode images - Select this option to encode any images included in the export in base64 format.
Export published articles only  - Select this option to include in the export only published articles.
Document options - You can select one or more of the export options: CSV, XML, and EXCEL.
For CSV you can accept the defaults for the following fields, or edit the field contents to suit your needs:

Fields terminated by  - Default is a comma (,).
Fields optionally enclosed by  - This allows you to include the field terminator, such as a comma, within the text of a
field. The default is double quotation marks (").
Lines terminated by  - The default is \n.
Include field names row  - Select to include a header row of all field names.

Click Save to save this template; click Save and Generate to save the template and generate files in the formats you have
selected with the required data; click Cancel to close the form without creating a template.
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Generate file from export template

Once you have saved an export template, you can use it at any time to generate or regenerate a document. The new export takes
the latest copy of each article from your knowledgebase.

Click on the Export menu
Click on the tab with the required export format to display the export templates you have for that format.
For the template you want to use, click the icon in the Action column. Then select Details.
In the Details screen you can review information about the template and, in the Downloads row, information about files it
has been used to generate. This row has different sections depending on the export format:

Export KB to PDF - one section
Export KB to HTML  - a section for single-file export and another for multiple file export.
Export Articles - up to three sections for Excel, CSV and XML export, depending on how the template is set up.

If articles have already been generated, you can click the file type to download them.
Click Generate for the format in which you want to generate or regenerate documents. If there is an export date, it updates
to reflect the date and time of this export.. 
Click the file type to download the newly-generated documents.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Export Articles from the Public Area

If you have purchased the export plugin, then you can set your knowledgebase up so that users can export a whole category of
articles as a PDF document, or print it, from the Public Area.

To allow public export of articles
Purchase the export plugin and install it
On the Settings menu choose the Plugins tab
Check allow category exporting .

To generate a PDF file or print a category from the Public Area
Once allow category exporting is set, users will find an Options button on their screen when they view a category

Click on the Options button
This opens a new options panel which allows a user to:

Search for items specifically within the category they are looking at
Create a PDF document
Create a printable html page.  This contains basic text without all the headings and left menu and right information
block.

The information covers all articles in the category.  The user can then print or save this as required. 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Export articles to PDF in demo mode

KBPublisher ascribes the "try before you buy" philosophy. 

You can try the export plugin by using a key of demo key instead of a purchased key.
This allows you to set up, create and test the export plugin and to work out if you want to buy it.

There are some limitations with the demo model:

Only the first three articles for each category will be exported.
A watermark is added to the page background.
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News
News functionality in KBPublisher
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The News Input Screen Explained

1. The blue line at the top of the screen denotes whether you are adding a new news item or editing an existing one.

2. The Date is the news date displayed on the Public area screen.

3. The Title is the news heading.

4. Body is the news article itself.
Note that on the Public area home page the user only sees the first characters of this. They click on the news heading to open
the news item and see the rest. To set the maximum number of characters displayed under an article, go to the Admin
area: Settings -> Public Area -> Articles -> Article preview format -> Article character limit.

5. Tags are search words. If you define a keyword here and a user then searches using that keyword, this news is displayed. Use
a comma to separate each keyword.
Some external search engines may also use this for search engine optimization.

6. Checking the Private Read option allows you to force users to log on to see the news item. Checking Private Write allows
you to control who can edit the news item. Checking both gives you control over who can read it, whether they have to log on,
and who can update it.

Designating that a news item is private brings up a list for you to choose Access for selected roles only . This allows you to
assign which groups of users (users in which roles) can actually read the news item. Choose None if you just wish to make the
news private (so they have to log on) but still want everyone to be able to read it. Otherwise, choose the role(s) that can see
or update this item.

7. Checking the Schedule option allows you to dictate a date and time for when a news item is published and when it drops off
the news list.
When you check Yes to the Schedule option it brings up a date and time, and allows you to determine whether the news item
is to be published or not published at that time. An And option allows you to specify a second date/time and status to
schedule.

8. Use the Published option to specify whether users can read the article or not.
You would often use this in conjunction with scheduling. For example, you may set a news item so it is not (Published option
not checked) and schedule it to be published on a specific date and time.

9. The Save and Cancel buttons are standard. Save means save the news item, Cancel means exit and don't save.
If the Published checkbox is selected, the Publish button appears instead of Save. After clicking the Publish button, the
news become visible in the Public area. Save and continue editing allows you to save the document but remain on the edit
page to make more changes.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Add News Item

The quickest way to add a news item to use the Shortcuts menu at the top of your screen:

Click on the drop-down menu in the top right of the screen and choose Add News .

Or you can do it via the News tab in the Admin Area.

Click on the News menu
Click on Add New .

Once you are on the news screen you must complete the following sections:

Add a Date for your news item
Add a Title. This is the heading displayed on the public screen
Type your news item in the Body editing box
Specify whether the news item is Published or not.

The following items are optional:

To force users to log on to read the news item, mark it as Private
To publish or change to not published at a future date, Schedule it

You can find out more about each of these fields and how they work in The News Screen Explained.

Once your news item is complete:

Click Save.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Edit news item

To edit a news item, including changing the date, changing the text, schedule and whether an article is published or not published
and private or not private:

Choose News menu
Click the Options icon under Actions to display the dropdown list, and then click Edit.

You can find out more about each of these fields and how they work in The News Screen Explained.

If you wish to simply change the news item to published or not published:

Choose News menu
Check or uncheck the Status option.

You can also use the bulk update option to set a news item as private/not private and published/not published or to delete it. Using
this feature, you can update more than one news item at a time.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Delete news item

To delete a single news item:

Choose News menu
Click on the News tab
Click Delete from the options dropdown menu.

To delete one or more news items:

Choose News menu
Click on the News tab
Check the Actions with selected check box to the left of each article you wish to delete
Choose Delete from the Actions with selected box at the bottom of the screen
Click OK
OK again to confirm that you really do want to delete these articles.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Bulk update news items

KBPublisher allows you to bulk update news items to:

Publish news items or set them to not published
Make news items private or public
Schedule news items
Set custom fields
Set news status
Delete news items

You can do this direct from the News menu, News tab.

To update the news items:

Check one or more news items to update
Choose the appropriate action from the drop down list of actions with selected
This brings up further options to select from according to the action chosen. Choose the appropriate selection
Click OK.

Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete articles that you have created,
then there is no 'Delete' action in the list of options. If your privilege does not allow you to update items, or allows you to only
update items you have created, then this menu will not be available for you at all.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to news

To be notified when news items are added to the knowledgebase:

Click on My Account
Click on the Subscriptions tab
Choose Subscribe/Unsubscribe for News.  This brings up a subscribe button.  
Click Subscribe

You will be notified daily of changes to news items.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from news

To no longer receive notifications about updates to the news area of the knowledgebase:

Click on My Account
Click on the Subscriptions tab
Choose Subscribe/Unsubscribe for News.  This brings up a subscribe button.  
Click Unsubscribe

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Remove scheduling

To remove scheduling from an article, file or news:

Edit the item
Uncheck the Schedule checkbox

You can also use the bulk actions option to remove scheduling from multiple articles or files:

Select each item to be un-scheduled
Choose remove schedule from the Actions with selected options at the bottom of the screen.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Articles
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Articles

Information about Articles, how they work and how to add and update them.
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The Article Input Screen Explained

The article screen is divided into two tabs. A Main tab, which is what you use to create the article, and an Advanced tab, where
you set external links, the order of the article inside a category and whether or not the article is published. The Advanced tab also
allows you to schedule articles for publication.

The Main tab

1. The blue line at the top of the screen denotes whether you are adding a new article, or editing an existing one.

2. If this is an existing article, it will have an Article ID. This is the record number under which the article is stored in the
database. You can easily find any article if you know its ID.

3. It will also show the date the original article was created in Date Posted, and who created the article.

4. The Date Updated field shows the last time the article was updated, and who updated it.

5. Type has two purposes. It is used to group records for searching and it can also provide a default template for the article. It is
not compulsory. If you want to remove a type you have already included, set the Type back to the first item in the drop-down
list (___).
Articles types can be managed in Tools -> Lists -> Article Type.

6. Category controls where the article will be placed in the knowledgebase. It is, effectively, the menu or the table of contents.
Note the red '*' to the right of the word 'Category'. This means that this field is compulsory. Note also that some of the
categories are red. These categories are private categories. When you select a private category, KBPublisher lists roles and
restrictions beneath the category list so that you know which users can access the article.
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7. You add or remove categories by clicking on the + and - buttons

8. Title is the heading that goes on the page, and also the link that is displayed under the category (table of contents). It, too, is
compulsory.

9. The Article is the content that people read. Again, it's compulsory. Type your article into the edit box. Move your mouse over
each of the icons in the edit toolbar to see what each one does, or you can read about each function in edit toolbar explained.

10. Templates can be inserted into the text by choosing the template from the drop-down list and then clicking on Insert, Replace
or Include template. Using templates in articles describes how templates work and how to use them.

11. Tags are search words. If you define a keyword here and a user then searches using that keyword, this article is displayed.
Use a comma to separate each keyword.
Some external search engines may also use this for search engine optimization.

12. You can easily cross reference other articles in your KBPublisher database by choosing Related articles. You can link to text
within the article, or you can add a link that is displayed under the heading 'Also read' at the bottom of the page. How do I add
a link to an article explains the process in more detail.

13. You can link to files in your KBPublisher database by choosing Attachment. Again, you can add it as a link to text within the
article, or you can add the link at the bottom of the page under the heading 'Attached files'. Attach a file to an article explains
this in more detail.

14. Use the Status to specify whether this article is published, meaning users can read it, not published, or pending (approval
required).
Articles statuses could be managed in Tools -> Lists -> Article Status.

15. The Revision comments box is only displayed once you start editing the content of the article. Use this to add comment
version history information. When you look at the history, these comments will help you remember what was changed for this
verison.

16. The Save and Cancel buttons are standard. Save means save the article, Cancel means exit but don't save. 
Save and continue editing allows you to save the document but remain on the edit page to make more changes.
Save, do not mark as updated option allows you to save the document but not update article updated date, this allows to
skip this article from subscription for updated articles.

The Advanced tab
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1. Again, the blue bar tells you whether you are editing an existing article or creating a new one.

2. The Meta Description is a brief summary of what is on the page. This description is often used by search engines when
displaying details of a page.

3. You can add links to other web sites by adding them to the External links field. Type or paste the address (URL) of the page
you want to link into the field. These then appear at the bottom of the article under the heading 'External Links'.
You can append an optional title to each link using a pipe symbol to separate the url and title.
Use an to separate links. Links must begin with http://. e.g. http://kbpublisher.com | KBPublisher

4. The categories you have selected for the article are listed in the Order field, along with a drop-down list of where to place the
article within the category. There is one order list for each category you have chosen.

5. Checking the Private Read option means that the user must log on to read the article. Checking the Private Write option
allows you to restrict who can edit the article.
Designated that an article is private brings up a list for you to choose Access for selected roles only. This allows you to
assign which groups of users (users in which roles) can actually read the article. If you just wish to make the article private but
still want everyone to be able to read it, choose None.

6. You can Schedule articles to be published or not-published at a specified date and time.
Checking the Schedule box brings up date, time and status fields. Fill these in to schedule that the article will change status on
that date. You can specify one or two schedule dates. Schedule an item explains this in more detail.

7. Must Read option allows you to set up a mandatory reading requirement.
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1. Set or unset reading requirements.
If your update article set as "Must Read" you have an option "Reset read confirmations", it means all read
confirmation will be reseted and assigned users should confirm it again.
 

2. Select who should read the article.
It is very flexible, you can assign all users, all staff users (user with privilege), or user with specified role or privileges or
specified users.
 

3. Add notes user will get with Must Read notification.
 

4. Set if reading requirement will expire.  
If not checked Must Read will never expire, the following rules applied: 
- Users who did not confirmed it will get notification until he confirm it.
- All new matched user will get a Must Read notification.  

If expire date is specified: 
- Users who did not confirmed it will get notification until he confirm it or expire date .... 
- All new matched user will get a Must Read notification before expire date.   
 

5. Force users to read  the article.
OFF (not checked) - On login user will be notified  but it is allowed to read it later.
ON (checked) - On login user will be notified and it is not allowed to go further until he confirm he read it. (Allowed go to
Admin Area and User's Account)
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The HTML editor toolbar explained

The text editor of KBPublisher is an FCK Editor.
You can edit the text as text (wysiwyg), or if you are familiar with HTML, you can edit the source HTML.

 

A summary of each command
 Command What command does

Hides the toolbar to give you more editing space. Click again to re-display the toolbar.

Allows you to edit the HTML source of the article.

Controls the templates. Note that this is similar functionality to the templates drop-down menu above it,
but the way you insert the template is slightly different (even though the end result is the same). See
using templates with articles for more detail about this.

Displays the page as HTML. i.e. As the users might see it.

Maximize the editor. This gives you a larger area to type into. Click again to return to normal.
Cut the highlighted text to the clipboard. The first time you cut or copy in an article you may be asked to
allow access. Click OK.
Copy the highlighted text to the clipboard. The first time you copy or cut in an article you may be asked to
allow access. Click OK.
Paste the text you copied. Any formatting will be included.

Paste the text you copied as plain text. No formatting will be included. For example, if the text you copied
was bold this paste will remove the bold.
Copy content from Microsoft Word.

Documents created in Microsoft Word produce messy HTML, with lots of unnecessary tags. This paste
allows you to clean up some of those tags. To use it:

Copy the text from your Word document
Click on the Paste from Microsoft Word  icon. This brings up a pop-up box
Use <Ctrl><V> to paste the text you copied into the box
Check Ignore font face definitions if you don't want the font data carried across
Check Remove Styles definitions  if you want to remove the Microsoft styles
Click Clean up box  to remove unwanted tags
Then click OK to copy the text back into your KBPublisher article.

Print the HTML page.

Undo or redo.

Find text in the article.

; Replace text in article.

Select all.

Remove any formatting.

Format the text as bold, italic or underline.

Create a numbered list.

Select all of the text in the HTML page (usually used before copy or cut, or to apply a style or format to the
whole page).
Indent text or remove indent.

Align the text. Alignment options are left aligned, centered, right aligned or justified.

Insert or remove a link.
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Insert an anchor.

Insert a picture. You can find out more about inserting images in add a picture to an article.

Insert a Flash animation into your document. Works similar to adding a picture.

Insert a table. Clicking on insert table brings up a pop-up box that allows you to set the table properties.

Inserts a horizontal line into the text. (The html <hr/>)

Insert emoticon. Brings up a list of common smileys for you to choose from.

Allows you to insert special characters such as copyright or trademark symbols, or em and en dashes.

Inserts a page break into the text.

Change the color of any highlighted text.

Change the background color of any highlighted text.

Show blocks.

Gives information about the editor.

Choose a style. This allows you to select a style from those defined in
admin\tools\fckeditor_custom\fckstyles.xml.

Select one of the standard pre-defined styles.

Select a font for your text.

Select a size for your text.

The editor also allows you to use some standard control key combinations as well, in particular:

<Ctrl><X> for cut
<Ctrl><C> for copy
<Ctrl><V> for paste
<Ctrl><Z> for undo
<Ctrl><B> for bold
<Ctrl><I> for italic.
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Quick add or update an Article

The Quick Add/Update feature is a shortcut that will significantly reduce the time it takes for you to add or update an article to
 Knowledgebase. When you initiate this feature an article template will be presented to you and the inline HTML editor functions will
be available so that you can create text, customized to your specifications.

To add or update an article, you must be an authorized user.
Sign in to your Knowledgebase. 

Quick Add

1. Click on Manage in the upper right corner.
2. From the drop down list select Add Article Here.
3. The first screen will ask you to select an appropriate category to publish an article.
4. Once you select a category, a new screen template will be displayed which will enable you to add additional information about

your article.
5. When you are done simply click Publish button on the lower right hand side of the screen.

Quick Edit 
1. Click on the article that you want to edit.
2. With the article open, click Admin Tools menu icon on the right of the article title or on the right below the article, from the

drop down list select Quick edit.
3. After making your changes simply click on the Save button to save the changes you made to the article.
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Add an Article

If you are in the Public area, the quickest way to add an article is via the Manage menu in the top right of your screen:

Click on Manage -> Add Article Here

If you are in the Admin area, another fast way is to to use the Shortcuts menu at the top of your screen:

Click on the Add drop-down menu in the top right of the screen and choose Article.

Or you can do it via the Articles tab.

Click on the Articles menu
Choose the Articles tab
Click on Add New .

Once you are on the article screen you must complete the following sections:

Choose where you want the knowledgebase article to be displayed by adding a Category or categories
Add a Title. This is the heading displayed on the knowledgebase screens and in any menus/table of contents.
Type your article in the Article editing box.

The following items are optional:

To help users search within your database, include a Type and Meta Keywords
To optimize web search add Meta Keywords/Tags and a Meta Description
To add links to other web sites, include External links
To add links to other articles in the KBPublisher database, include them as Related articles
To add links to files, include then as Attachments
To force users to log on to read an article, mark it as Private Read. To restrict who can read the article mark it as private
read and then assign specific roles which can access it.  To restrict who can edit the article, mark it as Private Write.
To say where in the list the article is placed, specify the Order
Use the Status field to make the article available to read.

You can find out more about each of these fields and how they work in The Article Screen Explained.

Once your article is complete:

Click Save.

Tips:

If you have a number of articles to add from another database, say, you may want to import articles instead of adding them.
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Update an article

There are two ways to get to the update article screen.

One way is to:

Choose Articles menu
Click on the Articles tab
Click the Options icon under Actions to display the dropdown list, and then click Edit.

The other way is to

Click on the article to view it
Click on Quick Edit to update article in place or click Edit Article to open article for update in Admin Area

You can find out more about each of these fields and how they work in The Article Screen Explained.

You can also use the bulk update option to update the categories, type, meta tags, status and description. Using this feature, you can
update more than one article at a time.
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Delete an Article

To delete a single article:

If you are in the Public area, click on the Admin Area link
Click on the Articles tab
Click Move to Trash from the options drop down menu.

To delete one or more articles:

If you are in the Public area, click on the Admin Area link
Click on the Articles tab
Check the Actions with selected check box to the left of each article you wish to 
Choose Move to Trash from the Actions with selected box at the bottom of the screen
Click OK
OK again to confirm that you really do want to delete these articles.
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Add a Picture to an Article

Graphics must be uploaded to the server before you can display them on the page. You can upload them as part of adding the
image.
You can "drag and drop" an image to the HTML editor, it will added to cusror position of an  editor.

Add or edit the article you wish to add the picture to
Place your cursor where you want to add the picture
Click on the Insert/Edit Image icon in the Article edit box  

Click on Upload

 
Click Choose File to find the file you want to upload, click on file this brings you back to the upload screen.
Click Send it to the Server.

 
This takes you back to the Image Properties box with the address of the file in the URL line.
This is the minimum you need to do to add the picture. You can optimize it by adding alternative text, resizing it, adding
borders or margins, adding links or modifying the style.
Click OK to add the picture to the article.

If image already on server

Click on the Browse Server button

 
Find file on server, double click on the name of the file you want to add 
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This takes you back to the Image Properties box with the address of the file in the URL line.
This is the minimum you need to do to add the picture. You can optimize it by adding alternative text, resizing it, adding
borders or margins, adding links or modifying the style.
Click OK to add the picture to the article.

Tip

You can "drag and drop" an image to the HTML editor, it will added to cusror position of an  editor.
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Assign category to article

Assigning a category to an article is a two-part process. First you assign the category, and then you define the order the item is
displayed in that category.

To assign the category
Create or edit the article.
Click on the plus (+) button on the right-hand side of the category field.
This opens the Assign a Category screen

 
Select a category by using the text entry field at the top of the screen. You can start typing a category name to filter the
category list.
You can select multiple categories.
Click OK to save your changes and exit the Assign a Category screen.

On the Assign a Category screen you can also:

Unassign categories from this article by clicking the x button.
Drag and drop categories into your preferred assignment order.
Select which category the article will be published in, and which categories the article will be listed in.

Tips:

To quickly assign a category without opening the Assign a Category screen you can:

Start typing a category name and then select the category.

To quickly unassign a category without opening the Assign a Category screen you can:

Double-click on a category in the Category box.
OR
Click on a category in the Category box, and then click the minus (-) button.

To order the category
When you exit from adding the category you return to the article screen. 

Click on the Advanced tab
This will now contain a list of each category you have assigned, and an order.  By default, articles are placed at the end of the
category.
Click on the order drop-down list beneath the category you wish to re-order
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Select a new position from the list
Click OK to save and exit from editing the article, or if you wish to continue editing the article, return to the Main tab,
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Link to another article (related articles)

To embed a link to an article
Add or edit the article to which you wish to add the link
Highlight the text to be linked

Click on the plus icon in Related Articles field or use the Link to article icon  in HTML editor
In the popup find an article you wish to link to
Click on the Insert icon located in the Action column

To attach a link to an article (Related Articles)
Add or edit the article to which you wish to add the link
Click on the plus icon in Related Articles field
In the popup find the article you wish to link to
Click on the Attach icon located in the Action column

To embed a link to a linked article
Edit the article to which you wish to add the link
Highlight the text to be linked to
Under Related Articles click on Link icon, located to the right of the article title

Tip

When you add a link to another page, the page that you link may also include a link back to this page under the 'Also Read'
heading. In the editor, you can turn this on by checking the cross reference  checkbox under Related Articles, located to the
right of the article title.
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Attach a file to an article (attachment and embedded link)

The New Attachment functionality allows you easily attach files and embed links to files in your article. It allows you to attach up to
5 files at once by either dragging the file, choosing a file from your local disk or selecting it from a list of already uploaded files.

Attach a file to an article
Add or edit the article to which you wish to attach a file
Click the plus icon in the Attachment section
The popup window Add Attachments will open like this:

 
In this window you can drag and drop a file, choose a file from your local disk or select it from already uploaded files
If you chose from uploaded files, find the file you want to attach in the popup window and click on the Attach icon

Note: When you upload new files using the Add Attachment window, the files will be posted to the Files module under the
Attachments category. This category is inactive by default so files will not appear in the Downloads section of your
Knowledgebase.

Add an embedded link to a file 
Add or edit the article to which you wish to add the link
Highlight the text to be linked

Click on the Link to file icon  in HTML editor
Find the file you want to link to in the popup window and click on the Link icon on the right

Embed a link to an attached file
Open the article which has the attached file
Highlight the text to be linked
Click on Link located to the right of the file name under Attachments

Tips

Once you have uploaded files, you can add links to them in your articles, much the same way as you can link to other articles.
This allows you to load a file once, but refer to it as many times as you wish.
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Article history

KBPublisher keeps a history of all changes you make to the content of an article.  You can view earlier versions and compare them
against the current version to see what has changed and you can roll back to earlier versions

By default, version control is turned on, and set to store unlimited number of revisions.

To turn off version control

Click on Settings menu
Choose the Admin tab
Set the maximum number of revisions  to 0

To change the maximum number of versions stored

Click on Settings menu
Choose the Admin tab
Set the maximum number of revisions  to the number of versions you want retain, use All to keep unlimited number of
revisions.

To view or recognize if an article has prior versions

Click on the Articles menu
Choose the Articles tab
Find the article in the list
Click [...] icon on the right, select History from drop down menu.

Tip

Only changes to content are stored.  If you modify the category or title, or update metadata, this is not stored in the version
history.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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The article history screen explained

The History screens shows all versions of an article.  From here you can compare earlier versions with the current one, revert to
earlier versions, delete versions and you can download a copy of a specific version.

1. Live Revision shows information about the current version.  Version number, date it was last created and any revision
comments.  When comparing versions, this is the version you compare against.

2. Revision number is a sequentially allocated number.  Each time you save the article, this number increments.
3. Date added is the date and time the version was created.
4. And who it was created by.
5. When you create a version you also add a revision comment.
6. View changes opens the version and compares it side-by-side against the live version. Changes in each document are

highlighted.
7. Rollback allows you to revert to a previous version. This then becomes the live version, while the formerly current version

becomes another historical version.
8. Load revision to update  opens the article for editing.  When you save the edited article this becomes the new current

version.
9. Download allows you to save the article (live version and an historical one) to your hard drive and compare it in your favorite

compare tool. The file is saved as HTML.
10. Public view displays the current live article in the public view.
11. Edit article opens the current live article for editing.
12. Delete all revisions  deletes all historical versions, leaving only the current version.  Note that if you wish to delete an

historical version, load the revision to update.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Autosave

Articles are saved automatically at intervals.  

For example, suppose you are called away from your desk in the middle of creating a new article. You don't expect to be away long,
so you don't save. An hour later you come back to your desk to find your session has timed out.  All that work lost.

Not quite.

Provided the administrator has turned autosave on, you can get your changes up to the last time the article was autosaved.

If you have not yet saved the article
If you were creating a new article and had not yet saved it, you can see it on the Articles tab

Log on and go to the Admin area
Click on the Articles menu
Choose the Articles tab
If there are any unsaved autosaved documents you will see a note at the top of the articles tab telling you that there are
unsaved drafts.
Click on the click here link to view the autosaved document(s).

Only the author can see the autosaved document

If you are editing an existing article
If you open an existing article for editing and for some reason the article was not saved correctly, or an error occurs on the
save, then when you next open the article for editing you will see the following message:

If you want to use the auto-saved version, click on Yes, open autosaved version.  
If you want to revert back to the old version, click on No, ignore autosaved version , which opens the version without your
edits
When you Save the article this new version becomes the current version and the autosave history is deleted.
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Articles being edited by another user

When you open an article that is already being edited by another user you get a warning message telling you that someone else is
working on the same document and that there are unsaved changes.

From here you can choose to:

Wait until later to edit the article.  
If you want to do this, click Cancel and come back at another time.
Try again , to see if the user has since closed the document. 
If the document is still being edited, you will get the same message.
If you wish to contact the person who was editing the article and to ask them if they are finished and if so will they please save
the document the Opened By information tells you who is currently editing the article.
Or you can ignore lock and proceed with editing  which overwrites anything the other user has done.  
Be aware when you do this that other author can also save over your work. The person who saves last is the one whose article
becomes the final article. 
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Remove scheduling

To remove scheduling from an article, file or news:

Edit the item
Uncheck the Schedule checkbox

You can also use the bulk actions option to remove scheduling from multiple articles or files:

Select each item to be un-scheduled
Choose remove schedule from the Actions with selected options at the bottom of the screen.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Add an article as a result of user feedback

Sometimes, feedback from a user generates an idea for another article.
You can create this article direct from the feedback page.

Click on the Feedback menu.
Click the [...] icon in a user feedback to display the dropdown list, and then click Create An Article.
This brings up a new article screen for you to start creating the new article. The text in the email is listed in the article title.
Create the article as you normally would and save it.
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Bulk Update Articles

KBPublisher allows you to bulk update articles to:

Move to category
Add to category
Set tags
Make the articles public or private
Schedule article publication
Reset rating
Set article type
Set author
Set custom fields
Sort articles (available only when filter for category applied)
Set article status
Delete articles.

You can do this direct from the Articles menu, Articles tab.

To update the article:

Check one or more articles to update
Choose the appropriate action from the drop down list of actions with selected
This brings up further options to select from according to the action chosen. Choose the appropriate selection
Click OK.

Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete articles that you have created,
then there is no 'Delete' action in the list of options. If your privilege does not allow you to update items, or allows you to only
update items you have created, then this menu will not be available for you at all.
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Import articles

You can import articles in bulk.
You might want to do this, say, if you are changing over to KBPublisher from another system.

The process is:

Create a file of articles to import
Upload a test sample to the system
Import.

Create a file of articles to import
First, you need to create your file of articles. This is a comma-separated (CSV) text file that consists of some or all of: title, body,
date_posted, id, author_id, updater_id, meta_keywords, meta_description, entry_type, external_link, date_updated, hits, sort_order,
private and an active flag.

The first three fields (title, body and date_posted) must be included. You can include some, all or none of the others as
required.
They do not have to be in the same order as above, but each line in the import file must contain the same fields in the same
order.
The active flag defaults to '1', which is active, so they only time you would set this is if you don't want the users to be active.
Place the data for each user onto a single line, and separate each field by a comma. Do not include spaces before or after the
comma.
Place quotes (") around text fields such as body, and be sure to check that your text does not have quotes within the text. If
your body, or other text field, does contain quotes, choose a different delimiter and update the fields optionally enclosed
by field to match.
The TestImportArticle.csv file shows a sample of what your upload file should look like. This file includes the three default fields
only.
Field sizes and types are specific, as per the table below. Your data must fit within these parameters or the upload will fail.

Field Type/size M/O Comments

title text M

body mediumtext M

date_posted datetime O Format 0000-00-00 00:00:00

id int(10) O Record ID. If this record ID already exists in the database KBPublisher will
skip the record. It will not overwrite an existing ID.

author_id int(10) O If not supplied, the user currently logged in and importing the articles is set
as the author.

updater_id int(10) O If not supplied, the user currently logged in and importing the articles is set
as the updater.

meta_keywords text O Format should be the same as if you are adding the keywords in add new
article.

meta_description text O

entry_type tinyint(3) O Type.

external_link text O

date_updated timestamp O Defaults to time imported to knowledgebase.

hits int(10) O Defaults to 0.

active tinyint(1) O Defaults to 1.

Create a test file
Don't try to upload the whole file without testing it first. If something goes wrong you may then have to delete all those half-
imported articles and try again. Create a test file and run that first.

Copy the first, say, three lines of your text import to a separate file
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)
Upload the file to the server
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Import the test file
You are now ready to import the test file to KBPublisher.

Click on the Import/Export menu
Click on the Import Articles tab
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File  in the SQL Load Command  field
Browse for the CSV file on your drive and load it

If the import file is on the server,
Choose Load data file
Type the address where the file is located into the Path to file field on CSV file line

Move the CSV fields around to specify which fields are in the file and what order they are in.
Do this by clicking on the name of the field you want to move and dragging and dropping it into the appropriate place.
For example, suppose you want the three mandatory fields included, plus the author ID. You need to move the user_ID field
from the Available table fields box into the Fields in CSV file box .

Click on the user_ID field and hold the mouse down
While holding the mouse down, drag the date_registered field over to the Fields in csv file box
Drop the field into the box by releasing the mouse

Make sure that you place it in the order it appears in the file.
Change CSV options if required.
Click Load

On completion of the load, you will see a message at the top of the Import Articles screen telling you how many files were imported
successfully and how many were skipped.

If the upload was successful, click on the Articles tab to check out the articles.

Fix any problems
All going well, you should now have three new articles in your knowledgebase. Check them carefully and ensure that everything
worked as you expected. If you had problems, delete these three articles, fix the test file and run it again. Keep fine-tuning until it
works, and then update the real file to match the fixes you made in the test file.
You are now ready to import the rest of the articles.

Import articles
Import the rest of the articles using the same process as for the test file, only this time using the real data file.

Note:

Articles are imported with a category name of Imported. If this category does not exist it will be created as part of the upload
process.
If any unique keys will be duplicated during import, records from cvs file will be ignored.
Use the bulk actions option to change the categories, etc.

User Manual v7.5 142



Private Articles

What the Private function does
The private option:

Lets you force users to log on to read items
Allows you to restrict who can read items
Allows you to restrict who can edit or upload items.

It works for articles, files and news items, and can be applied at individual item level and at category level.

Using the Private function  
Force users to log on

If you mark an item as private read and do not assign roles:

Users must log on to read the item
Any user who is logged on can read it
In the Public area users will not see the item until they are logged on
In the Admin area all users will see the item.

If you mark an item as both private read and private write and do not assign any roles:

Users must log on to read the item
Users who are not logged on cannot see the item.

Restrict read access

If you mark an item as private read and do assign roles:

Users must log on to read item
Only users who belong to the nominated role can read the item
In the Public area, users who do not belong to the nominated role cannot see the item
All users in the Admin area can see the item.

Restrict write access

If you mark an item as private write and do assign roles:

All users can read the item
Only users who belong to the nominated role can create, edit or update the item
For articles, users will not see Edit Article and Quick Edit options in the Public view if they do not belong to the correct role

Note that if you mark an item as private write and do not assign roles:

All users can see and read the item
All users logged in to the Admin area with appropriate privileges can edit the item.

Restrict both read and write access

If you mark an item as both private read and private write and do assign roles:

Users must log on to read the item
Only users who belong to the nominated role can see or read the item
Only users who belong to the nominated role can create, edit or post the item
In the Public area, users who do not belong to the nominated role cannot see the item
In the Admin area, users who do not belong to the nominated role cannot see the item

Note that private items work in conjunction with privileges. A user who does not have, say, author privileges, will still not be able to
create articles even if they are assigned to a role that allows them access via private write.

Set up private read and write
To restrict whole categories:

Edit the category
Choose Private Read if you wish to restrict who can read the articles in this category or force users to log on to read the
articles. Choose Private Write if you wish to restrict who can create or edit articles in the category. Choose both if you wish
to restrict both reading and writing of articles
This brings up another option, Access for selected roles only
By default, this is set to None, which means that users must log on to read articles in this category, but anyone can read
them once they have logged on
Select which roles users must belong to in order to read or write the article

User Manual v7.5 143



Click OK.

To restrict access to a single article:

Edit the article
Click on the Advanced tab
Choose Private Read if you wish to restrict who can read the article or wish to force users to log on to read it. Choose
Private Write if you wish to allow everyone to read the article but only writers in a specified role to edit it. Choose both if you
wish to restrict both reading and writing.
This brings up another option, Access for selected roles only
By default, this is set to None, which means that the article is private, but all users can read it once they have logged on
Select which roles users must belong to in order to read/write the article
Click OK.
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Subscribe to an article

Subscribing to an article means that you receive email notification of any changes to that article.

To subscribe to a single article
Open the article to read it

In the right float panel, click Save. The article will be added to your Favorite list and subscription will be automatically
activated. From now until you unsubscribe you will receive notification whenever this article is edited.

To subscribe to all articles in a category
In the category tree, select a category you wish to subscribe to.
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Click Options in the top right-hand corner. A panel with additional actions will appear.
Click Subscribe.

You can see which articles and categories you have subscribed to in the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from an article

To unsubscribe direct from the article
Click on the article to read it.
Click on Remove in the right float panel.

To unsubscribe via the subscriptions list
You can unsubscribe from single articles this way, and whole categories

Click on My account.
Click on the Subscriptions tab.
Select a required section and click Manage.
When selecting Articles Subscription or Article Categories Subscription, in the opened list find an article or category you
wish to unsubscribe from. Click the [...] icon and in the opened menu select an Unsubscribe command.
Click OK to the message that asks if you're sure.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Add new status

Articles, files, users, rating comments and feedback comments all have default statuses.  For example, there are four default article
statuses: published, pending, draft and not published.

You don't have to stay with these statuses, you can create your own:

From the Tools menu choose the Lists tab
Click on Articles (or Files, or Users, or Rating Comments or Feedback)
Choose Add New

You must include:

A title. This is the status name. e.g. In review.

You can also add:

A description, an explanation of what this status is used for.
A color that is displayed with the status on article summary and list screens.
Whether or not this status is published. If you check this box, then users will be able to read articles of this status. If you do
not check this box, then only authors, editors, moderators and administrators can read the article.
The order of this item in the status list. This defaults to 1, which places the new status at the top of the list.
Whether or not the status is active. If the status is not active, then you will not able to assign this status to article.

Lastly

Click Save.
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Add new article type

You can create your own article types:

From the Tools menu choose the Lists tab
Click on Article Type
Choose Add New

You must include:

A title. This is the article type name. e.g. FAQ.

You can also add:

A description, an explanation of what this article type is used for.
An article template. This is default text and/or formatting that is created for all articles of this type. For example, you might
create an article type of system errors. For each article of this type you require three sections: error number, error message
and anexplanation, so you create a System Error type template with these three headings. When an author creates a new
article based on System Error, these three headings are automatically included in the article, so all they have to do is fill in the
details.
The order this item is in the article type list. This defaults to 1, which places the new type at the top of the list.
Whether or not the type is active. If the type is not active, then you will not be able to choose this as a type.

Lastly

Click Save.
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Featured Articles

The Featured tab lets you select articles you want to highlight. You can include articles in the Featured section of your index page,
or in the featured section of a category, or both.

To access the Featured tab click Articles from the main menu bar and select Featured from the tabs displayed:

The list provides the ID and title of each featured article and the number of views the article has had. A star appears in the Index
Page or Category Page columns, or both, to indicate where the article is featured. In the Category Page column a number
appears beside the star to indicate how many categories feature the article.

Use the filter at the top of the form, marked in red in the image above, to show only articles that are featured on the Index page, the
Company Specific page, or for a particular category. Click the > button to filter the display. Clear the fields and click > again to show
all articles.

At the right of each entry is [...] button. Click it to open the Actions menu. From this menu:

Select Details to see more about the current article. The display changes to the Details sub-tab of the Articles tab.
Select Edit to set how the article is featured.
Select Remove to remove the current article from the Featured list. 

Add an article to the Featured list
To add an article to the Featured list, click the Add new button. The popup window appears and shows all the articles available to
add to the list.

Use the filter fields above the list and then click the > button to show only articles that match the conditions you set. Clear all fields
and click > again to show all articles.

To add an article to the list, select one that does not already have a star in its Index or Category column. Click the icon to add the
article to the list.

Click the icon in the Action column to open the edit form for the article. The form is described below.

Edit a featured article
To adjust how an article is featured, click the Action icon for the article and select Edit. The Edit form appears:

Clear the check box to remove the article from the Index Page display.

You can feature an article on one or more category pages. To add the article to a category page, click the + button to the right of the
Category Page field. Select the category you want from the list that appears. To remove the article from a category page, select the
category in the Category Page field and click the - button to the right of the field. A confirmation message appears to make sure you
want to remove the category.

Click Save to save your edits. Click Cancel to abandon your edits and close the form.

Remove a featured article
There are three ways to remove articles from the Featured list:

1. Click the Action icon for the article you want to remove from the list and select Remove.
2. Check the check box at the left of the row for each article you want to remove. Click the Actions with selected menu at the

bottom of the display, and select Remove. Click OK to confirm that you want to remove the selected articles.
   This option is useful when you need to remove several articles from the Featured list. Check the check box that appears at
the top left of the list of articles to select all articles. De-select it to clear all check boxes at once. 
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3. Click the Add new button to open the list of articles as described above. Articles that are featured have a star in either or
both of their Index Page and Category Page columns. Click a star to remove that article from being featured in that page or
pages; you can remove the article from one feature and retain it for the other.

Configure display options
To learn more about configuring the display of featured articles, see The Public Area tab explained.
See settings "Featured articles" and "Featured articles in a category".
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Adding Code Snippets

You may want to add code examples, or snippets, to your knowledgebase article to show your users how to achieve a particular
effect or address a common problem. KBPublisher makes this easy by providing formatting tags to put around the example. When
your readers look at the article, the example code appears, correctly formatted for the coding language you specify, and highlighted
as it would appear in a code editor for that language, in a box to set it off from the rest of the text.

There are two options to add code snippet to an article.

Option 1 - toolbar button
To add code snippets to an article by using the toolbar button:

1. Open the article for editing.
2. Place cursor where you want the code snippet to appear. (You can move the snippet later, if needed.)

3. Click the "Insert Code Snippet" icon in the editor toolbar .
4. In the Code snippet window, select a language and add your code content.
5. Click OK.

Example:

<?php 
$value = 'something from somewhere';
setcookie("TestCookie", $value);
setcookie("TestCookie", $value, time()+3600);  /* expire in 1 hour */
setcookie("TestCookie", $value, time()+3600, "/~rasmus/", "example.com", 1);
?>

Available Languages

In the Language drop down menu, the following options are available:

Apache
Bash
CoffeeScript
C++
C#
CSS
Diff
HTML
HTTP
INI
Java
JavaScript
JSON
Makefile
Markdown
Nginx
Objective-C
Perl
PHP
Python
Ruby
SQL
VBScript
XHTML
XML

Option 2 - [code] tag
To add code snippets to an article by using the [code] tag:

1. Open the article for editing.
2. Add opening and closing tags around your code snippet:

[code=XXX] Add your code here. [/code]
3. Replace the XXX with the indicator from the list below for the snippet's coding language.
4. Paste your code between the opening and closing tags.
5. Preview the article to confirm it appears as you want.

Example:

<?php 
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$value = 'something from somewhere';
setcookie("TestCookie", $value);
setcookie("TestCookie", $value, time()+3600);  /* expire in 1 hour */
setcookie("TestCookie", $value, time()+3600, "/~rasmus/", "example.com", 1);
?>

Available Languages

Find your snippet's coding language on the left side of any pair. Choose one of the entries that appear on the right side. For AS3, for
example, you could use "code=as3" or "code=actionscript3".

Code Language Indicator

AS3 actionscript3
as3

Bash bash
shell

CSharp c-sharp
csharp

ColdFusion cf
coldfusion

Cpp c
cpp

Css css

Delphi
delphi
pas
pascal

Diff diff
patch

Erlang erl
erlang

Groovy groovy

JScript
javascript
js
jscript

Java java

JavaFX javafx
jfx

Perl perl
pl

Php php

Plain plain
text
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PowerShell powershell
ps

Python py
python

Ruby
rails
ror
ruby

Scala scala

Sql sql

Vb vb
vbnet

Xml
html
xhtml
xml
xslt

Code Language Indicator
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Set up required reading (Must Read)

Must Read functionality allows you to set up a mandatory reading requirement. It allows you to make sure that members receive
information.

When a member signs on to the KB, they are notified that there is a mandatory reading item, and they are directed to it. After
reading the article or news, the staff member acknowledges the new information. The system maintains a list of who has and hasn't
read the Must Read items.
 

Set an item as "Must Read" (required reading)
To set a Must Read requirement for an item:

Create a new article or news item or edit an existing one.
If you are in an article, click the "Advanced" tab.
Select the "Must Read" checkbox.
Fill out Must Read block. For more detail, see the section below.
Click Save.

Set multiple items as "Must Read" (required reading)
In the articles or news listing, check required articles on the left.
From the "Actions with selected" menu at the bottom on the page, choose Set Must Read.
Fill out the Must Read block. For more detail, see the section below.
Click OK.

Must Read input block explained

1. Set or unset reading requirements.
If you update an article set as "Must Read" you have a "Reset read confirmations" option. This resets all read confirmation,
which requires assigned users to confirm it again.
 

2. Select who should read the article.
Audience assignment is very flexible: you can assign all users, all staff users (user with privilege), designate specific users, or
assign to users based on specific roles or privileges.
 

3. Add notes that your users will see with the Must Read notification.
 

4. Set if the reading requirement will expire.
If not checked, Must Read will never expire, and the following rules apply:
- Users who did not confirm it will get a notification until they confirm it.
- All new matched users will get a Must Read notification.

If an expiration date is specified:
- Users who did not confirm it will get a notification until they confirm it or the expiration date is reached.
- All new matched users will get a Must Read notification before the expiration date.
 

5. Force users to read  the article.
OFF (not checked) - Users are notified about Must Read items at login, but are allowed to read them later.
ON (checked) - Users are notified about Must Read items at login, and are not allowed to go further until confirming they have
read all Must Read items. (Exception: Users are still allowed to go to the Admin Area and their own My Account area.)
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Must Read Flowchart
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Drafts
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Drafts

The Drafts module lets users create new articles, or modify existing published articles, without interfering with live publications.
Users can create and modify drafts in a separate area until each draft is finished and ready to go live.

The Drafts module lets you require specific contributors to create drafts that must be approved before publication, rather than
publishing their material directly.

To learn about creating and managing your drafts, see Manage drafts.

Essential facts about drafts
Users with admin privileges can create, approve, reject, or delete any draft at any stage in the approval process. 
If a draft has been sent for approval, the author cannot update it until the review is complete. 
Your knowledgebase records approval decisions in a log for future reference.

Drafts and Workflows
When a draft is ready to publish, an approval workflow can route the document or item to the assignees, one or more people
assigned to review such material before publication.

Assignees can approve the article for publication or send it back to the author for more work. They can also provide feedback on an
article. The feedback is compiled and sent to the person who initiated the workflow.

Possible scenarios when a user adds a draft
1. There is a matching workflow

The author of a draft can save the draft repeatedly while working on it until the material is ready to submit. When the user
submits the draft for approval, the workflow assigns it to appropriate assignees. The user has no further access to the draft
until it is approved for publication or returned for further edits.
 

2. There is no matching workflow and the user's privileges do not permit adding articles
The author of a draft can save the draft repeatedly while working on it. However, the user cannot publish the draft, and there
is no way to send the draft for approval. 
 

3. There is no matching workflow, and the user's privileges permit adding articles
The author of a draft can save the draft repeatedly while working on it. When the draft is ready to publish, the user can publish
it. 
Once the draft is published it no longer appears on the list of drafts, and does appear on the list of articles.
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Manage Drafts

To manage existing drafts or create a new one, select Articles or Files from the main menu and select the Drafts tab:

The tab lists all existing drafts. If the list is long, use the filter fields above the list to show just the drafts of a particular status, or the
drafts with a certain word in their titles.

The Status column shows a color for each draft to indicate its status:

gray = in progress
yellow = waiting for approval
red = rejected
green = approved
dark gray = completed (approval not required)

Click the actions icon in the Action column for a draft to perform an action.

For drafts of articles:

Approve - Appears if draft requires approval and you are an assignee (are allowed to approve or reject the draft).
Preview - Display a preview of the draft to review.
Details - Display details about the draft.
Edit - Open the draft for editing.
Delete - Delete the draft.

For drafts of files some extra options available:

Open - Open the file in a browser if possible.
Download - Download the file to a location on your computer.

Depending on your privilege level, the following Bulk Actions are available:

Set Assignee - Change assignee. Can be applied to drafts that are in the approval queue. 
Reset - Move drafts to the beginning of the approval queue. Updates do not reset drafts.
Set Status - Change draft status to "In Progress" or "Completed". Can be applied to drafts that are not in the approval queue. 
Delete - Delete the draft.

Adding a draft
To add a draft of an article or file, click Add new on the relevant tab and complete the form that appears.

For a description of the form for adding a draft of an article, see Add an article.
For a description of the form for adding a draft of a file, see Add a file.

Approve a draft
If you are an assignee for a draft in its current workflow step, you can:

Approve the draft as-is and either publish it or move it to the next workflow step.
Edit the draft and save your changes before approving it, as in the previous option.
Reject the draft so it returns to the author for further edits. 
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Approve or Reject a Draft

A workflow may assign the draft of an article or file to you for review. You can:

approve the draft. The draft then moves to its next assignment in the workflow, or (if it requires no further approvals) is
published.
publish the draft. The draft then become available in the Public area.
update the draft and then approve it. The draft then moves to its next assignment in the workflow, or is published.
reject the draft so it is returned to the author for further work.

To see the drafts assigned to you, select Articles or Files from the main menu and then select the Drafts tab:

The colors in the article's Status column indicate the article's status. The options are:

Yellow = waiting for approval.
Red = rejected and returned to the author for further work.
Gray = in progress; the article is not ready for review.

Review a draft
To review a draft, select a draft with a "waiting for approval" status indicator, click the [...] actions icon in the draft's last column and
select Review. The review screen appears:
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Click Preview to display the article or file in a pop-up window so you can evaluate the material.

In the example above, the current reviewer can

Publish the draft if the material is satisfactory.
Approve the draft  to send it to its next approval step in the workflow.
Reject the draft if the material is not ready for publication. A form appears where you can provide notes about additional work
the draft requires. After you have added your comments, click Reject to send the notes and the draft to the author.
Edit the draft if the material needs editing.
Cancel to close the form without making a decision

Note: A user with admin privileges can approve or reject a draft at any stage in the workflow process, whether or not the draft is
assigned to the admin.

Add or remove an assignee
The Assignee section of the Review screen lists those who are assigned to review the draft.

Remove an assignee from the list by clicking the [x] to the right of the assignee's name.
To add an assignee, click Click Add new . A popup window appears with a list of available staff. Click the down-arrow in the
Action column for each person you want to assign the draft to. The down arrow changes to a check mark. Close the popup
window when you have finished adding assignees.

You can remove all assignees from the list.

Review the log
The bottom part of the Review screen shows the workflow log. The author, reviewers, and admins can add comments when they
are submitting, approving, or rejecting drafts, and the comments are available in this log.
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Categories
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What are categories?

Categories control where information is displayed, how it is displayed and who can see it.

They control the menu display (sometimes known as the table of contents) on the left hand side of the screen.

Categories for articles and files are controlled separately.
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Category types

Category type controls how articles in this category are displayed in the public view.
There are four category types.

Standard
The Standard (default) type displays a list of articles, along with one or two lines of text.
If the category has sub-categories, these are displayed above the list.

 

Book
The book type displays items as a table of contents.

 

Quick FAQ
The Quick FAQ type displays all articles in the category on the same page.
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Quick FAQ (interactive)
While the Quick FAQ (interactive) type displays all articles in the category on the same page as well, but with only the titles
displayed initially. Click on the title to display the article, click on it again to hide it. 
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Add a Category

The quickest way to add a category is to use the Shortcuts menu at the top of your screen.

Click on the drop-down menu in the top right of the screen and choose Add new category .

Or you can do it via the Categories tab in the Admin Area

Click on the Articles menu
Choose the Categories tab
Click on Add New .

You can also add a category while you are in the middle of adding an article or a file

Edit the article or file
Click on the assign categories button (+)
Click on Add New Category .

Once you are on the category screen you must complete the following sections:

Add a Title. This is the name that will be displayed on the left menu or in any table of contents.
Define where it fits in the category hierarchy by choosing a Parent category and an Order. If you don't change these you
will add a new top-level category and it will be placed last.

You may also:

Change how articles are displayed by specifying a category type
Control read and write access through Private and Active
Allow users to comment on or rate articles in the category
Assign a person to approve articles (Supervisor) for the category

You can find out more about each of these fields and how they work in the Category screen explained.
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The Category Input Screen Explained

To get to the Category screen, click on the Articles menu, then choose the Categories tab and then select or edit a category.

1. The category Title is the title that is displayed on the left menu in the public view. Title is required.

2. The Description is an explanation of what this category is.

3. The Parent category denotes where this category will come in the menu. A TOP LEVEL category means that this is a top
level menu and will be displayed in the list when a user first enters the public view.
Categories that are red denote restricted privileges. They may be marked as 'private', or only users with assigned roles can
access them.

4. Category type controls how articles in this category are displayed in the public view.
See a detailed explanation here.

5. Sort entries by  allows you to set custom sorting for a category.

6. The Order defines where the category is placed in the list of categories. By default, it is added to the end of the list.

7. You can assign an owner to a category by assigning it a supervisor. This is the person who receives emails when pending
articles have been created and need to be approved.

Click on the folder icon to bring up a list of users.

Assign a user.

8. You can force users to log on to read articles in this category by marking the category Private Read/Write.
You can restrict authoring of articles in a category by marking the category Private Write.

Checking either option for Private brings up a list of roles.  Select the role(s) that you wish to allow to read/write.  Hold the key
to select second and further roles.
If the category is a sub-category, you can inherit the read privacy from the parent category by clicking on copy from parent
category. This means that if you change the privacy for the parent category the change will flow on to this sub-category.

9. When Allow comments is checked, users can add comments to articles in this category.

10. When Allow rate is checked, users can add a rating to an article in this category.

11. Content in an Active category is published at Public Area. Content that is not active will be hidden, and the only way you can
see it through the Admin screens.

You can use this field to deactivate obsolete content, but you can also use this field to hide articles until you are ready to
display them. It might be useful, for example, if your knowledgebase is about a system. You decide to add new functionality to
the system but don't want the readers to anything about it until the release date. You can create articles about the new
functionality in an inactive category, and then after the release, make the category active.
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Article Templates
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What are article templates?

Templates have two functions in KBPublisher--to standardize article design and to add boilerplate text.

To standardize design
Suppose you want each page in your knowledgebase to have three headings: 'Introduction', 'Steps' and 'Conclusion'. The 'Steps'
section should be a simple bulleted list. You want all your authors to keep to the same format so you set up a template and ask them
to create articles using that template

Or maybe you run a Help Desk. Rather than simply have users type their problem into a free-format article field, you can set up a
form template and ask them to fill it in.

KBPublisher ships with four standard Article templates:

The default template, which is a white background with standard formatting
Page Content -- This is similar to the default template, but it includes headings and a numbered list
Info Box -- a box with a yellow background, good for displaying information
Info Box 2 -- similar to Info Box, but the box has a grey background.

The default template is the base template. You do not need to specify it.

If you do specify a template, you can:

Choose to replace existing content, whereby everything you have written in the article to date is overwritten, or
Simply add the new template where your cursor is currently placed, or
Include the template in the article. If you choose this option, a special tag (e.g. [tmpl:include|<template_key>] ) is placed in
the text to denote where the template is to be placed, and the content of the template is included at the rendering stage. This
means that when you edit the article you do not see the contents that are being included; you just see the special tag. 

Boilerplate text
If you find yourself continually typing the same content over and over again, you can use templates to simplify the work.

Maybe you need to add a disclaimer at the bottom of each page. The disclaimer is exactly the same on every page, and you don't
want the bother of typing it in every time. A template saves time typing the disclaimer initially, but your legal people keep changing
it. You don't want the hassle of changing every page. Not to worry. You can include a template. If the disclaimer changes, then all
you have to do is change the template and the next time someone views the page they will see the correct disclaimer
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Using templates in articles

The different ways you can add templates
A template is a piece of content (text and pictures and other media) that you can place into other articles. Common examples of
where you might use a template are a disclaimer paragraph that you add to the bottom of each article, or a series of steps that are
common to many of your instructions.

You can add, replace or include templates in articles.

Insert pastes the content of the template into the article.  Once the content is added you edit it like any other article content.
Replace works the same way except that instead of just placing the template content into the article at your cursor position,
it replaces everything in the article.
Include is different in that it just puts a marker in the article, it doesn't put the contents in. The template content is pulled in
when the reader opens the article to view it. When you edit the article you don't see the content from the template, all you see
is a code like or [tmpl:includeisclaimer] and you can't edit the contents of the template in the article, you have to go back to
the template to do it. 
The great thing about include is that if you can update the template as many times as you like and the changes always flow
through to the article. This is not like add and replace, which place the contents of the template into the article, so once it's
there it doesn't change if you update the template.

To add a template to an article
Your template must exist before you can use it in an article.

To add a template to an article:

Add or update the article.
If you are going to add or link to a template, place the cursor where you want to include the template.
Choose the template from the Template drop-down menu.

Click on the appropriate insert template icon
If you wish to add the contents of the template to the article, click on the icon with the blue arrow. This pastes the text
of the template where the cursor is currently positioned. It does not affect any of the text above or below it.
If you wish to replace the contents of the article, click on the icon with the red arrow. This deletes any text currently in
the article and replaces it with the text in the template.
If you wish to include the contents of the template, click on the icon with the green arrow. This puts a placeholder into
the article and when a user opens the article to read it, the knowledgebase pulls in the text from the placeholder
template.
If you have defined a key for your template, you can also include the template by typing in the special template include
command and the template key into the editor window. i.e. By typing [tmpl:include|<template_key>] where
<template_key> is the template key
Or you can use the template ID in the template include command, i.e. [tmpl:include|<ID>] where <ID> is the
template ID.

Alternatively, you can use the Template icon in the editing toolbar, but this only allows you to add or replace the template; it does
not allow you to link the contents.
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If you choose this option:

Add or update the article
Place your cursor where you want to insert the template
Click on the templates icon (check out the edit toolbar explained to see where the templates icon is on the toolbar)
This opens a pop-up box. If you intend to replace the current contents, check Replace actual contents
Click on the name of the template
This returns you to the editor with the template inserted.

Tip:

You can also use the article type as a form of template.
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Add an Article Template

To add a new article template

Click on the Articles menu
Choose the Article Template tab
Click on Add New.

Once you are on the article screen you must complete the following sections:

Add a Title. This is the name of the template.
Set up your template in the Template editing box.

The following items are optional:

You can include a template key to use to easily identify the template when including it in articles
You can add a description to explain what the template is used for
You can speficy whether the template can be used by marking it active. If you don't mark the template as active, then
authors cannot use it in their articles.

Once your article is complete

Click Save.
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Article types as templates

Another form of template is the article type.

Each article can be assigned a 'type'. Your knowledgebase might contain, for example, the following types:

Procedures which contain a short summary, plus some steps
Screen images, with an explanation of each field on the screen
Common error messages showing the error number, the message, and an explanation of what it means.

You can use article types to set up a base template for each type of article. For example, the Procedures type may contain one
heading called Summary, and another called Steps with a numbered list below it, while the Error Messages type contains three
headings: Error No, Error Message and Explanation. Set up your article types templates with these headings.

When you create a new article, choose the appropriate type from the Type drop-down list, and the headings are automatically
included in the article. All you need to do then is fill in the blanks.
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Glossary
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Glossary explained

The glossary allows you to create a list of definitions in your knowledgebase.

Glossary items are highlighted in red in the article. If you hover your mouse over the glossary item, you see a question mark. If you
click on the word, the definition is displayed in a grey box.

To hide the definition again, move your cursor away from the word.

Tip: If you wish to not highlight a word in an article, then when you update or create an article, highlight the required word and click
  in the HTML editor.
        This word will be skipped and not highlighted as a glossary term.

User Manual v7.5 175



Add a glossary item

The glossary gives your readers quick definitions or explanations of words or phrases important to your application, but which the
reader might not know.

There are two ways to add a glossary item:

1. Click the Add icon  at the top right of the Admin screen and select Glossary item.
2. On the Articles tab select the Glossary sub-tab, then click the Add new button.

Either method displays the Add new form. Provide the required information for the new item:

Word/phrase - This is the word or phrase that may puzzle your reader. This text will be highlighted in red in articles. 
Definition - Explain the word or phrase. In an article, the definition appears in a yellow box when the reader clicks a word
highlighted in red.

There are two optional settings:

Highlight once  - Select to have the word or phrase highlighted only the first time it appears in an article. Repeated
highlighting may make the article more difficult to read.
Published - This is selected by default. De-select to have this item not display in the glossary.

Click Save to save the new item. Click Cancel to abandon your edits and close the form. Click Preview to see how the item will
appear.
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Import glossary

If you already have a list of terms and definitions that you would like to use in your knowledgebase, you can upload these terms in
bulk.

The process is

Create a file of glossary items to import
Upload a test sample to the system
Import.

Create a file of glossary items to import
First, you need to create your file of articles. This is a comma-separated (CSV) text file that consists of a phrase, followed by a
definition.

Both fields must be included, and they must be in the order of glossary item name (phrase) first, and then the text that
explains it
Place the data for each glossary item onto a single line, and separate each field by a comma. Include a space after the comma.
If you choose to use something else other than a comma, update the field terminated by field under CSV options to match.

Field Type/size M/O Comments

phrase varchar(100) M The maximum size of a phrase is 100 characters

definition text M

id int(10) O Record ID. If this record ID already exists in the database KBPublisher will skip
the record. It will not overwrite an existing ID.

date_updated timestamp O Defaults to time imported to knowledgebase.

highlight_once tinyint(1) O Defaults to 0.

active tinyint(1) O Defaults to 1.

Create a test file
Don't try to upload the whole file without testing it first. If something goes wrong you may then have to delete all those half-
imported glossary items and try again. Create a test file and run that first.

Copy, say, the first three lines of your text import to a separate file
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)
Upload the file to the server

Import the test file
You are now ready to import the test file to KBPublisher.

Click on the Import menu
Click on the Import Glossary tab
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File  in the SQL Load Command  field
Browse for the CSV file on your drive and load it

If the import file is on the server,
Choose Load data file
Type the address where the file is located into the Path to file field on CSV file line

Change CSV options if required.
Click Load

On completion of the load, you will see a message at the top of the Import Articles screen telling you how many files were imported
successfully and how many were skipped.

If the upload was successful, click on the Articles tab to check out the articles.

Fix any problems
All going well, you should now have three new glossary items in your knowledgebase. Check them carefully and ensure that
everything worked as you expected. If you had problems, delete these, fix the test file and run it again. Keep fine-tuning until it
works, and then update the real file to match the fixes you made in the test file.
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You are now ready to import the rest of the glossary.

Import articles
Import the rest of the glossary using the same process as for the test file, only this time using the real data file.

Note:

If the glossary item already exists, a new item will still be uploaded.  We recommend you do not duplicate.
If any unique keys will be duplicated during import, records from cvs file will be ignored.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Comments
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Article comments

SaComments allow readers to give feedback on articles.

You can read comments in the public view, or if you have admin access you can also see them from the comments tab in the
knowledgebase.

To add a comment:

Open the article to read it
On the right click on More icon in the float panel on the right.
This brings up the screen to choose an action. Click on the Add Comment icon.
This brings up the screen to add a comment. Type in your comment. Type it in as plain text. Do not include HTML.
If you wish to be notified when someone else adds a comment to this article, check Subscribe
Unless the system administrator has changed the settings, you will then need to type in a confirmation code. Type the code
exactly as you see it. Match upper and lower case.
Click Send.

Your comment is displayed beneath the article.
By default, it is displayed immediately, but this can be changed in the settings to require approval first.
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Rating Comments

Users can rate articles to say whether they were helpful or not helpful.

Depending on how you set your knowledgebase up, they can either rate an article as:

Helpful/Not helfpul, or
Use a star rating system.

When a user rates an article they can also add a comment saying why they rated the article the way they did.

These comments are emailed to the supervisor for that category, or if no supervisor is assigned, to the system administrator.

You can see these rating comments in the Admin area

Choose the Feedback menu
Select the Rating Comments tab

----------------------------------------------------------------------
This functionality works in version 3.5 and above

---------------------------------------------------------
Some functionality mentioned on this screen works in version 3.5 only or has been changed for version 4.0. 
For a complete list of changed/new functionality, please see version 4.0 release notes
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Bulk update comments, rating comments and feedback

KBPublisher allows you to bulk update feedback, comments and rating comments to:

Set a status
Delete 

You can do this direct from the Feedback menu, and choose the appropriate tab.

To set the status of a comment or a rating comment:

Click on the approriate tab
Check one or more comment to update
Choose the appropriate action from the drop down list of actions with selected
This brings up further options to select from according to the action chosen. Choose the appropriate selection
Click OK.

Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete comments then there is no 'Delete' action in the list of options.
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Files
The Files area of the knowledgebase
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What are files and how do they work?

Files are documents you can add to your knowledgebase. The type of files you can add is controlled by the settings of your
knowledgebase, but in general you can add graphics, text documents, Microsoft Office documents (Word, Excel, PowerPoint) or PDFs.

The file area is separate to the article knowledgebase, although you can attach the files from the File area into articles. Note though,
that inserting graphics into articles is not the same as adding a file from the Files area.

Why would you want to have a separate files area? Common examples might be:

It could be a download area of your knowledgebase.
You have a whole lot of process documents or user manuals that you wish to upload.

The maximum size of a file you can upload depends on PHP settings, default is 2MB.
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Add a File

To add a file from your local computer to the server, select Files from the menu bar to display a series of sub-tabs. To link to a file
that is already on your server, see Add a local file.

To upload a new file that requires no further approvals before becoming available, select the Files tab. Then click the Add
new button to display the form where you specify the file.

Complete the form's fields:

File -- Select the file to upload.
Category -- Add one or more categories for the files by clicking the + icon to the right of the Category field and selecting from
the list of categories provided.
Title -- Add a title.
Description -- Add a description.
Tags -- You can add one or more tags to help users find the file. Click the Tags link and then select tags:

Type a few characters of the tag you want in the field that appears, and select the tag from the options provided.
Click the "Choose from your tags" link to display all the tags available. Select the ones you want to associate with this
file.

Private -- You can opt to restrict either or both read and write access to the files. If you check either check box another field
appears where you can specify which roles users must have to be able to read and/or update the file.
Schedule -- Check the Yes check box and use the fields that appear to set a date when the status of the current files changes
from unpublished to published. Check the And check box to set a date after which the status of the current files changes from
published to unpublished.
Order -- The categories you have selected for the file are listed in the Order field, along with a drop-down list of where to
place the article within the category. There is one order list for each category you have chosen.
Status -- You  can set the file status as Published or Unpublished.

Click Save to upload the file.
Click Cancel to abandon your edits and close the form.
If the Published status is selected, the Publish button appears instead of Save. After clicking the Publish button, the file becomes
visible in the Public area.

The maximum size of a file you can upload depends on PHP settings. The default is 2MB. 
See here for Files settings (Allowed extension, Max file size, etc).
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Bulk update files

KBPublisher allows you to bulk update files to:

Move to a category
Add to a category
Set tags
Make the files public or private
Schedule file publication
Re-parse files to extract text from the file (to make them searchable) and update the file size information
Set custom fields
Set file status
Delete files.

You can do this direct from the Files menu, Files tab.

To update the file:

Check one or more files to update
Choose the appropriate action from the drop down list of actions with selected
This brings up further options to select from according to the action chosen. Choose the appropriate selection
Click OK.

Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete articles that you have created,
then there is no 'Delete' action in the list of options. If your privilege does not allow you to update items, or allows you to only
update items you have created, then this menu will not be available for you at all.
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Add a Local File

When you want to add files to the knowledgebase, you can upload files from your local computer, or you can link to files that are
already on your server or files located on Amazon S3 server. In KBPublisher such files are known as "local files". If the file already
exists on the server it saves space to reference it rather than uploading a second copy specifically for the knowledgebase.

By adding a reference to a file that may be also be available through your corporate website or some other site (forms, disclaimers,
fair-use and privacy policies, product disclosure statements, catalogues, printable manuals, and so on) you can make the
knowledgebase richer and more useful without taking up additional space.

To add a local file (a reference to a file already on your server):

Select the Files menu
Choose the Add Local Files tab to display the Local add form:

 

Complete the form's fields:

Files -- Click the [+] icon. In the popup window, choose the source directory or Amazon S3 (if enabled; see the "Allow access
to Amazon S3" setting in the Admin tab to enable the Amazon S3 option).

For Directory, enter the name of the directory on your server which holds the files you want to link to.
For Amazon S3, enter the S3 path in format: bucket_name/prefix/... (prefix is optional)
Then click the [ >> ] icon to display files. Check all files or check the checkbox for each file you want to link to, and click
Done.

Category -- Add one or more categories for the files by clicking the + icon to the right of the Category field and selecting from
the list of categories provided.
Title -- Add a title. If you are linking to more than one file in this operation, all files will have the same title.
Description -- Add a description. If you are linking to more than one file in this operation, all files will have the same
description.
Author -- By default you are identified as the author of the files. Click the Delete link to the right of your name to remove it.
Tags -- To add a tag, click [+]. You can add tags one at a time by hitting Enter after typing each tag. Or you can add multiple
tags at a time by separating each with a space as you type. You can join 2 or more words together in one tag by enclosing
them in quotation marks.
To select a tag from your existing list (tags previously used in KBPublisher) click Choose from your tags  and select the tags
you want to use.
Private -- You can opt to restrict either or both read and write access to the files. If you check either check box another field
appears where you can specify which roles users must have to be able to read and/or update the file.
Status -- You  can set the file status as Published or Unpublished.
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When the form is complete, click Add files to add the files to the list on the Files tab.

If you have the correct permissions, you can add the files as drafts. Click Save as Drafts  to add the files to the list on the Drafts
tab. Use this option for files that you do not want to publish yet, or for files that require further review or approval before becoming
available. 

Tips:

The files that are found are controlled by the Allowed/Denied extensions setting on Admin tab under Settings. If you have
said there are no restrictions, then all files in the directory are found. If you have said only image and text files are loadable,
then only image and text files will be found.
The PHP open_basedir setting determines where KBPublisher searches for the files. If you find that Get Files only searches
the directories under the knowledgebase itself, then check your settings to see if PHP restricts it to this.
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Automatically Add Local Files

The Directory Rules screen allows you to set up the knowledgebase so that KBPublisher automatically checks the specified
directory on the server or on Amazon S3 server every day and adds in KBPublisher links to any new files.

Standard allowed and denied extension rules apply, based on your denied and allowed extensions set in the Files Settings. 

Note: this option doesn't move files, it adds links in KBPublisher to files on your server. If you move a file from the location
KBPublisher linked to, the links to that file in the knowledgebase will be broken. 

To see and manage your directory rules, select Files in the main menu, and then the Directory Rules tab:

If you have a long list of directory rules, you can filter the list by rule status or by the directory the rule applies to, using the fields
above the list of rules.

Managing directory rules
Check the checkbox in the Active column for a rule to enable that directory rule. Uncheck the checkbox to disable the rule.

Click the [...] actions icon in the last column of a row to perform one of these actions on the directory rule in that row:

Edit - update the rule's information. The fields are the same as when you add a new directory rule - see the descriptions
below.
Delete - delete the directory rule.

Adding new directory rules
To add a directory rule, click the Add New  button. Complete the form that appears:
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Rule options:

Directory - Choose source Directory or Amazon S3 ((if enabled; see the "Allow access to Amazon S3" setting in the Admin
tab to enable the Amazon S3 option).

For Directory enter the directory on the server. The directory name should be the full server path.
For Amazon S3 enter the S3 path in format: bucket_name/prefix/... (prefix is optional).
Click [→] to verify that the path is correct. If the path is correct, in popup window you will see a list of all files in that
directory.

Parse child directories - Check this option to have the rule monitor all sub-directories in the directory. This is selected by
default.
Description - A description is not required, but you can add one to describe the files that normally appear in the directory, or
information about the directory rule that may be useful to other team members.
Active - This field is selected by default, and once you save the new directory rule it will run at the next scheduled
opportunity. Uncheck this check box to disable the rule. You can also enable and disable a directory rule from the full list of
rules, as described above.

File options:

Category - Add one or more categories to which the links to the new rules this directory rule finds will be added. Click the
[+] icon to the right of the field to add a category.
Author - By default the current user's name appears in this field, and will be associated with the link to any file the directory
rule adds to the knowledgebase. You can select a different user's name as the author, or opt to have no author name.
Private - By default the links the directory rule creates are public. Check one or both check boxes to control read and write
access to the linked file to users with the roles you specify. See private read and write.
Status - By default, files are set to a status of published, but you can change this to unpublished.

To test the settings click Test.

Click Save to save the new directory rule. Click Cancel to abandon your edits and close the form.
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Add New File Category

The quickest way to add a category is to use the Shortcuts menu at the top of your screen.

Click on the drop-down menu in the top right of the screen and choose Add new file category .

Or you can do it via the Categories tab under Files.

Click on the Files menu
Choose the Categories tab
Click on Add New .

Once you are on the category screen you must complete the following sections:

Add a Title. This is the name that will be displayed on the left menu or in any table of contents.
Define where it fits in the category hierarchy by choosing a Parent category and an Order. If you don't change these you
will add a new top-level category and it will be placed last.

You may also:

Control access through Private and Active
By checking Allow attach files, files from this category will be allowed to be attached
Designate an owner (Supervisor) for the category

You can find out more about each of these fields and how they work in the Category screen explained.
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Private Files

What the Private function does
The private option:

Lets you force users to log on to read items
Allows you to restrict who can read items
Allows you to restrict who can edit or upload items.

It works for articles, files and news items, and can be applied at individual item level and at category level.

Using the Private function  
Force users to log on

If you mark an item as private read and do not assign roles:

Users must log on to read the item
Any user who is logged on can read it
In the Public area users will not see the item until they are logged on
In the Admin area all users will see the item.

If you mark an item as both private read and private write and do not assign any roles:

Users must log on to read the item
Users who are not logged on cannot see the item.

Restrict read access

If you mark an item as private read and do assign roles:

Users must log on to read item
Only users who belong to the nominated role can read the item
In the Public area, users who do not belong to the nominated role cannot see the item
All users in the Admin area can see the item.

Restrict write access

If you mark an item as private write and do assign roles:

All users can read the item
Only users who belong to the nominated role can create, edit or update the item
For articles, users will not see Edit Article and Quick Edit options in the Public view if they do not belong to the correct role

Note that if you mark an item as private write and do not assign roles:

All users can see and read the item
All users logged in to the Admin area with appropriate privileges can edit the item.

Restrict both read and write access

If you mark an item as both private read and private write and do assign roles:

Users must log on to read the item
Only users who belong to the nominated role can see or read the item
Only users who belong to the nominated role can create, edit or post the item
In the Public area, users who do not belong to the nominated role cannot see the item
In the Admin area, users who do not belong to the nominated role cannot see the item

Note that private items work in conjunction with privileges. A user who does not have, say, author privileges, will still not be able to
create articles even if they are assigned to a role that allows them access via private write.

Set up private read and write
To restrict whole categories:

Edit the file category
Choose Private Read if you wish to force users to log on and/or to restrict who can see files in this category. Choose Private
Write if you wish to allow everyone to see and open files in the category but only people who have in the specified roles to
manage them (e.g. upload, delete). Choose both Private Read and Private Write if you wish to restrict who can read the files
and also who can manage them.
This brings up another option, Access for selected roles only. 
By default, this is set to None, which means that users must log on to see and open files in this category, but anyone can see
them once they have logged on
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Select which roles users must belong to in order to read the files
Click OK.

To restrict access to a single file:

Edit the file
Choose Private Read if you wish to force users to log on to read the file or you wish to restrict who can see or open it. Choose
Private Write if you wish to allow everyone to see and open the file but only people who have the specified roles to manage
(e.g. delete) it. Choose both Private Read and Private Write if you wish to restrict who can see or open the file and who can
manage it.
This brings up another option, Access for selected roles only. 
By default, this is set to None, which means that the file is private, but all users can read it once they have logged on
Select which roles users must belong to in order to read/manage the file
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Assign category to a file

Assigning a category to a file is a two-part process. First you assign the category, and then you define the order the item is displayed
in that category

To assign the category
Create or edit the article.
Click on the plus (+) button on the right-hand side of the category field.
This opens the Assign a Category screen

 
Select a category by using the text entry field at the top of the screen. You can start typing a category name to filter the
category list.
You can select multiple categories.
Click OK to save your changes and exit the Assign a Category screen.

On the Assign a Category screen you can also:

Unassign categories from this article by clicking the x button.
Drag and drop categories into your preferred assignment order.
Select which category the article will be published in, and which categories the article will be listed in.

Tips:

To quickly assign a category without opening the Assign a Category screen you can:

Start typing a category name and then select the category.

To quickly unassign a category without opening the Assign a Category screen you can:

Double-click on a category in the Category box.
OR
Click on a category in the Category box, and then click the minus (-) button.

To order the category
When you exit from assigning the category the new categories are listed at the bottom of the screen. 

This will now contain a list of each category you have added, and an order.  By default, articles are placed at the end of the
category.
Click on the order drop-down list beneath the category you wish to re-order
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Select a new position from the list
Click OK to save the changes,
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Delete a file

To delete a file:

Choose Files menu
Click on the Files tab
Click Delete from the options dropdown menu under Actions
Click OK to confirm that you really do want to delete the file
You will be presented with a warning message asking if you wish to delete the file from disk

Choose No, just delete record from DB  if you wish to delete it from the knowledgebase but leave the file on the
server
Choose Yes, delete from disk  to remove the file altogether.

Note:

If a file is attached to an article it cannot be deleted.
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Enable searching in files

Text-based file searching/indexing (txt, html, etc.) is enabled by default. If you want to include searching PDF or Word documents
then you need to do the following.

Searching in PDFs
 To enable search in PDFs you need to:

Install a program called xpdf
Ensure Settings points to where you installed it
Ensure that PHP has access to your xpdf directory. (Check your open_basedir PHP setting in php.ini)
Ensure that PHP can run the system  function.  (Check your disable_functions, safe_mode_exec_dir PHP settings in php.ini)

Install xpdf

xpdf is available from www.foolabs.com/xpdf/download.html
Download and install it.

Update the setting to point to xpdf

Once you have installed xpdf, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Admin -> XPDF installation path
Make sure that this points to the directory where you installed xpdf. For example: /usr/local/bin/ or c:/wwwroot/xpdf/
Set this to 'off' to de-activate this option.
When you click "Save", test pdf file will be parsed/indexed and error occurs if it failed. 

Test xpdf from command line

Test to see if xpdf is working by running the following command from the command line:

$ /path_to_xpdf/pdftotext -raw file_read.pdf file_write.txt;

Test  xpdf from command line using PHP and included test file:

$ cd /path/to/kbp_directory
$ php -r "system('/path_to_xpdf/pdftotext -raw admin/extra/file_extractors/extract_test.pdf file_write.txt');"

Searching in Word 2007/2010, Excel 2007/2010 or Open Office document files
To enable search in .docx, .xslx and .odt documents you need to:

Install a PHP Zip extension if you do not have one
You can see if you have it installed in Home -> Setup Tests tab  in your KBPublisher installation

Searching in Word 2003 and below files
 To enable search in Word documents you need to:

Install either catdoc or Antiword
Ensure Settings points to where you installed it
Ensure that PHP has access to your catdoc directory. Check your open_basedir PHP setting in php.ini.
Ensure that PHP can run the exec function.  Check your disable_functions, safe_mode_exec_dir PHP settings in php.ini. 

Install catdoc

catdoc is available from http://www.wagner.pp.ru/~vitus/software/catdoc/
Download and install it.

Install Antiword

Antiword is available from http://www.winfield.demon.nl/
Download and install it.

Update the setting to point to catdoc

Once you have installed catdoc, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Admin -> catdoc installation path
Make sure that this points to the directory where you installed catdoc. For example: /usr/local/bin/ or c:/wwwroot/catdoc/
When you click "Save", test pdf file will be parsed/indexed and error occurs if it failed. 

Test catdoc from command line

Test to see if catdoc is working by running the following command from the command line:
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$ /path_to_catdoc/catdoc -w file_read.doc;

Test catdoc from command line using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_catdoc/catdoc -w admin/extra/file_extractors/extract_test.doc');"

Test antiword from command line

Test to see if antiword is working by running the following command from the command line:

$ /path_to_ antiword/antiword -t file_read.doc;

Test antiword from command line using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_ antiword/antiword -t admin/extra/file_extractors/extract_test.doc');"

Turning PDF or Word search off
If you don't want to allow searching on PDF or Word documents, change the setting in XPDF installation path or catdoc installation
path to OFF. 
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Remove scheduling

To remove scheduling from an article, file or news:

Edit the item
Uncheck the Schedule checkbox

You can also use the bulk actions option to remove scheduling from multiple articles or files:

Select each item to be un-scheduled
Choose remove schedule from the Actions with selected options at the bottom of the screen.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to a file

Subscribing to a file means that you receive email notification of any changes to that file.

To subscribe to a single file
Click on the Downloads tab to bring up the list of files
Browse for the file that you wish to subscribe to
Click on Save in the file details box

The Save option changes to Remove, and from now until you unsubscribe you will receive notification whenever this file is
changed.

To subscribe to all files in a category
Click on My account, which is in the top right-hand corner of the knowledgebase screen
Click on the Subscriptions tab
Find a File Categories Subscription section and click Manage
Click on Add New
Select a category you wish to subscribe to from the list. Note, there is also an option to select all categories, if you wish
Click OK to save your subscription.

You can see which files you have subscribed to in the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above

User Manual v7.5 200

https://www.kbpublisher.com/kb/entry/257/


Unsubscribe from a file

To unsubscribe direct from the file
Click on the Downloads tab to bring up the list of files
Browse for the file that you wish to unsubscribe from
Click on Unsubscribe in the file details box

To unsubscribe via subscriptions 
You can unsubscribe from single files here, or from whole categories

Click on My account
Click on the Subscriptions tab
Click on Subscribe / Unsubscribe next to Files if it's for a single file, or from File Categories if it's for the whole category
Click unsubscribe for the file or category you wish to unsubscribe from
Click OK to the message that asks if you're sure

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Feedback
How feedback works on KBPublisher.
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User feedback

Users can contact the knowledgebase by sending a feedback request. They can use the feedback form to ask questions, provide
general feedback or even to suggest updates.

Different subjects can be emailed to different moderators.

The feedback request also provides a 'Quick Response' answer. As the user types their question, KBPublisher searches for articles
appropriate to the words typed and brings back the five articles most likely to match the query. If the answer is in one of the listed
articles, the user doesn't have to send the query at all. They can simply click on the article instead.

The request is sent to an email address defined in the settings.

The person who receives the email can:

Reply by email, or
Publish the feedback to the knowledgebase as an article, or
Both reply and publish.

A user with administrator, moderator or editor access can view the feedback by clicking on the Feedback menu.

This brings up a list of the feedback that users have sent.

1. The date and time the user sent the feedback.
2. The subject area the user chose from the list of subjects when they sent the mail. The person reading the mail may also

change the subject.
3. Username and Email of the user who has sent the feedback.
4. Attachments shows files the user has attached with their feedback.
5. The status of the feedback shows if an answer has been sent to the user or not.
6. When clicking the [...] icon, the menu with the following commands opens:

Click Details to view the history of messages sent to this feedback. The command is available only for a feedback with
the Answered status.
Click Create An Article to add a new article based on this feedback to the knowledge base. A screen for creating a new
article opens when selecting the command.
Click Set status - Answered to change the feedback status from Not answered to Answered.
Click Set status - Not answered  to change the feedback status from Answered to Not answered.
Click Answer to reply to the user by email.
Click Delete to delete the user feedback.

It is quite common to both answer the user by email and then post to the knowledgebase. For example a user might ask
a question that you think deserves to be a knowledgebase article, so you write the article and then email the user back
to say that the answer is now on the knowledgebase.

The templates for the initial email and the reply are controlled in the settings.
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Ask Question and Quick Response

Ask a Question
If you still cannot find the information, you can use KBPublisher's "Ask a Question" feature. As you type in the Question / Comment
textbox, KBPublisher will display articles that might answer your question. If that list doesn't provide the answer you're after, click
Send to email your question to the knowledgebase administrator. Questions can be targeted, too, so that questions will be sent to
different users in your knowledgebase based on the item selected in the Subject dropdown box.

For more information on configuring recipients for Ask a Question submissions, see the following articles:

Set Who Receives Emails
How Can I Route a Question Based on the Subject?
Add New Feedback Subject
 

 Quick Response
By "connecting" your contact form with your knowledge base, your visitors can get instant answers to questions that they would
normally send you via email.

If a user clicks on Ask a question, when they start typing their query into the Question/Comments field, KBPublisher checks what
they are typing and searches for articles that may answer the question.
It presents the five best matches at the bottom of the screen under a heading called 'Do these answers help?'

The five articles returned change as the user types more words.
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Turning off quick response
This option can be turned off in Settings if you prefer a basic feedback form without this feature.

Go to Admin Area
Click on the Settings menu
On the  Common tab, under Feedback, uncheck Enable 'quick response'.
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Reply to feedback from a user

There are two ways to reply to emailed feedback from a user.

The first is to click on the link supplied in the email:

Click on the link after Read and respond to this message at  in the email
This brings up a mail template for you to reply to.

Or you can do it from the feedback option:

Click on the Feedback menu
Click the Options icon under Actions to display the dropdown list, and then click Answer
This brings up a mail template for you to reply to

Once the email template is open:

Type your answer in the Answer section
Click Send
You return to the Feedback screen. The answered box is checked.
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Add an article as a result of user feedback

Sometimes, feedback from a user generates an idea for another article.
You can create this article direct from the feedback page.

Click on the Feedback menu.
Click the [...] icon in a user feedback to display the dropdown list, and then click Create An Article.
This brings up a new article screen for you to start creating the new article. The text in the email is listed in the article title.
Create the article as you normally would and save it.
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Add New Feedback Subject

You can create your own feedback subjects:

From the Tools menu choose the Lists tab
Click on Feedback Subject
Choose Add New

You must include:

A title. This is the subject the user picks from the drop-down list of subjects when they are sending feedback.

You can also add:

A description, which is an explanation of what this subject is used for.
A supervisor. This allows you to determine which user will receive feedback for this subject. If you do not assign a supervisor,
then the email assigned to recieve Support email will get the feedback. To assign the supervisor click on the Add New icon,
find the person you want to receive the emails, and click Assign. You can add more than one supervisor. Each person on the
list will receive the emails.
Choose a color that will be associated with this feedback subject.
The order this item is in the list of feedback subjects. This defaults to 1, which places the new type at the top of the list.
Whether or not the feedback subject is active. If the subject is not active, then the user will not be able to choose this as a
subject.

Lastly

Click Save.
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Article comments

SaComments allow readers to give feedback on articles.

You can read comments in the public view, or if you have admin access you can also see them from the comments tab in the
knowledgebase.

To add a comment:

Open the article to read it
On the right click on More icon in the float panel on the right.
This brings up the screen to choose an action. Click on the Add Comment icon.
This brings up the screen to add a comment. Type in your comment. Type it in as plain text. Do not include HTML.
If you wish to be notified when someone else adds a comment to this article, check Subscribe
Unless the system administrator has changed the settings, you will then need to type in a confirmation code. Type the code
exactly as you see it. Match upper and lower case.
Click Send.

Your comment is displayed beneath the article.
By default, it is displayed immediately, but this can be changed in the settings to require approval first.
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The article comments screen explained

The Article Comments screen displays a list of the comments users have added to articles.

To get to this screen:

Select the Feedback menu
Click on the the Article Comments tab.

1. The Status drop-down list allows you to filter comments by whether they have been published or are unpublished.
2. Use the Search field to search for specific text in the comment.
3. Once you have changed the status or typed in a search command, use the [→] button to get the results back.
4. The records line contains information about how many comments are displayed here, how many pages there are in the list,

and the number of records per page. You can use this to move through the list of comments.

Information shown for each comment includes:

5. The date and time the comment was posted, plus a name and email of the user who posted the comment.
6. The first 200 characters of the comment are displayed initially. If there are more than 200 characters, this will be shown by '...

more' at the end. You can click on 'more' to display the full comment. 
7. The title of the article for which the comment was made, plus the total number of comments for this article.
8. The status of the comment. Articles can be published or not published.
9. When clicking the [...] icon, the menu with the following commands opens:

Article details opens detailed information about the article for which the comment was made.
Set Inactive/Set Active changes the status of the comment.
Edit allows you to edit the user comment.
Delete is used to delete the comment.
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Rating Comments

Users can rate articles to say whether they were helpful or not helpful.

Depending on how you set your knowledgebase up, they can either rate an article as:

Helpful/Not helfpul, or
Use a star rating system.

When a user rates an article they can also add a comment saying why they rated the article the way they did.

These comments are emailed to the supervisor for that category, or if no supervisor is assigned, to the system administrator.

You can see these rating comments in the Admin area

Choose the Feedback menu
Select the Rating Comments tab

----------------------------------------------------------------------
This functionality works in version 3.5 and above

---------------------------------------------------------
Some functionality mentioned on this screen works in version 3.5 only or has been changed for version 4.0. 
For a complete list of changed/new functionality, please see version 4.0 release notes
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The rating comments screen explained

The Article Feedbacks screen displays a list of the comments users have added when they rated an article 'Helpful / Not helpful'.

To get to this screen:

Select the Feedback menu
Then click on the Article Feedbacks tab.

1. The Status drop-down list allows you to filter the rating comments list by a single status, such as New, Ignore, In progress,
Processed.

2. Use the Search field to search for specific text in rating comments.
3. Once you have changed the status or typed in a search command, use the [→] button to get the results back.
4. The records line contains information about how many rating comments are displayed, how many pages there are in the list,

and the number of records per page. You can use this to move through the list of rating comments.

Information shown for each article includes:

5. The date and time the feedback was posted, plus a name and email of the user who made the comment.
6. The first 200 characters of the comment are displayed initially. If there are more than 200 characters, this will be shown by '...

more' at the end. You can click on 'more' to display the full comment.
7. The title of the article about which the comment was made, plus the total number of rating comments for this article.
8. The current status of the comment is shown as a color. Red denotes a new comment, yellow denotes in progress (the article is

being reviewed), blue denotes that the article is currently being updated, and grey denotes a comment that you have chosen
to ignore. (You can change the statuses and the colors from the Settings menu, Lists tab.)

9. When clicking the [...] icon, the menu with the following commands opens:

Article details opens detailed information about the article for which the comment was made.
Set status changes the current status of the comment.
Edit allows you to edit the comment.
Delete is used to delete the comment.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Users
All about users
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The User input screen explained

You can't have a knowledgebase without users. In KBPublisher we have readers, contributors, authors, editors, moderators and
administrators. Or you can set up your own user types.

1. First Name, Last Name and Middle Name make up the user's name. First and last name are compulsory, middle name is
not.

2. Email is the user's email address. This is the email to which all KBPublisher communications will be sent. Email is also
compulsory. Emails are also unique, so you cannot have more than one user in the knowledgebase with the same email
address.

3. Phone is the user's contact telephone number.
4. Company is the company the user works for. If you intend to associate a company with the user, then this company must

have first been set up in KBPublisher.
5. Roles allow you to group users, and to further control what content a user can see.

To add a role:

Click on the [+] to the right of the role field. This takes you to a new screen listing all roles
Select a role you wish to allow the user to take and the role appears in the list of assigned ones
When you are done, click OK to return to the user screen

6. Privileges control the type of access the user has to KBPublisher.

There are five default privilege groups.

Administrator sets up the system, controls user accounts, designs the site and so on
Moderator has access to every part of the system except Settings and Import/export. The moderator generally
creates users, organizes categories and manages the knowledgebase on a day to day basis
Editor can add, edit and delete their own and other users articles, files, comments and visitors' questions. This is
the person responsible for the overall content of the knowledge base.
Author provides the actual content. An author can add, edit, delete or publish their own articles and files. When
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they have completed an article and published it, the article appears immediately in the article list
Contributor also provides content, and can add edit or delete their own articles and files but the articles and files
do not appear in the knowledgebase immediately. They must be approved by an editor or a moderator. Once an
article or file is approved, the contributor can no longer edit it.

You can also create your own privilege groups.

Users may also be set up with no defined privilege. These are the public users.

7. The Username is the name the user uses to log on. If you click set as email  here, the username will be the name you typed
into the email field. You must provide a username.

8. The Password is the password the user will use to log on. Because this is a password, the text you type is replaced by
dots. You can also generate a random password instead, by selecting Generate random password.

9. Because there is no way of seeing what you typed into the Password field, you need to retype the password into the
Verify Password field.

10. User notes are comments the user adds when he or she fills in the form to request user access.
11. Private Admin notes are notes that can be added by the administrator when adding or updating the user. The user does not

see these.
12. The administrator adding the user can automatically subscribe them to news, files and articles. The user is then notified of

any changes to these. Click All to subscribe them to all changes, or click to select individual subscriptions. Use <Shift> or
<Ctrl> to select more than one. 

13. A user must be Active to be able to log on to the system. An inactive user cannot log onto the system at all, and user who is
pending (approval required) has been set up but is still not able to access the system until a moderator or administrator
approves them.
User statuses could be managed at Tools -> Lists -> User Status.
Note that inactive users can still see any parts of the public area that are open to everyone. That is, that users don't have to
log on to see.

14. If Notify user is checked, the user will receive an email once their access has been set up.

---------------------------------------------------------
Some functionality mentioned on this screen works in version 3.5 only or has been changed for version 4.0. 
For a complete list of changed/new functionality, please see version 4.0 release notes
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Add a user

To add a new user

Click on the Users menu
Click on Add New .

Once you are on the Users screen you must complete the following sections:

Give the user a First Name and a Last Name
Add their Email
Give them a Username. If you prefer, you can set their email as their user name.
Set up a Password

The following items are optional:

Assign a Privilege. If you do not assign a privilege the user will have standard read access to the public area.
To classify the user, and provide another level of access, include a Role. 
You can include extra user details such as a Middle Name, Phone and Company
You can add comments about the user or registration
You can automatically subscribe them so that they receive changes to news, articles or files
To give the user immediate access to the system, make this user Active
To send an email to the user after then that their user ID has been created, check Notify User .

You can find out more about each of these fields on the User screen and how they work in the User Screen Explained

Once your user has been set up:

Click Save.

Tips:

If you have a number of users to add from another database, say, you may want to import users instead of adding them
Or you may choose to allow users to register, which effectively allows them to create their own user.
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Change user status

There are two ways to change the status of a user.

The quickest way allows you to update the status of more than one user at the same time.

Click on the Users menu
Check the box to the left of the user or users you wish to change
Choose Set Status from the Actions with selected drop down box

This brings up another drop down box with a list of statuses to choose from
Select the status you wish to change to
Click OK
You will be asked if you really want to change the status. Click OK to confirm.

The other way to change the status of the user is to:

Click on the Users menu
Click on the paintbrush under Actions to edit the user
Change the Status
Click OK.

This second method only allows you to change the status of one user at a time.
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Delete user

The quickest way to delete a single user is to:

Click on the Users menu
Click Delete from the options dropdown menu under Actions
In Actions column click icon [...] and in drop down menu click Delete
Click OK to confirm the deletion.

The second way allows you to delete more than one user at the same time.

Click on the Users menu
Check the box to the left of the user or users you wish to delete
Choose Delete from the Actions with selected drop down box
Click OK
You will be asked if you really want to delete the user. Click OK to confirm.

User Manual v7.5 218



Bulk update users

KBPublisher allows you to bulk update users to:

Set roles
Set privileges
Assign users to a company
Automatically subscribe them to news, articles or files
Set the user status
Delete users.

You can do this direct from the Users menu, Users tab.

To update the users:

Check one or more users to update
Choose the appropriate action from the drop down list of actions with selected
This brings up further options to select from according to the action chosen. Choose the appropriate selection
Click OK.

Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete articles that you have created,
then there is no 'Delete' action in the list of options. If your privilege does not allow you to update items, or allows you to only
update items you have created, then this menu will not be available for you at all.
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Import users

You can import users in bulk. You might want to do this if you are changing over to KBPublisher from an old system, or if you have
signed up a new company or organization and the company provides you with a list of users to create.

The process is:

Create a file of users to import
Upload a test sample to the system
Import.

Create a file of users to import
First, you need to create your file of users. This is a comma-separated (CSV) text file that consists of some or all of: first name, last
name, email, username, user ID, date registered, middle name, telephone number and an active flag.

The first five fields (highlighted bold) must be included. You can include some, all or none of the others as required.
They do not have to be in the same order as above, but each line in the import file must contain the same fields in the same
order.
The password is encrypted. You cannot import plain text passwords; they must be encrypted in MD5 format. Ensure that the
person providing you with the list encrypts the passwords.
The active flag defaults to '1', which is active, so the only time you would set this is if you don't want the users to be active.
Place the data for each user onto a single line, and separate each field by a comma. Do not include spaces before or after the
comma.
The TestImportUsers.csv file is a sample that shows what your upload file should look like. This file includes the four default
fields only.
Field sizes and types are specific, as per the table below. Your data must fit within these parameters or the upload will fail.

Field Type/size M/O Comments

first_name varchar(50) compulsory

last_name varchar(100) compulsory

email varchar(100) compulsory

username varchar(50) compulsory

date_registered date optional
Format YYYY-MM-DD.
If not supplied will use current
date.

middle_name varchar(50) optional

phone varchar(20) optional

active tinyint(1) optional Default = 1

Create a test file
Don't try to upload the whole file without testing it first. If something goes wrong you may then have to delete all those half-
imported users and try again. Create a test file and run that first.

Copy the first, say, three lines of your text import to a separate file
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)
Upload the file to the server

Import the test file
You are now ready to import the test file to KBPublisher.

Click on the Import/Export menu
This brings up the Import Users tab
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File  in the SQL Load Command  field
Browse for the CSV file on your drive and open it
 

If the import file is on the server,
Choose Load data file
Type the address where the file is located into the Path to file field on CSV file line
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Move the CSV fields around to specify which fields are in the file and what order they are in.
Do this by clicking on the name of the field you want to move and dragging and dropping it into the appropriate place.

For example, suppose you only want the five mandatory fields included. You need to move the date_registered and
imported_user_id fields out of the Fields in CSV  box and into the Available table fields box. Let's start with the
date_registered field.

Click on the date_registered field and hold the mouse down
While holding the mouse down, drag the date_registered field over to the Available table fields box
Drop the field into the box by releasing the mouse

Make sure that you place it in the order it appears in the file.
 

Change CSV options if required.
Click Load.

Once the load is complete you are returned to the Import Users tab. At the top of the screen you see a message telling you whether
the import was successful and how many users were imported.

If the import reports as successful, click on the Users tab to check the result for yourself.

Fix any problems
All going well, you should now have three new users. Check them carefully and ensure that everything worked as you expected.
If you had problems, delete these three users, fix the test file and run it again. Keep fine-tuning until it works, and then update the
real file to match the fixes you made in the test file.
You are now ready to import the rest of the users.

Import users
Import the rest of the users using the same process as for the test file, only this time using the real data file.

Note:

Imported users have no roles or privileges.
If any unique keys will be duplicated during import, records from cvs file will be ignored.
Use the bulk actions option in Users module to change roles, privileges, etc.
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Companies

Companies provide another level of information about users. When you create a user you can assign the user to a specific company.

Companies are not compulsory in the knowledgebase. You would use them if your users were from a small number of companies,
but if your users came from all around the world and were a mix of individuals and company users you probably would not bother.

Some examples where you might user them:

Your users come from a finite number of companies and you have multiple users in each company
When you license the knowledge in your knowledgebase and charge the company for access

Some examples where you probably wouldn't:

Your users come from all around the world
You would have to set up a different company for every user
When there is only one company (although you could also set up the company in this case; it wouldn't matter either way).
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Generating API Keys

For API authentication Public and Private keys are required.
Each user has his own unique keys. 

To generate and assign keys to user:

Login to Admin Area 
Click User tab
Click the Options icon under Actions to display the dropdown list, and then click Details
Click API Settings, it will open for with API Settings
Check API Access to allow user API requests or uncheck to disalow
Click Generate API Keys if you assign keys in first time or Reset API Keys if updating 

Important: if you reset API keys it will affect all current scripts for this user
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User Activities

The Activities tab lets you view activity on your site related to a specific user. You can find actions performed by a specific user,
actions related to specific articles by this user, or other types of content. This tab duplicates the functionality of the User Activity
Report but is filtered to a specific user. 

To open this tab from Users ► Users, click on the [...] icon in the last column for the desired user.

See this article for details on the User Activity Report.
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Privileges
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User privileges

Any user can read articles, but in order to create articles and to publish them to the knowledgebase, users must have certain
privileges.
For example, to actually write articles a user must have author or contributor privileges. 

To publish the article for other users to read, they must be in the author, editor or moderator privilege groups. KBPublisher comes
with five default privilege groups, and you can also create your own.

There are five default privilege groups.

Administrator sets up the system, controls user accounts, designs the site and so on
Moderator has access to every part of the system except Settings and Import/export. The moderator generally creates users,
organizes categories and manages the knowledgebase on a day to day basis
Editor can add, edit and delete their own and other users articles, files, comments and visitors' questions. This is the person
responsible for the overall content of the knowledge base.
Author provides the actual content. An author can add, edit, delete or publish their own articles and files. When they have
completed an article and published it, the article appears immediately in the article list
Contributor also provides content, and can add edit or delete their own articles and files but the articles and files do not
appear in the knowledgebase immediately. They must be approved by an editor or a moderator. Once an article or file is
approved, the contributor can no longer edit it.

You can also create your own privilege groups.

Here is a quick chart of default user types in KBPublisher

Privilege levels
Each user type has a privilege level. The privilege level defines who can edit users of this level. Users cannot edit other users with
a privilege level lower than or equal to their own.

Admin users always have a privilege level of 1. They can edit any other user.  In the standard setup editors have a privilege level of
3, while authors have a privilege level of 4 and contributors 5. This means that an editor could--if he had edit user access--edit
author and contributor users while a contributor could not edit any users except other contributors (again, and only if he had edit
user access).  None of them can edit admin users.
This gives an extra level of security when editing users.

* Adding comments, rating articles and sending emails to the administrator are all options that can be turned on or off in the
settings. Hence while these options are available, they must also be turned on if you wish to use them.
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How privileges work

User access is controlled by privileges.

There are five default privilege groups. 

Administrator sets up the system, controls user accounts, creates templates, designs and so on
Moderator has access to every part of the system except settings. The moderator generally creates users, organises
categories and manages the knowledgebase on a day to day basis
Editor can add, edit and delete articles, files, comments and visitor feedback. This is the person responsible for the overall
content of the knowledge base. They are also the person who manages visitor comments and feedback.
Author (trusted) provides the actual content. A trusted author can add, edit or delete articles and files. When they have
completed an article and published it, the article appears immediately in the article list
Author (untrusted) also provides content, and can add edit or delete articles and files but their articles and files do not
appear in the knowledgebase immediately. They must be approved by an editor or a moderator. Once an article or file is
approved, the untrusted author can no longer edit it.

Default privileges

 You can also create your own privilege groups. 

You can stop all users in a privilege group from logging on by making the privilege inactive.
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Create new user privilege

Privileges control what a user can do on the system. There are five default privilege groups, but you can also create your own.
You must have administrator access to create new privileges.

To create a new privilege group:

Click on Users
Choose the Privileges tab
Click Add New

Complete the following:

Title is compulsory
Privilege level is also compulsory. This controls user security. Users cannot edit users with a privilege level less than their
own, even if the access settings allow them to edit users.
Check privileges as required. A user will be able to do anything that is checked.
The privilege screen explained tells you how each of the options work.

You may also wish to:

Add a description to explain why this group has been set up and how it should be used
Prevent users in this group from logging on by making the group inactive.
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Change user privilege

There are two ways to change the user's privilege.

The quickest way allows you to update the privileges of more than one user at the same time.

Click on the Users menu
Check the box to the left of the user or users you wish to change
Choose Set Privilege from the Actions with selected drop down box

 
This brings up another drop down box with a list of privileges to choose from. One of these options is to 'remove all privileges'.
This sets the user back to a standard public user.
Select the privilege you wish to change to
Click OK
You will be asked if you really want to change the privilege. Click OK to confirm.

The other way to change the privilege of the user is to:

Click on the Users menu
Click on the paintbrush under Actions to edit the user
Change the Privilege
Click OK.

This second method only allows you to change the privilege of one user at a time.
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Set default user privileges

New users can be created two ways. They can be set up by the knowledgebase administrator, or users can register themselves.

By default, when users register KBPublisher creates them with no privileges. You can change this so that new users are created with
a specific default privilege by:

From the Settings menu choose the Public Area tab
Go to the Security / Privacy / Registering section
Select the appropriate Privilege for new registered users from the drop-down list of privileges
Click Save.

All new users who register after this are created with the new default privilege.

You must have administrator access to change the settings.
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The Privilege Screen Explained

1. Title is the name of the privilege. Title is compulsory.
2. Description is used to remind you what the privilege is for. For example, when the administrator creates a new privilege, he

or she would use the description to explain what the privilege does and how it should be used.
3. When the privilege is set to Active (that is, active is checked), users with this privilege can log in. If it is not set, then users

with this privilege cannot log in. Thus, with one click you can prevent all users with a specific privilege from logging in.
4. You can control the privileges for each module in KBPublisher separately. This means you can give access just to one area only

if you wish. For example, you may allow access to the knowledgebase, but not to Files, Feedback, Users, Settings or
Import/Export. Or you may have hired a contractor to import a list of users for you, and you give them access to the
Import/Export section only, but not to other areas of the knowledgebase.

5. Or you can apply privileges to each sub-module.
6. Most of the privileges are self-explanatory.

 

When Read is checked the user can view items. If own records is also checked, they can only read records they
have created. Otherwise they can read all records. Belong to own records  denotes items like comments, and
allows the user to manage comments that belong to items where own records is checked.
 
When Add is checked they can create new items. if As draft only is checked, they can add only drafts. 
 
When Update is checked they can change existing ones. If own records is also checked, they can only update
records they have created. Otherwise they can update any record. If As draft only is checked, they can
update articles as draft only. Belong to own records  means that the user can update comments for items they
own.
 If status, then the user can only update articles with the assigned status. (To select more than one status hold
the <Ctrl> key down and click each status you want.) If no status is selected, the user will be able to update
records with any status.
 
When Delete is checked the user can delete items. If own records is also checked, they can only delete records
they have created. Otherwise they can delete any record. Belongs to own records means that the user can
delete comments for items that are designated as their own.
If one or more statuses are selected under If status, then the user can only delete articles with the assigned
status(es). 
 
Status allows the user to change the status of an article from, say, unpublished to published. If own records is
checked, then the user can only change the status of records they have added.
If one or more status is selected under allowed status to set , then the user can only change items to the
selected status(es). If no status is selected, the user can change the record to any status.

Privilege levels
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Privilege level denotes the level of security for this privilege.  Users cannot update other users with a privilege level lower than or
equal to their own, even if they have user update access.

You can manage Privilege level by clicking [...] icon on the right in privilege list view screen.
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Roles
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User roles

Roles allow you to set up a hierarchy of users and to control which articles users can see.

Roles are set up as tree structures, and when you mark an entry as private to a specific role then users with this role and with
parent roles have access to the article. Any role below it in the tree, and roles that do not belong to 'current tree', will not be able to
access the article.

For example, suppose you have the following roles:

In the above tree the Contractors role has a sub-role of Manager, and below that sub-sub-roles of Beta Tester, Tech Writer and
Programmer.

Users can be assigned to multiple roles.  Thus your programmer could also be an employee. 

If you mark an article private read and assign to it a role of 'Programmer', then contractor managers and programmers will be able
to access the entry. No one else will have access to this article.

Note:

Users with administrator privilege have access to any article in any category.
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Create new user role

Roles control access to knowledgebase articles and files.
Some default roles have been created, but you can also create your own.

You must have administrator access to create new roles.

To create a new role:

Click on Users 
Choose the Roles tab
Click Add New

The following are compulsory:

You must include the role name in the Title
The Parent role denotes where in the list of roles this role is placed. If you choose 'Top Level' your new role becomes a top
level role. Otherwise, choose the parent role for your new role.

You may also wish to:

Add a description to explain why this role has been set up and how it should be used
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Change user role

There are two ways to change the role of a user.

The quickest way allows you to update the role of more than one user at the same time.

Click on the Users menu
Check the box to the left of the user or users you wish to change
Choose Set Role from the Actions with selected drop down box

This brings up another drop down box with a list of roles to choose from. One of these options is to 'remove all roles'.
Select the role you wish to change to
Click OK
You will be asked if you really want to change the role. Click OK to confirm.

The other way to change the role of the user is to:

Click on the Users menu
Click on the paintbrush under Actions to edit the user
Change the Role
Click OK.

This second method only allows you to change the role of one user at a time.
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Set Default User Roles

New users can be created two ways. They can be set up by the knowledgebase administrator, or users can register themselves.

By default, KBPublisher creates registered users with no designated role. You can change this so that new users are created with a
specific role by:

First, ensure that the role exists. If it doesn't, create it first
From the Settings menu choose the Public Area -> Common tab
Go to the Security / Privacy / Registering section
Select the appropriate Role for new registered users from the drop-down list of roles
Click Save.

All users who register after this are created with the new default role.
You must have administrator access to change the settings.
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My Account

How to use My Account
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How do I change my password?

To change your password:

Log in to the knowledgebase
Click on My account, which is in the top right-hand corner of the knowledgebase screen
Click "Change Password"
Type in your Your Current Password if required
Type your new password into the New Password field
Retype the password in the Verify Password field
Click OK.
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How do I display more articles on a page?

Ten articles are listed on each screen by default is 10, and you have to click more to see the next ten, and so on. The adminstrator
can change this or everyone.

You can also personalize it for yourself, and display 20 or 40 records at a time instead:

Click on Admin Area if you are in the public view
Click on My Account, which is in the top right-hand corner of the knowledgebase screen beneath your login details
Click on the Settings tab
Choose 10, 20 or 40 records from the drop-down list for Number of records per page
Click Save.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Change the order articles and files are displayed in

By default, articles and files in Admin Area are displayed in ascending date updated order.  That is, the last article or file updated is
at the top of the list, and the first one updated is at the bottom.

Sometimes you want to see the list differently.  You can order by date added (newest date first), date added (oldest date first), date
modified (newest date first), date modified (oldest date first) and in alphabetical order.

Click on Admin Area if you are in the public area
Click on My account, which is in the top right-hand corner of the knowledgebase screen, beneath your login details
Click on the Settings tab
To change the order that articles are sorted in, choose an appropriate order in Sort Articles By
To change the order that files are sorted in, choose an appropriate order in Sort Files By
Click Save.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscriptions

Subscriptions allow you to be notified when:

A single article is changed
Any article in a specified category is changed, or when new articles are added to the category
A single file is changed
Any file in a specified category is changed, or when new files are added to the category
News is added or changed
A comment has been added to an article or file.

When you set up a subscription for a specified item or category, then KBPublisher sends you an email when that file or category is
changed.

You can see what you have subscribed to on the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to an article

Subscribing to an article means that you receive email notification of any changes to that article.

To subscribe to a single article
Open the article to read it

In the right float panel, click Save. The article will be added to your Favorite list and subscription will be automatically
activated. From now until you unsubscribe you will receive notification whenever this article is edited.

To subscribe to all articles in a category
In the category tree, select a category you wish to subscribe to.
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Click Options in the top right-hand corner. A panel with additional actions will appear.
Click Subscribe.

You can see which articles and categories you have subscribed to in the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above

User Manual v7.5 244

https://www.kbpublisher.com/kb/entry/257/


Unsubscribe from an article

To unsubscribe direct from the article
Click on the article to read it.
Click on Remove in the right float panel.

To unsubscribe via the subscriptions list
You can unsubscribe from single articles this way, and whole categories

Click on My account.
Click on the Subscriptions tab.
Select a required section and click Manage.
When selecting Articles Subscription or Article Categories Subscription, in the opened list find an article or category you
wish to unsubscribe from. Click the [...] icon and in the opened menu select an Unsubscribe command.
Click OK to the message that asks if you're sure.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to a file

Subscribing to a file means that you receive email notification of any changes to that file.

To subscribe to a single file
Click on the Downloads tab to bring up the list of files
Browse for the file that you wish to subscribe to
Click on Save in the file details box

The Save option changes to Remove, and from now until you unsubscribe you will receive notification whenever this file is
changed.

To subscribe to all files in a category
Click on My account, which is in the top right-hand corner of the knowledgebase screen
Click on the Subscriptions tab
Find a File Categories Subscription section and click Manage
Click on Add New
Select a category you wish to subscribe to from the list. Note, there is also an option to select all categories, if you wish
Click OK to save your subscription.

You can see which files you have subscribed to in the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from a file

To unsubscribe direct from the file
Click on the Downloads tab to bring up the list of files
Browse for the file that you wish to unsubscribe from
Click on Unsubscribe in the file details box

To unsubscribe via subscriptions 
You can unsubscribe from single files here, or from whole categories

Click on My account
Click on the Subscriptions tab
Click on Subscribe / Unsubscribe next to Files if it's for a single file, or from File Categories if it's for the whole category
Click unsubscribe for the file or category you wish to unsubscribe from
Click OK to the message that asks if you're sure

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to news

To be notified when news items are added to the knowledgebase:

Click on My Account
Click on the Subscriptions tab
Choose Subscribe/Unsubscribe for News.  This brings up a subscribe button.  
Click Subscribe

You will be notified daily of changes to news items.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from news

To no longer receive notifications about updates to the news area of the knowledgebase:

Click on My Account
Click on the Subscriptions tab
Choose Subscribe/Unsubscribe for News.  This brings up a subscribe button.  
Click Unsubscribe

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Reports
Reports functionality in KBPublisher
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The Usage Report Explained

1. Report Filter allows you to choose which statistics you want to report on. Check each item you want statistics for
2. Range allows you to determine whether the stats are shown for each day, for a month at a time or for a whole year.
3. Period is the time period over which the stats are to be listed for. The options here depend on what you choose in the range.

For example, if you choose monthly, then the period options will be this week, previous week, this month or the previous
month.
You can also select a custom period. If you choose this KBPublisher allows you to choose a From date and a To date.

4. Once you have selected filters, a range and a time period, click the OK button to produce the report.
5. The report is displayed as a graph - you can choose line, bar or pie charts
6. And as a table on screen.
7. If you wish, you can also Export the results.

If you click on the Export button, you get the option to export the results in XML, CSV or Excel format. Once you have chosen
the appropriate format to export in, click on the Export button to export the data. You will be asked if you want to open the
file or save it.

Note:

Report functionality only works when scheduled tasks are turned on
Data collected is summary data. We do not break down data to individual user level, we collect totals only.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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The Views Report Explained

The Views Report lets you review how often visitors are looking at each of your articles or documents.

The main display shows you, for each document:

the document's ID
the title
the number of views (or "hits") the document has had in the current time span
what percentage of all views that number represents (in the "Rate" column)

If there are a lot of entries, the list at the right is broken up into pages, with the number of entries displayed at the top left. Use the
navigation options at the top right to move through the list.

You can filter the display to simplify finding what you want. The Report Filter is on the left of the screen, and you can use one or
all of these filter conditions:

Type -- Choose from the available options: Article Views, File Downloads, or News Views.
Period -- Choose a time period such as "This Week". If you choose "Custom", fields appear where you specify the start and
end dates for the custom period.
Limit -- Indicate how many entries to display. If you select "__", KBPublisher displays all entries for the type you selected.
Category -- Choose a category to only display items from that category. Check the checkbox to the right of the field to also
display entries in sub-categories of the category you selected.
Entry ID -- You can enter one or more document IDs, if you know them, to restrict the display to those documents only. If you
enter multiple IDs, separate them with commas (like "22, 40, 104, 10021").

Click OK to display filtered search results. If there are no results, your search may be too restrictive: remove or relax one filter and
click OK again.

To see details about one document use, you can click its title.

The Details appears. This view has a space for a chart at the top, a table and an export button.

Details View
The details view can display a chart of document use, and has a table to report on daily use and a button to export the information.
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Chart

A chart of document views can help you analyze viewing and use patterns over time. You can display the information about the
selected document or documents as a Line, Bar, or Pie chart; or you can opt to have no chart:

Table

The table shows the number of views for the selected document for each day in the selected period. Sundays appear in red so you
can quickly see week-by-week information.

Export button

You can export the views data for the documents you selected. See Export Reports.

To return to the full list of documents, locate the "breadcrumbs" entry at the top of the display. Click either Article Views or
Filtered views to close the details view.

Note:  Report functionality only works when scheduled tasks are turned on
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The User Activity Report Explained

The User Activity Report lets you view activity on your site so that you can analyze your user base and the state of your content. You
can find actions performed by specific users, actions related to specific articles or other types of content, and can even filter your
search by date range or IP address.

Note: Report functionality only works when scheduled tasks are turned on.

What reports I can generate?
The User Activity report is very flexible. Here are a few examples of what you can find:

users who logged in this week
users who did not log in this week (use the "Invert Result" checkbox)
articles that were updated last week
articles that were created this month
articles that were created this month by specific user
all of a specific user's actions
all actions by a user with a specific IP address

What report data is available?
For every entry type, the system logs different actions. The "Actions" dropdown menu in the filter report varies by entry type. For
example, the "Publish" action is only available when the entry type is Article Draft or File Draft. As a more extended example, for the
User entry type the system logs the following:

Create - Someone created a user
Update - Someone updated a user's details
Bulk Update - Someone updated user details in bulk
Delete - Someone deleted a user
Login - Someone logged in

What are the report filter options?
The Report filter is on the left of the screen, and you can use one or all of these filter conditions:

Entry type - Choose from the available options: __ (all), Article, File, User, News, Article Draft, File Draft.
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Action - Choose from the available options: __ (all), View, Create, Update, Bulk Update, Delete, Move to Trash, Login, Publish.
Period - Choose from the available options: All, Previous Day, This Week, Previous Week, This Month, Previous Month, This
Year, Previous Year, Custom period.
User ID  - Enter the numerical ID for a user, or click the + button to select a user from the Users popup. For results already
displayed, you can also click on a user's name in the User column and select Report filter.
Entry ID - Enter the numerical ID for the entry type, or click the + button to select an entry from the popup.
User IP - Enter an IP address to filter by user IP.
Invert Result - This checkbox extends the report's powerful functionality by displaying the inverse of the results that the
currently selected filters would display. For example, you might search for users who have not logged in since the middle of
last month, or you might want to know which articles have not been updated this year.

How are the results displayed?
If there are a lot of entries, the list at the right is broken up into pages, with the number of entries displayed at the top left. Use the
navigation options at the top right to move through the list.

The main display shows the following for each activity log item:

the time
the entry type
the action
the entry ID
the user's last name and first initial
the user's IP address

Can I export this report data?
Yes! See our article about exporting reports for more information.
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Export Reports

You can export your reports on document and file activity from the Usage, Views and User Activity tabs of the Reports menu
item.

Each of these tabs has a pair of sub-tabs, Report and Export. Once you see the information you want to export in the Report sub-
tab, switch to the Export sub-tab to export it.

For XML or Excel, select that option and click Export.

For CSV export, accept the defaults for the options for the exported data, or set your own:

Fields terminated by  -- The mark that indicates the end of data for the current field; normally a comma.
Fields optionally enclosed by  -- You can opt to enclose data for each field in quotation marks or another mark. This allows
you to include commas in the data even if they are also used as the field terminators.
Lines terminated by  -- For multi-line entries for a field, the mark that indicates when to start a new line,
Include field names row  -- Check the checkbox to include the header row in the export.
Include total row  -- Check the checkbox to include a "totals" row indicating a count of the entries.

When you are satisfied with the settings, click Export.

----------------------------------------------------------------------
This functionality works in version 3.5 and above

User Manual v7.5 256



Statistics

The statistics screen allows you to see

What are the most viewed articles
The articles with the highest rating
The articles with the lowest ratings
The articles with the most comments
The most downloaded files
The most popular search terms used, and the least popular
Plus general statistics about articles, files, news, feedback and users.

You can export the results as xml or csv files for use elsewhere.

Note:

We keep records at summary level only. We do not break data down into individual users.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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The Must Read Report Explained

The Must Read Report  lets you review which articles are set as required reading, who has confirmed reading them and when, and
who has not confirmed reading.
 

You can filter the display to simplify finding what you want. The Report Filter is on the left of the screen, and you can use one or
all of these filter conditions:

Entry Type -- Choose from the available options: Article or News.
Date Created -- Choose a time period when the Must Read was created, such as "This Week". If you choose "Custom", fields
appear where you specify the start and end dates for the custom period.
Date Expired -- Choose a time period when the Must Read expires. If you choose "Custom", fields appear where you specify
the start and end dates for the custom period.
Notified -- Filter result by Notified status. 
Confirmed -- Filter result by Confirmed status.
User ID  -- You can enter one or more user IDs, if you know them, to restrict the display to those users only. If you enter
multiple IDs, separate them with commas (like "22, 40, 104, 10021").
Entry ID -- You can enter one or more document IDs, if you know them, to restrict the display to those documents only. If you
enter multiple IDs, separate them with commas (like "22, 40, 104, 10021").

Click Filter to display filtered search results. If there are no results, your search may be too restrictive: remove or relax one filter
and click Filter again.

To see details about one Must Read use, choose Details from popup menu on the right.
 

Details View
The details view displays detailed information about Must Read items, such as Must Read details, and a list of users along with dates
when they were notified and when they confirmed.  
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Export Reports
You can export the views data for the documents you selected. See Export Reports.
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RSS
An explanation of RSS feeds and how to set them up
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Turn RSS feeds on or off

You must have administrator access to do this. 
Login to Admin Area.

To turn RSS feeds on
Click on Settings menu
Choose the Public Area -> Common tab
Go to the section titled RSS Feeds  at the bottom of the screen
In the Generate RSS feeds field choose either One Channel for whole knowledgebase, or Channel for every top
category depending on whether you want multiple feeds or one feed for the whole knowledgebase.
Click Save to implement the changes.

To turn RSS feeds off
Click on Settings menu
Choose the Public Area -> Common tab
Go to the section titled RSS Feeds  at the bottom of the screen
In the Generate RSS feeds field choose Do not generate any RSS feeds
Click Save to implement the changes.

User Manual v7.5 261



Change RSS feed from single feed to separate category feeds

By default, your knowledgebase is set up to display a single RSS feed for the whole knowledgebase. You may, however, want to
change this. You might want to turn it off altogether. Or you might want to change it so that each top-level category has its own
feed.

Separate feeds are useful when your users are only interested in information about specific categories. For example,suppose your
knowledgebase was about internet browsers. You have three main categories: Internet Explorer (IE), Firefox and Safari. People who
use Sahara are not interested in anything IE or Firefox related, they are only interested articles pertinent to Sahara. Likewise, Firefox
users do not generally use Internet Explorer. In this case, a separate feed for each top category is ideal.

You require administrator access to do this.

Click on Settings menu
Choose the Public Area -> Common tab
Go to the section titled RSS Feeds  at the bottom of the screen
In the Generate RSS feeds field choose Channel for every top category
Click Save to implement the changes.

Even when this is turned on, a user can still subscribe to the single feed if they wish to.

Note:

Articles designated as "private" are not shown in the RSS feed.
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Subscribe to RSS feed

KBPublisher produces an RSS feed which users can subscribe to by:

Click on the RSS feed image at the bottom of the screen ( )
This brings up a list of all feeds available.

If KBPublisher is using default settings, there will only be one option available--Knowledgebase RSS .
If multiple feeds are set up, this list will also include a feed for each top-level category.

Click on the RSS feed image to the right of the feed you wish to subscribe to to bring up the RSS page.
Click on Subscribe to this feed

Note: Articles designated as 'private' are not shown in the RSS feed.
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Tools
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Tags, Labels
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What are Tags?

Tagging is another non-hierarchical way to group related articles together and to quickly tell readers what they are reading about.
Tag keywords and phrases so readers can easily find articles related to specific topics.

Tags are similar to categories, but are more specific. The use of tags is optional.
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Tagging Content

Tagging an article, news, or file?
It's easy! When you create or update an article or a file, you can assign and/or add new tags to it using the Meta Keywords/Tags
field.

Click on the Add a tag  link below the text editor.

You can add tags one at a time by hitting the Enter after typing each tag. Or you can add multiple tags at a time by separating each
with a space as you type. You can join 2 or more words together in one tag by enclosing them in quotation marks.

To select a tag from your existing list (tags previously used in KBPublisher) click Choose from your tags  and select the tags you
want to use.

Note: Changes are not saved until you save an article.
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Bulk Add or Update Tags

To bulk add or update tags, log on to the Admin Area

1. If you are updating:

an article's tags, click on the Articles menu
a file's tags, click on the Files menu
a news' tags, click on the News menu

2. Choose Set Tags from the Actions with selected drop-down

a second drop-down will display the following options:

Remove any tags:

Choose Remove all tags from the second drop-down box
Click OK

Add tags:

Choose Add to existing to add tags and not remove existing ones or Replace existing to remove old tags and
assign new ones 
Click Add a tag
Assign tags from choosing existing ones or add your own tags
Click OK to save the change

User Manual v7.5 268



Managing Tags

You must have administrator access to manage tags.

Login to Admin Area, click Tools, choose the Tags tab.
From here you can see all the tags used in KB.

Create or updating a tag 

The following are compulsory:

You must enter a tag name in Title
Check Visible to make tag visible to end users or uncheck so that it is hidden

You may also wish to:

Add a Description to explain why this tag has been set up and how it should be used
This information is displayed in Public Area, under Tags to help end users searching for content
 

What is a difference between visible and hidden tags?
A visible tag displays in the Tags of and article (below the article) in the Public Area. Although hidden tags do not display in the Tags
section, it is always used for searching.

Can I safely update or delete tags? 
Yes, you can. When you update a tag it will affects all entries already assigned.
Conversely, when you delete a tag, it will be deleted from all entries that is was assigned to.
Since the daily scheduled tasks are responsible for updating meta keywords updates it might take some time for these changes to
take effect.
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Tags in Public Area

The 3 uses of tags in the Public Area 

While viewing an article you can see all assigned tags below an article.
Click on a tag to display all articles with this tag. This function is the same for the News section.

The Tags section will list all tags.
Click a tag to be be redirected to search section displaying all articles with this tag.

In Advanced Search you can search the knowledgebase by tags.
- Type keywords in Keywords field, you can type several keywords separated by comma
- In Search In choose Articles (tags, keywords) or Files (tags, keywords) or News (tags, keywords)
- Click Search and KBPublisher will search in articles, files, or news respectively.
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Custom fields

Custom Fields

User Manual v7.5 271



Custom Fields

You can customize your knowledgebase by adding custom fields.

These custom fields can be defined for:

Articles
Files
News
Feedback form

For articles, the custom fields can:

Be displayed at the top of the article
Be displayed at the bottom of the article
Be displayed after the rating block
Or they can be hidden, for internal use only

For files, fields are for internal use only.  That is, you can see them when you add the file, but the user cannot see them.

Depending on where the field is displayed, you can also include text around the field.  For example, the field may be 'Department',
and the valid value in the field might be 'Sales', but the user might see this as 'Contact the Sales Department for further
information'.

You can show or hide any field in a search form.
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The Custom Fields Tab Explained

This screen allows you to create custom fields, and to place them in your knowledgebase.

The Custom Fields tab

1. The Custom Fields tab allows you create and manage the fields and to control which categories or areas they are attached
to. The Ranges tab allows you to create a set of valid values which you can then assign to one or more custom fields.

2. Field type is a filter that allows you to view custom fields for a specified Field types. Select your filter and then click the
[→] button to restrict the list.

3. You can also search on the name of the custom field by typing the name into the Search fields and then clicking the [→]
button.

4. Clicking the Add New button allows you to create a new custom field. Note that you can only create the field to go with a
specific entry type. Thus if you want to add, say, a Department field to both articles and files, then you would need to create
two custom fields.

5. The Title is the name that the user sees on the screen when they add or read an article
6. The Field type denotes the type of field it is. Whether it's a checkbox, or a select box, or even free-flowing text
7. The ID denotes a unique identifier of the custom field.
8. Man denotes mandatory. When a field is mandatory the author creating the item cannot leave this field blank.
9. Cat shows if the custom field is displayed in a certain category.

10. Dis shows if the custom field is displayed in the search screen.
11. The [i] button opens a list of entries where the custom field is used.
12. The last column contains the [...] button which opens a menu with the following commands:

Apply allows you to set a value for all articles which match field criteria. This is useful when you already have existing
items and want to add a value to the old items. Note that it only applies value to items that do not already have an
associated custom value, so you don't have to worry about overwriting items you have already set.
Set active/inactive allows you to set the status of the custom filed. If the active status is set, the user can fill it in.
Edit allows you to edit the custom field. Note that you can also double-click anywhere in the line on the field to edit as
well.
Delete allows you to delete the field. If you attempt to delete a field that is being used you will get a warning message
telling you the field is being used and you will need to decide if you still wish to delete the field after that.

The Ranges tab
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The ranges are the valid values you can select from. For example, you may have a list of departments, or a checkbox that allows you
to denote whether extra information is required.

You can also re-use ranges. That list of departments might be a drop-down select box in your FAQ category, and a radio-button
select on the feedback form.

13. Add New here means add a new set of valid values.
14. Click on the Title to open the range set and add new values or edit existing ones, including re-order the fields.
15. Description is a description of the field range. When a user is adding a custom field, this is the text they see when they click

on the inline help.
16. Entries shows a total number of custom fields where the range is used.
17. The last column contains the [...] button which opens a menu with the following commands:

View Items takes you to the range, so that you can edit, update or re-sort the individual valid values
Edit allows you to rename the range and update the description
Delete deletes the range. If the range is being used by custom fields, you will not be able to delete it. Use Entries to
see which fields contain the range.

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete articles that you have created, then
there is no 'Delete' action in the list of options. If your privilege does not allow you to update items, or allows you to only update
items you have created, then this menu will not be available for you at all.
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Add a new custom field

To add a new custom field
Click on Tools ->  Custom Fields tab
Click on the Article, File or other tab
Click Add New
Choose your field type by clicking on one of the field types.
 
Categories
If you are adding the field to articles or files, you will then be taken to the Categories tab and prompted for a category. Add
any categories where the field is to be displayed. If you want the field displayed in all categories, leave this blank
 
Click Form Options tab
Add the name of the field to the Title field
Add a tooltip if required
Check Mandatory if you want to force the user to fill in this field
Check Active if the field is to be used immediately i.e. if you want the field to appear on the screen
 
Click on the Ranges tab
Click on Set Range
If you wish to use an existing range click Assign to assign the range
If you wish to create a new range,click Add New and [add the new range], then click Set Range to assign the range to the
custom field
 
Click on the Display Options tab
Use the drop-down Display field to choose where the field is to be displayed on the screen.
Note that when you enter the field as part of creating the article, it is always displayed under the article content. This display
field define where the text is displayed in the Public area
If you wish you can also add some text around the field by adding it to the HTML Template. For example if your custom field
is 'Department' and the value you input is 'Sales' then:
{title}: {value} - displays Department: Sales
Welcome to the {value} team - displays Welcome to the Sales team 
Note that this extra text is not displayed if you have chosen 'Hidden, not displayed in Public Area' as the display option
If you wish your visitors will be able to search in this field check Display in search checkbox 
 
Click Save to create the field.

Note:

If you have existing articles or files, then you will be given the option to add a default value to those items. If you wish to add a
default value, select the value and click Add Values.

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete articles that you have created, then
there is no 'Delete' action in the list of options. If your privilege does not allow you to update items, or allows you to only update
items you have created, then this menu will not be available for you at all.
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Add a new custom field range

What is a custom field range
A range is a list of valid values that you can use in your custom fields.  

Once you have set up a range you can re-use it as many times as you like.  For example, one time you might have it as a drop-down
option in an article category, another time you might include it as a radio button list in the news area.

Create the range 
Click on Settings menu
Select the Custom Fields page
Choose Ranges tab
Add New
Add an appropriate name to the Title field, for example, Department.
We recommend that you add an appropriate description as well.
Click Save.
This adds the field and sets up ready to add each of the values.  Then, for each valid value you wish to add:

Add the name of the value in the Title field
Add a number in the Order field to show where it will be placed in the list.  By default this is numbered sequentially in
the order that you add them
Save if you wish to add another valid value.

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete articles that you have created, then
there is no 'Delete' action in the list of options. If your privilege does not allow you to update items, or allows you to only update
items you have created, then this menu will not be available for you at all.
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Update values in a custom field range

To update values in a custom field range

Click on Settings menu
Choose Custom Fields tab
Choose Ranges tab
Click on the name of the range that you wish to edit

From here you can

Add new values to the range by
Click Add New
Add a Title
Click Save

Change the name of a valid value value by:
Click on the edit icon of the value you wish to change
Update the Title
Click Save

Delete existing values
Click on the delete icon of the value you wish to change
Click Save to confirm that you really do want to delete the value

Reorder the range
Click on the edit icon of the value you wish to change
Type the new order into the Order field
Click Save

You will need to do this for each valid value in the range, as the other values do not automatically re-order themselves.

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete articles that you have created, then
there is no 'Delete' action in the list of options. If your privilege does not allow you to update items, or allows you to only update
items you have created, then this menu will not be available for you at all.
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To see where a custom field is used

To see all items where a field is used
Click on Settings menu
Choose the Custom Fields tab
Click a tab with the entry type 
Click on [i] in the Entries column

To see where items with a specific valid value are used
This functionality works in a similar way for articles, files, news and feedback, even though the example given here is for articles.

Log on to the Admin area
Click on Articles (if field is under Articles, or Files, News or Feedback if field is under, respectively, files, news or feedback)
Click on the [+] button to the left of the category drop-down

This brings up a list of all custom fields for articles (or files/news/feedback)

Select the specific field and value that you are looking for
Click on Search.

This brings up a list of all articles with that particular custom field value.

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete articles that you have created, then
there is no 'Delete' action in the list of options. If your privilege does not allow you to update items, or allows you to only update
items you have created, then this menu will not be available for you at all.
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Search in custom fields

You can search for data in both the Public Area and in the Admin Area.

To search in the Public Area
Click on Advanced Search
Select a type (Article or Files)
Click Extra Options section which contains all the custom fields

To search in the Admin Area
Click on Articles (if field is under Articles, or Files, News or Feedback if field is under, respectively, files, news or feedback)
Click on the [+] button to the left of the search area

This brings up a list of all custom fields for articles (or files/news/feedback)

The list of custom fields display by default is custom fields that are included in all categories.  If you want custom fields that are
listed only in a specific category, select the category
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Once you have your list of custom fields

If necessary, choose a category.
Categories default to 'all' and will also search in sub-categories if you use the default options
Choose which field you wish to search on, and choose which data you wish to search for

If the field is a multi-choice field you will be presented with a list of drop-down values to select from
If the field is a checkbox, you will be able to check the value to choose items with that flag set
If the field is a text field, you will be able to type text into the field to search on

and so on.

Click Search to start the search.

This brings up a list of all articles with that particular custom field value.

Some working examples for search
Let's say you have a knowledgebase set up as follows:

Article Category Custom
field

Valid values for
custom field

Custom field defined
at category level

Value in
custom

field

Teach yourself
Photoshop Product Extras

DVD
T-shirt
Game

No DVD

Nerds Rule Product Extras
DVD
T-shirt
Game

No T-shirt

How to Make
Cards Product Extras

DVD
T-shirt
Game

No -

Our London
Office Branches Retail

shop
Yes
No Yes Yes

Our Paris Office Branches

Retail
shop

Yes
No Yes Yes

Extras
DVD
T-shirt
Game

No T-shirt

No valid value has been set for the article How to make cards. Also, Extras can be defined anywhere.

If you click on search without defining any further parameters this brings back a list of all articles which contain values in any
custom field, hence it would return:

Teach Yourself Photoshop
Nerds Rule
Our London Office
Our Paris Office

If you select T-shirt in the Extras custom field, and then click on search (still not having defined any further parameters, or
using All), this will bring back:

Nerds Rule
Our Paris Office

If you select T-shirt in the Extras custom field, and choose the Product category, this will bring back:
Nerds Rule

If you choose T-shirt in the Extras custom field, and Yes in the Retail Shop field, and search all levels, then your search will
return:

Nerds Rule
Our London Office
Our Paris Office

This last is because it will search for either field, rather than both fields.
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Bulk add or update custom fields

To bulk add or update custom fields, log on to the and Admin area and then:

1. If you are updating:

an article custom field, click on the Articles menu
a file custom field, click on the Files menu
a news custom field, click on the News menu
a feedback custom field, click on the Feedback menu

2. By default, the listing displays all custom fields that are not assigned for specfic categories.
To see fields assigned to a specific category, select the category you wish to search on.  This displays all custom fields for the
category, plus any custom fields that are not assigned to a specific category.

3. Select the items whose custom fields you wish to update.
4. Choose Set custom fields from the Actions with selected drop-down.

This brings up a second drop-down box for you to select from.

5. If you wish to:
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Remove any custom fields set:

Choose remove all custom fields from the second drop-down box
Click OK

Update a single custom field:

Choose the custom field from the second drop-down box
This brings up the fields associated with the category beneath the drop-down
If the field is not currently associated with the item(s), this brings up a check-box add to existing
If you wish to add the field to the selected items, check this box
Update the field as required
Click OK to save the change

Update all the custom fields at the one time:

Choose set all custom fields  from the second drop-down box
This brings up the fields associated with the category beneath the drop-down
Update fields as required
Click OK to save the changes.
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Lists
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The Lists Tab Explained

The Lists tab under the Tools menu allows you to:

Manage article statuses
Manage file statuses
Control article types
Manage user statues
Manage feedback subjects
Manage rating comments statuses

Article and file statuses
KBPublisher has three default article and file statuses: Published, Not published and Outdated.

Use the Lists tab to add new statuses and modify existing ones. You control:

The name of the status
The color denoting that status
Description
Where the status appears in the list of statuses
Whether the status is active
Whether or not this status is published (which means users can see it),

Add new article status tells you how to add a new status for an article.

Article types
Article types are used to group records for searching, to provide default template for the articles and to control the display of the
type.
Add new article type explains how to create new article types.

User statuses
KBPublisher has four default user statuses: Active, Pending (approval required), Not active / Suspended and Unconfirmed.

Use the Lists tab to create new user statuses and modify existing ones. You control:

The name of the status
The color denoting that status
Description
Where the status appears in the list of user statuses
Whether the status is active.

Feedback subjects
There is an option on the Ask a Question screen that allows the user to specify a feedback subject from a drop-down list. You define
these feedback subjects on the Lists tab. You control:

The title, which is what the user picks from the feedback subject list
Description
Who gets the feedback question (i.e. the specified supervisor)
Color associated with this feedback subject
Order it appears in the list
Whether the feedback subject is active.

Article feedback status
Rating comments have four intially-defined statuses: New, Ignore, In progress and Processed.  You control:

The name of the status
The color denoting that status
Description
Where the status appears in the list of statuses
Whether the status is active.

User Manual v7.5 284

https://www.kbpublisher.com/kb/entry/138/
https://www.kbpublisher.com/kb/entry/140/
https://www.kbpublisher.com/kb/entry/67/


Automations
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Automations

Use automations (automated tasks) to check your content regularly and perform certain actions as needed. You can make sure your
articles are up to date, and alert staff to review them when they are not. You can let authors know when articles have been
approved for publication, or let managers know when articles are ready for review.

To access your automations, select Tools from the menu bar. Then select the Automations sub-tab.

Essential facts for automations
Automations are time-based: they act when a time-based event occurs, such as the time since an article was edited exceeding
a specified maximum time.
Automations run daily, at midnight.
An automation must contain a condition that is true only once, or an action that nullifies at least one of the conditions;
otherwise, the automation will run daily, possibly sending unwanted duplicate alerts every time it runs.
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Manage Automations

To access your automations, select Tools from the menu bar. Then select the Automations sub-tab:

The tab displays both your active and inactive automations for either articles or files. Switch between the Articles and Files tabs to
see all existing automations. If the list is long, enter a keyword in the Filter field to display just the automations that have that
keyword in their titles. To restore the full list, remove all text from the Filter field.

For each automation, you can click the button in the Action column and select an action to perform:

Change status - Select to change the status of the automation from active to inactive, or  from inactive to active. A
confirmation message appears to make sure you want to change this status.
Duplicate - Make a copy of the automation that you can then edit. This helps you quickly create automations that are similar
to existing ones.
Edit - Edit the automation. See Creating or editing an automation.
Delete - Select to delete the automation. A confirmation message appears to confirm you want to do this.

Add an Automation
To create a new automation, click Add new. See Creating or editing an automation.

Reorder
To change the display and execution order of the automations:

Click the button with three dots [...] in the top right corner.
Choose Reorder from the popup menu.
Rearrange the articles by dragging and dropping them in the results list.
Click Save.
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Creating or editing an automation (automated task)

To create a new automation (automated task), click Tools -> Automations tab make sure you are on the sub-tab the automation
will be for: Articles, Files, or Incoming Mail. Then click Add new. See the information below about completing the form that
appears.

When you create a new automation, or update an existing one, you see the same form:

Complete the form in the following manner:

Title - Required. Provide a descriptive title for this automation. It should not be the same as the title of an existing
automation.
Conditions - You must have at least one condition that the automation checks each time it runs. You can have multiple
conditions. Set the automation to perform its actions if any or all of the conditions are true. Add a condition by clicking
the + button; remove a condition by clicking its - button.
Actions - If the automation finds that the conditions in the previous field are met, it performs the actions you set here. You
can have multiple actions. Add an action by clicking the + button; remove an action by clicking its - button.
Each action will either set status or send emails to one or more recipients.

​Set status - If you choose this action, in the next field specify the new status for the article or file from the list of
options shown above.
Email - you can choose to send an email to yourself or another user, or to a user group. You can opt to send one email
for each item that matches the conditions, or to bundle all the notices into a single email.
You need to prepare the email template in the fields that appear:

Title - Provide a title for the email.
Body - Provide the body of the email. You can use template tags to customize the email: for instance, if you want
to include the title of the article in the email, you could write "This is an alert about the article [article.title]." When
the automation needs to send the email, it replaces the template tag with the appropriate information.
To see the template tags that are available, click Show template tags .
To check that the email looks as it should, click Test template to see a preview. 

Active - Select to activate this automation. It will run daily until deactivated.

Click Save to save the automation. Click Cancel to abandon your edits and close the form.

Important: 
An active automation will run daily. Make sure that, when the automation finds an article or file that meets its conditions, one of the
actions invalidates for that item one of the conditions of the automation.
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Incoming email automation (automated task)

Incoming email automation allows you to parse your email box and create articles, drafts, or news from emails.

Create or update an automation
To create a new automation for incoming email, click Tools -> Automations -> Incoming Mail  tab, then click the + (Add new)
icon.
To update an existing automation, click Tools -> Automations -> Incoming Mail  tab, click the [...] icon on the right and choose
Edit from the dropdown menu.

Complete the form in the following manner:

Title - Provide a descriptive title for this automation. It should not be the same as the title of an existing automation.
Email Box - Choose or set up a new email box to be parsed.
Conditions - You must have at least one condition that the automation checks each time it runs. You can have multiple
conditions. Set the automation to perform its actions if any or all of the conditions are true. Add a condition by clicking the
+ button. Remove a condition by clicking its - button.
Actions - If the automation finds that the conditions in the previous field are met, it performs the actions you set here. You
can have multiple actions. Add an action by clicking the + button. Remove an action by clicking its - button.

​Create Article Draft  - If you choose this action, an article draft will be created. You also can specify whether to send
for approval or not by checking "Send for approval" checkbox.
Create Article - If you choose this action, an article will be created.
Create News - If you choose this action, a news will be created.
Stop Evaluating Tasks  - Mail stops applying rules to a message when it encounters the Stop Evaluating Tasks action.

Active - Select to activate this automation. It will run daily until deactivated.

Click Save to save the automation. Click Cancel to abandon your edits and close the form.

Important: An active automation will run daily.

Create or update an Email Box
To create a new Email Box or update an existing one, you first must navigate to the Email Box list. Click Tools -> Automations ->
Incoming Mail tab, then click [...] icon on the right and choose Email Boxes. A list of all available email boxes will appear.

To create new box, click the + button in the top right corner and fill the form.
To update an existing box click [...] in the list and choose Edit from dropdown menu.

Complete the form in the following manner:

Title - Provide a title for the Email Box.
Hostname - Provide a host name.
Port - Provide a port. The default IMAP port is 143, or 993 when SSL/TLS is enabled.
SSL - Check this checkbox to use SSL.
Mailbox - Provide a mailbox name. The default is INBOX.
User - Provide a username.
Password - Provide a password.
Max message count - This is the maximum number of messages to process in one task. If this number is exceeded, the
mailbox will be skipped.

Click Save to save the Email Box. Click Cancel to abandon your edits and close the form.
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Incoming email - Stop Evaluating Tasks

Mail stops applying rules to a message when it encounters the Stop Evaluating Tasks action.

Tasks ordering and 'Stop Evaluating Tasks' actually server a purpose when you're working with complex tasks. For example, lets say
you want to skip all tasks for auto-generated emails.
You need to create a "Stop Evaluating Tasks" tasks to make this happen.

In the below example "Create news" never trigerred if email is auto-genearetd email.
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Workflows
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Workflows

Workflows automate processes for reviewing, approving, and publishing articles. This can save you time and make sure articles that
may be ready to publish, but need approval, are not overlooked. If the item requires review and approval before it is published, a
workflow can transfer the item to the worklist of the person who is responsible for approving it. That person can approve the article
or send it back for further edits.

Workflow Flowchart
The image below shows the path the draft of an article or file might have to follow if, after the author has written or uploaded it, one
or more people have to review and approve it before publication.

Essential facts for workflows
Workflows are applied to drafts of articles and files only 
You cannot delete or edit a workflow which in use (is applied to some drafts).
You can have as many approval steps in a workflow as your project's process requires.
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Manage Workflows

To access your workflows, select Tools from the menu bar. Then select the Workflows sub-tab: 

The tab displays both your active and inactive workflows for either articles or files. Switch between the Articles and Files tabs to
see all existing workflows. If the list is long, enter a keyword in the Filter field to display just the workflows that have that keyword
in their titles. To restore the full list, remove all text from the Filter field.

For each workflow, you can click the button in the Action column and select an action to perform:

Set Active/Inactive - Select to change the status of the workflow from active to inactive, or from inactive to active. A
confirmation message appears to make sure you want to change this status.
Duplicate - Make a copy of the workflow that you can then edit. This helps you quickly create workflows that are similar to
existing ones.
Edit - Edit the workflow. See Creating or editing a workflow.
Delete - Select to delete the workflow. A confirmation message appears to confirm you want to do this. 

Note: You cannot delete a workflow that is in use. Updates are limited while some drafts it relates to are being approved.

Add a Workflow
To add a workflow, click Add new and complete the form. See Creating or editing a workflow.

Reorder
To change the display order of the workflows, click the [...] icon and choose Reorder from dropdown menu.
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Creating or editing a workflow

To locate your workflows, select Tools from the menu bar and then select the Workflows tab. 

You can create your own workflow from scratch, or copy an existing workflow and adapt it to your needs. You can create or edit a
workflow for either articles or files.

To create a new workflow, click Add new to open the Workflow form.
To edit a workflow, click the actions icon in the workflow's row and select Edit.
To make a copy you can adapt, click the actions icon in the workflow's row and select Copy.

The workflow form appears, with blank fields if it is for a new workflow and with the existing information if you are editing or copying
an existing workflow.

Note: you can't edit an active workflow. First change the workflow's status to "inactive" and then open it for editing. When you have
completed the edits, you can change the status back to "active".

Complete the fields in the form:

Title -- Provide a unique, distinctive title for this workflow.
Conditions -- Add one or more conditions that the workflow evaluates each time it runs. You can set the workflow to take
action if any of the conditions are true, or if all conditions are true. In the example above the workflow conditions apply to
articles that have been published and where the author's privilege level is greater than "author" (the author is also an editor,
for example).

To add conditions, click the [+] button to the right of the field.
Each condition can apply to one of these:

Whether the draft is published or not.
The author's privilege level.
The author's identity.

Steps -- Provide one or more steps for the workflow to take if the Conditions section evaluates to true.
Add steps by clicking the [+] button to the right of the field.
For each step, provide:

A title for the step.
The action to take (like "assign" the article or file).
Where relevant, the person or role to assign the article or file to. Select from the options provided.

Optional Approval -- Select the checkbox to allow users to pypass the approval process in the workflow.
Active -- By default, each workflow is set as active. To deactivate it, uncheck this check box. The workflow appears in the
Inactive workflows list.

Click Save to save the workflow and add it to the active or inactive list.
Click Cancel to abandon your edit and close the form.
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Workflow examples

Here are some examples of how to use workflows for drafts of material that need review and approval before publication.

Simple, one-step approval 
When you have users with the "contributor" privilege adding a drafts, use a workflow like this to alert the category supervisor when
draft content is ready for review.

The workflow checks for draft content that has been submitted for review by a "contributor" user and assigns such content to the
appropriate supervisor. If the category has no supervisor assigned, KBPublisher parses the category tree to find the appropriate
supervisor. If no category supervisor can be found, the system sends a message about the draft to the email address defined in
Settings > Email > Admin Email .

You should assign a supervisor at least for each top category (the same supervisor can be responsible for multiple categories).
See Can I route an Approval email based on the category? for information about assigning category supervisors.
 

Assign to a specific approver
When you want a specific staff member to review draft submitted for publication, use a workflow like this that identifies the specific
user:

When a user with the "author" or "moderator" privilege adds a draft, the draft will be assigned for review to the person specified. In
the example above, the person is the current logged-in user; but you can assign any user to review the material.
 

Multiple-step approval 
If your workflow requires multiple approval steps before draft material is published, use a workflow like this one:
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In this example, when a contributor creates a new draft, the draft will be assigned for review to a user with "editor" privileges. When
the editor has approved the material for publication, the draft is assigned to a user with "moderator" privileges for final review and
approval. When the moderator has approved the material, it is published.

You can add as many approval steps as your project's process requires.

As with the first example, if KBPublisher cannot find a user with "editor" or "moderator" privileges, it sends a message about the
draft material to the email address defined in Settings > Email > Admin Email .
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Settings
An explanation of the Settings module and how it works
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The Admin Tab Explained

The Admin tab is the first tab under Settings. The fields on this tab control KBPublisher's configuration. Only administrators can
change the settings on this tab.

You can reduce the number of fields displayed by typing key words into the Filter field, making it easier to find the fields you want.
Restore the display by removing any entries from this field.

Click Save to save your edits; click Set Defaults to restore the original values for all fields.

International
Language - Select the language for field labels and other onscreen texts for your KBPublisher.

Date & Time
​Time zone  - Select the time zone to use. If your team is distributed across many time zones, the time zone you select may not
be the one for the area where you live, but rather the one where the majority of your team lives and works.

Security / Privacy
Session expires (in minutes)  - Controls how long before the user is automatically logged out when they are not actively
using the system. If you wish to turn automatic logout off, set this to 0. 
Allow automatic sign-in  - If enabled, users do not need to re-enter their username and password when returning to the site.
Note: This option requires that the site be configured for SSL.
Enable visual confirmation to login  - Controls whether a user has to pass a CAPTCHA test, typing the test displayed in an
image, in order to log in. The displayed image looks like this:

Enable visual confirmation to reset password  - Controls whether a user has to pass a CAPTCHA test, as described above,
in order to reset the account password.
Password Rotation Frequency - Defines how frequently password changes are required. Available options are: Off, 90 days,
180 days, and 1 year.
Password Rotation Policy  - Available options are: Advisable and Mandatory.
Advisable - On login, notify the user that a password change is recommended.
Mandatory - Require a password change before the user can continue.
Password Rotation Previous Passwords - Set if user is allowed to re-use previous passwords.
Old password required to change password  - Select to require the user to provide their current password as well as the
new password they want to change to.
Allow login with email  - If checked, user can use his email as Username on login.
Use 'Email' for 'Username' - If checked, email will be used as the Username.

API
Enable API access - Select to allow users access to the KBPublisher API.
Secure API connection - Select to require a secure API connection (the URL starts with https:// instead of http://).

Look & Feel
Box width - Required. Set the width of the frame for the administrator's screen in pixels, like 980px, or as a percentage of the
user's screen, like 90%.
Number of records per page  - Set the number of records displayed per page when a user first goes to that page. The user
can temporarily change the setting while on the page.
Sort articles by  - Specify the initial sort order for articles, which the user can change temporarily when working with a list of
articles. The options are:

Title (sorted alphabetically)
Date added (newest first)
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Date added (oldest first)
Date modified (newest first)
Date modified (oldest first)

Sort files by  - Specify the initial sort order for files, which the user can change temporarily when working with a list of files.
The options are the same as for the previous field.

HTML Editor
HTML editor file directory  - Required. Provide the location for images you use in articles or files that you link to.
KBPublisher uses this location when you perform actions like insert a picture into an article.

Scheduled Tasks
Send critical messages to admin  - Select to send the administrator an email alert of critical errors in scheduled tasks so
the administrator can respond quickly. Define the email address to receive these messages in the Email settings tab.

Tags
​Allow to create tags  - Select to let users create custom tags when adding a record. If this is not selected, users can only
choose from among the existing tags.

Article
Maximum number of revisions  - Specify how many past versions of a document are stored. If you set this to 5, then when
the document is changed and saved the sixth time and after, the oldest revision is deleted so only the five most recent
versions are retained. If you don't want to keep article history at all, set this to 0.
Autosave recovery information every  - Specify in minutes how often KBPublisher should automatically save an article a
user is editing. To turn autosave off, set this to 0.
Default category - If you select a category for this field, all new articles will by default be part of that category. Select None
to disable this option.

Files
Files directory - Required. Set the location where files are uploaded to, in this server path format.
Max file size - Set the maximum file size, in kb, that users can upload (1024 kb = 1 mb). The maximum you can set depends
on your php settings: see Handling file uploads.
Allowed extensions - You can specify the file types that can be uploaded, separated by commas, such as "txt,png,doc,docx".
Note: if you enter anything in this field, KBPublisher ignores any entry in the following field.
Denied extensions - Specify types of files that cannot be uploaded, separated by commas, such as "php,exe,asp,cfm".
Extract raw text  - Select to have KBPublisher try to extract the text from PDFs and similar files so it can include the content
of the files when the user does a search.
XPDF installation path  - XPDF extracts content from PDF files to make that content searchable. If you have XPDF installed,
provide the relative path to it in the form "/user/bin/". To disable this option, enter "off". 
Catdoc installation path - Catdoc extracts content from .doc files to make that content searchable. If you have Catdoc
installed, provide the relative path to it in the form "/user/bin/". To disable this option, enter "off". Note: You can use either
Catdoc or Antiword (below). You don't have to use both.
Antiword installation path - Antiword extracts content from .doc files to make that content searchable. If you have Antiword
installed, provide the relative path to it in the form "/user/bin/". To disable this option, enter "off".
Default category - If you select a category for this field, all new files will by default be part of that category. Select None to
disable this option.
Spy Directory missing files policy - Select what the auto-load directory files functionality should do when it finds a file
listed in the database that is no longer on the server.
Allowed directories for local files  - List allowed directories for adding local files. If empty, any directory is allowed.
Allow access to Amazon S3 - Specify Amazon S3 credentials to link S3 files to your KB.
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The Public Area Tab Explained

The Public Area tab is the second tab under the Settings menu. The settings here apply to the public view -- that is, to what users
see.

Only an administrator can change the settings on this page. The page is divided into four further tabs:

Common, for settings which are common to the whole knowledgebase
Articles, for settings which are specific to articles
Files, for settings which are specific to files.
Page Design is to design pages in Public Area. 
 

Common
Titles/Meta/Navigation

Site title (meta) - set the meta title of the knowledgebase.
Site keywords (meta) - set the meta keywords of the knowledgebase. 
Site description (meta)  - set the meta description of the knowledgebase.  
Header title - the text displayed in the header.
Navigation title - the home page in the navigation bar.
Display entry title in navigation -  show or hide the article title in the breadcrumb trail.
Extra items in navigation  - manage extra links in the breadcrumb trail
Site modules / Menu items - manage main KB navigation and sections, sort menus, add extra items.

 
Search engine friendly URL  - controls what you type into the address line when you want to jump direct to an item in the
knowledgebase.      

Security/Privacy/Registering
Access for registered only  - only people who are registered users can view the knowledgebase.
Allow registration - whether registration allowed or not.
Agree terms - if checked defined terms section will appear under registration form and users must agree to these terms to
complete their registration.
Approval required for registration  - whether approval required for new registered users.
Privilege for new registered users  - this privilege will be set for all users registered through registration form.
Role for new registered users  - this role will be set for all users registered through registration form.
Enable visual confirmation to register means the user has to type in a confirmation code before they can register. This is
to stop scamming.
Login policy determines whether a user gets a login option on the public view screen, whether they don't get the login option
but can still login (if they know the link to the login page), or whether they cannot login at all.
Private policy  - controls whether content that is locked because it is private is displayed in the menu with a locked symbol,
or whether it is simply not visible at all. When this is set to Do not display entries  then the user only sees items he can
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access. When it is set to Display entries as 'locked' sign , then the user can see the entries title but he cannot read them.
Cookie consent banner - if set  a cookie consent banner will be displayed. The banner will be hidden when the user agrees
to it.

Look and feel
Page template - customize your KB to match your style. Click [...] to add custom header, footer, JavaScript and set colors for
elements.
View format - allows you to set your knowledgebase up with a left menu or without.
Left menu type - can be a standard menu tree, or it can be a follow-on menu that allows users to click on one article after
another to read them.
Header - whether to display or not  the header. If you uncheck, then the Header title (specified in section 1, above) and
Header logo are not be displayed.
Header logo - upload a logo to be added to the header section.
Content width - controls page content width.

Setting up the look and feel is covered in more detail in the article that explains how to change the way articles are displayed.

Feedback
Allow contact us - set whether users can contact you using the Feedback facility through. You can set this so that all users
can contact you, only registered users can contact you, or no users can.
Enable visual confirmation - controls whether a user has to pass a CAPTCHA test, typing the test displayed in an image, in
order to add a feedback.
Enable quick response - turns off the automatic searching and turns the form into a static feedback form. i.e. users
type their message into the form and email it to the supervisor, but KBPublisher doesn't do the search.
Allow attachments - says whether users can attach documents to their mail. The value here is the number of files that can
be attached. When this is set to 0, attachments cannot be included.
Allowed extensions - controls the type of files that can be attached.
Send attachments with e-mail - must be set if a user is allowed to send attachments in the Feedback form.

Sharing
Allow social sharing - whether to allow visitors to share content on social networking sites.
Social networking sites - click [...] to manage Social Sites.
Allow email sharing - whether to allow visitors to share articles via email.

Tags 
Display tags - whether to display tags for articles, files, news, etc. If set tot ON, tags will be displayed below an article.

Search
By default search in  - defines whether the initial search searches the whole knowledgebase, only in articles, or only in files.
Search preview character limit - how many characters display in search results.
Search by article ID  - defines search behavior when user types a number in the search field. You can disallow searching by
article ID or allow it and choose between two options: search in content first or search by ID first. Defaults to "Search in
content first then by ID"
Search suggest - whether to offer suggestions when the user types in the search field. It suggests most popular
searches based on other searches.
Search spelling suggest - whether to suggest spelling when the user types in the search field.

Subscription
This section allows to set up subscription options. How often send subscription email, when send,  allowed or not, etc.

RSS settings
Set RSS channel details.
 

Articles
Look and feel

Number of articles per page  - how many articles display per page.
Sort articles by  - how to sort articles.
Featured articles in a category  - how many featured articles display per category. If it is set to 0, featured articles are not
shown.
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Display "Also listed in" - whether to show or not other categories this article is published in, displayed below article.
Others in this category  - controls whether or not the 'Others in this category' sub-heading is displayed at the bottom of the
screen, and how many items are displayed if it is.
Display Prev / Next navigation  - controls whether the user sees links to the next article and previous article at the bottom
of the screen.
Category columns - defines how how many columns the categories are displayed in on the page in public view. If this is set
to 0, no categories are displayed.
Article title prefix pattern  - you can add text to the front of an article heading using this setting. For example, if your article
is named Keeping Pets, you can use the article title prefix pattern to make this: Question: Keeping Pets. Even better, if you use
types in your knowledgebase, you can customize the article prefix to each type. Suppose, for example, you have two types of
articles. One is Facts, the other is General info. If you wish you can change the title to include the type. e.g. Fact: Climate
change is happening and General info: What are greenhouse gases?.
You can include the article number as part of the article title prefix as well. e.g. Q: What can I do to help?
Entry ID padding - if you choose to include the article number in an article title prefix, you can also say how many digits the
number will have by specifying number here. For example, if you had 100 questions and chose an article title prefix of 'Q', by
default they would be numbered Q1...Q100.  If you would prefer it to be Q001: .. Q100 set the entry ID padding to 3.
Display Article ID  - whether to display article ID and date updated below article title.

Table of contents
Generate TOC - Whether or not to generate a table of contents (TOC). If checked, TOC will be generated at the top of an
article.
TOC tags - The list of heading tags to use to generate the table of contents. Example: h1,h2
Minimum article characters - Specify number of article characters. If the number of characters in an article is less than this
limit, a TOC will not be generated.
Minimum tags - Specify number of tags. If the number of headings is less than this limit, a TOC will not be generated.

Comments
This section allows to set up article comments settings. How many comments per page,  if approval required, etc.

Rating
Allow rate articles  - lets the user rate articles in your knowledgebase.
Rating type - Ratings can be text, helpful/not helpful, or you can use a star system where the user rates the article out of five
stars.

Feedback
Allow feedbacks - Enable this option to allow visitors to send article feedback such as rating comments, reporting article
issues, etc.

Article preview format
Article Character Limit - number of characters displayed in the preview.
Display updated date - whether the last date the article was updated is shown. 
You can also specify whether to display the rating, number of comments  and number of views .

Article information block
Block Position - where to display information block.
Display article block  - displays the article ID and when the article was last updated.
Display private block - shows whether the article is public or private. If an article is private, a user can hover his/her mouse
over the key graphic to see which roles have access.
Display author block - displays the date an article was created and the name of the author. If the article has been updated
since, it also displays the name of the person who last updated it and when that was. The format of the author/updater's name
is controlled by the user format for author block .
You can also choose to include whether or not to display the number times this article has been viewed and commented.
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Article actions block
Block Position - where to display actions block.
Float Panel - manage article actions items.
You also can define whether to display each of the following actions:

Print
Save (saves an article to user's favorite list )
Pin
Export to PDF
 

Files
Look & Feel

Number of entries per page  - how many files display per page.
Sort files by  - how to sort files. 
Category columns - defines how how many columns the categories are displayed in on the page in public view. If this is set
to 0, no categories are displayed.

File preview format
Display number of downloads  -  controls whether users see how many times the file has been downloaded.
 

Page Design
This section controls page layouts. It is available for Index and Downloads pages. You can manage block position, add custom
blocks, and create different grids.
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The Email Tab Explained

The Email tab under the Settings controls who receives administration emails, and how the email is set up.

1. The Support Email sections allows you to define system emails.

Support mailer is the special email header
Support Email is the email address, or addresses, where the administration emails are sent. Feedback emails are sent to this
address. You can enter more than one email address. Separate each email address with a comma.
Support Name is the name the user sees when they receive an email from KBPublisher. For example, if you reply to a
feedback question, this is the name that will be shown in the reply field
The No Reply Email is the email address that sends automated information such as subscription alerts, password enquiries
and so on
The person or persons assigned in the Admin Email receive system notifications, warning messages and other messages that
impact the running of your knowledgebase.

2. The Email settings are where you set up the mail system.

The mailer is the system you are using to send the emails.
This defaults to the PHP mail function unless you change it.
The other items here are specific to the SMTP mailer, and should only be filled in if you have specified SMTP as the
mailer.
Sendmail defines the location of sendmail files. Sendmail is a UNIX based mail application. You would not normally
change this.

3. The Mass mailer controls how many emails, such as subscriptions, are sent by the background task scheduling system.

Email limit per hour controls how many emails are sent per hour.
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The Export tab explained

Under Settings > Plugins, the Export tab allows you to enable and configure the Export plugin, which is available as an add-on to
enhance KBPublisher functionality. To use the Export plugin, you need to purchase a plugin key, which is sold separately. For
KBPublisher Cloud users, select a plan that includes the Export plugin.

Export Plugin
Plugin key - Enter your plugin key here. To see how the system works, type 'demo'. Note that demo documents have a 'trial'
watermark on each page and are limited in quantity.
Allow category exporting  - If allowed, users can export whole categories to PDF. Available options are: Not allowed, Allowed
for all, Allowed for registered users only, and Allowed for staff only.
Print article block in PDF  - Select this option to include the block of article information in the exported PDF. It works when
you export single article in Public Area. 
Font - Select the default font for document text. Available options are: Arial, Courier, Helvetica, Monospace, Sans Mono, Sans,
Serif, and Times.
Font size - Enter the default font size, in points.

WKHTMLTOPDF
WKHTMLTOPDF is preferred over HTMLDOC. Third-party tools, such as WKHTMLTOPDF, are already installed and available for
KBPublisher Cloud users.

WKHTMLTOPDF installation path - To produce PDFs, you need to install a program called WKHTMLTOPDF. Turn this feature
off by entering 'off', or specify a path where this program is installed. For example: /usr/bin/
Cover template - Click the ellipsis to view, edit, enable, or disable the cover page template. When enabled, the cover
template adds cover page to the resulting PDF when you export a category.
Header template - Click the ellipsis to view, edit, enable, or disable the header template. When enabled, the header
template adds a header to all PDF-generated pages.
Footer template - Click the ellipsis to view, edit, enable, or disable the footer template. When enabled, the footer template
adds a footer to all PDF-generated pages.

The checkboxes indicates whether or not each template is enabled. Please note these template options only work if you use
WKHTMLTOPDF.

HTMLDOC
HTMLDOC installation path  - To produce PDFs and HTML pages, you need to install a program called HTMLDOC. Turn this
feature off by entering 'off', or specify a path where this program is installed. For example: /usr/bin/
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The License tab explained

The license tab provides details of your KBPublisher customer number, the type of license you purchased and when you purchased it.

When you purchase from KBPublisher your license key and software downloads are made available under the My Licenses tab in the
Client Area on the KBPublisher site.  After you install KBPublisher, copy the license key provided in the Client Area here.
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How to enable Sphinx Search

Sphinx is a full-text search engine that provides fast and relevant full-text search functionality. 
Key Sphinx features are:

high indexing and searching performance;
advanced indexing and querying tools (flexible and feature-rich text tokenizer, querying language, several different ranking
modes, etc.);
proven scalability up to billions of documents, terabytes of data, and thousands of queries per second.
 

Steps to enable Sphinx Search
Download and install Sphinx on your machine, supported version is Sphinx 2.2.11 - 2.3.2, 3.1 - 3.3
Go to KBPublisher Admin Area
Click Settings -> Plugins -> Sphinx Search tab
Check Enable Sphinx Search checkbox
Click Save
 

Sphinx Settings 
Enable Sphinx Search - On, or Off Sphinx (if Sphinx is Off - search is performed by MySQL full text)
Test Mode - if you wish to test Sphinx, you can firstly set it in a test mode. Sphinx search will be activated only by putting
'sphinx:' in front of your query, e.g. sphinx:banana
Host - Sphinx daemon host (default is 127.0.0.1)
Port - Sphinx daemon port (any free port, default is 9306)
Bin path  - a directory where Sphinx is installed. You can leave it empty, but if your system does not recognize Sphinx
command without path than - you should fill it, e.g. /usr/local/bin/
Data path  - a directory where all Sphinx related files will be stored. Defaults to KBP cache directory, but you can change it. It
should be writable by Scheduled Task (cron) user.
Version - a version number of Sphinx which you use on the computer.
Languages - set it to your language, if you have documents in another languages, select the available from the drop down
list.  
 

Essential facts for Sphinx Search
All Sphinx tasks are executed by frequently scheduled task (cron)
Search index is updated every 5 minutes
 

Sphinx Search Logs 
You can monitor how Sphinx works, what tasks are executed, what is indexed, what is added to index, etc. in Logs -> Sphinx
tab
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Search engine friendly URLs

What is a search engine friendly URL?
KBPublisher records are stored in a database. When you wish to read an article, KBPublisher sends a request to the database to get
this record for you. This request is usually sent as a query string, and in its native form it looks something like:

http://yoursitename.com/kb/index.php?view=entry&entryID=90.

This works well to get the record back, but most search engines, Google excepted, will not index pages with question marks (?) or
ampersands (&) in the name.

To get around this, we use a search engine friendly URL . This converts the query to something more like:

1. http://yoursitename.com/kb/entry/90
2. http://yoursitename.com/kb/Search-engine-friendly-URLs_90.html

which contains only characters that search engines recognize, and therefore will the record will be found by the search engine.

Not only that, when sending a link to someone else, it makes a lot more sense, and is a lot less error prone, to send a link
http://yoursitename.com/kb/entry/90 than to send http://yoursitename/kb/index.php?view=entry&entryID=90.

How do I set up a search engine friendly URL?
Log onto KBPublisher as an administrator
Choose the Settings menu
Click on the Public Area -> Common tab
Go to the Titles / Meta  section and choose an appropriate option from the Search Engine Friendly URL  drop down list.

You have four options:

Automatic uses the default set up when KBPublisher was installed
Type 1: kb/entry/[article_id] gives the friendly URL - http://yoursitename.com/kb/entry/90
Type 2: kb/entry/[article_title]_[article_id].html gives the friendly URL - http://yoursitename.com/kb/Search-engine-
friendly-URLs_90.html
Do not use search engine friendly URL means exactly what it says.
Your link to the article mentioned above would be http://yoursitename.com/kb/index.php?
view=entry&entryID=90

Note:

"Search Engine Friendly URL" works on Apache web server with mod_rewrite enabled.
On IIS you can set it up with IIS ModRewrite or similar tools.  
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Look and feel

Change the design
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Customizing Public Area

KBPublisher can be extensively customized and you can get some spectacular results if you want to design your own site.

The default format of the KBPublisher Public Area is:

1. The standard header is controlled by the Header field.
Settings -> Public Area -> Common -> Header

You can:

Include the header by checking the Header field
Remove the Header by un-checking this field

If no header is assigned, a header is controlled by the Header title field.
Settings -> Public Area -> Common -> Header title

2. Likewise, the left menu is standard. The menu is controlled by the View Format field which is under Look & Feel.
Settings -> Public Area -> Common -> View Format

The menu choices are either Browseable, Left Menu or Intranet. 

3. Directly under the header are menu options and a breadcrumb trail.

The menu options, which are extra links that can be included in the menu, are displayed first. For example, you might
want to include a "Home" link if the knowledgebase is part of a larger site.

The menus are controlled by the Extra links in navigation  field.
Settings -> Public Area -> Common -> Extra items in navigation 

To include extra links, click the [...] button and you can manage extra links.
The breadcrumb trail is displayed after any extra links. It reflects the article you are currently viewing in the
knowledgebase.

4. Site modules/Menu items.

The menu options are extra links in navigation menu.

The menus are controlled by the Site modules/Menu items  field.
Settings -> Public Area -> Common -> Site modules/Menu items

To manage menu items, click [...].

5. This area will change depending on "Page Design" settings.
Settings -> Public Area -> Page Design.

In the "Page Design" section you can manage built-in blocks, add custom blocks, and organize blocks on the grid.
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Customising page layouts

Page Design settings allows you to customize page layouts for home and download pages. You can move blocks, resize blocks, and
add custom blocks to create your preferred layout.

To set up your own page layouts go to Settings -> Public Area -> Page Design  tab and click the page you want to update.

Updating Page Layout
To move a block, drag from the middle of the block.
To resize a block, drag from the border of the block.
To add a new block to the existing layout, click [+] on the right. In the popup, click on the block and it will be added to the
layout.
To remove a block from the layout, click  on the right in the block.
To cancel your changes, click Reset.
To reset the layout to its default state, click Set Defaults.
Page Header and Menu blocks cannot be moved, resized, or removed from the page layout.

Update Block 
To update a block's properties, click  on the right in the block. Depending on the block, properties can include the title,
number of items, or custom content.

Custom Blocks
Custom blocks allow you to include any content. For example, you could include ads or announcements.
To add a custom block:

Click [+] on the right.
Click Add a custom block .
Add content, and then click Save.
Click on the block and it will be added to the layout.

Title is optional for custom blocks.
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Customizing article display options

You can customize how and where articles are displayed in the Settings > Public Area > Articles  tab.

Look & Feel
In this area you can specify

Number of articles per page  - Set how many articles appear per page. If there are more articles than the number you set,
KBPublisher provides navigation so the reader can move from page to page of the display.
Sort articles by  - Choose an option for the default order by which articles are sorted.
Featured articles in a category  -  Set how many "featured articles" appear for each category. Set the field to 0 to remove
this feature.
Display 'Also listed in'  - Set to yes to show a list of other categories in which the article is listed. Set to no to disable this
feature.
Others in this category  - Set how many links to other articles in this article's category to display when the user is reading
the article. Set to "None" to disable the feature.
Display Prev / Next navigation  - Set whether and in what conditions you want to display previous / next navigation for
articles in this article's category.
Category columns - Set how many columns to use to display the articles in a category.
Article ID zero padding  - If you use an article title prefix (see the next field) you can set here the number of zeros with
which to pad a short ID. If you set the padding number to 3, for example, and you have and article with ID 1000  ID 1 will show
up as 0001 to provide a display that is easier to read.
Article title prefix pattern  - You can opt to prefix each article title with a pattern that can include the article's ID. For
example, presume your article with ID 1 has the title "Welcome to our knowledgebase":

'Q{$entry_id}:' would cause the article to appear in the list as "Q1: Welcome to our knowledgebase".
'Q{$entry_id}:' | Q{$entry_id} - {$entry_type}: ' would behave as above if the article does not have an entry type. If its entry type
were "intro", for example, it would appear in the list as "Q1 - intro: Welcome to our knowledgebase".

Display Article ID  - Whether to display Article ID, last updated date at the top of an article.

Comments
In this section you can control whether and how comments display.

Allow add comments - Select whether to prevent comments, to let only registered users add comments, or let all readers
add comments. If you prevent comments in this field, the rest of the fields in this section are ignored.
Enable visual confirmation - Specify whether to use a CAPTCHA confirmation to prevent robotic spam comments. You can
require no CAPTCHA confirmation, confirmation for non-registered users, or confirmation for all users adding comments.
Comment approval policy - Specify whether comments must be approved before they are added to the knowledgebase.
YOu can accept all comments without approval, require approval only for non-registered users' comments, or require approval
of all comments.
Comment subscription - Specify whether registered users can request a notice to be sent when a comment is added to a
particular article.
Number of comments per page  - Select the number of comments to appear per page. If the number of comments is larger
than the number you specify here, navigation allows readers to move through the pages of comments.
Display comments on the article page  - Check this check box to have comments appear on the same page as the article.
If this option is not selected, a link appears to a separate comments page.
Signature format for commenter - Specify how the commenter's signature appears at the end of the comment.
Options include [first_name], [last_name], [middle_name], [short_first_name], [short_last_name], [short_middle_name], [username],
[email], [phone], [user_id]. You can use multiple tags to construct a signature, such as "[first_name] - ID [user_id]".

Rating
You can let users rate articles in your knowledgebase with these settings:

Allow rate articles  - Check this check box to let users rate articles.
Rating type - Set the type of rating display as stars or text.

Feedback
Allow feedbacks - Check this check box to let visitors to send feedback, rating comments, report an article issues, etc..

Sharing
Allow social sharing - Enable this option to allow visitors to share content on social networking sites.
Social networking sites - This options allows to manage list of social networking sites.
Allow email sharing - Check this check box to let visitors sharing article via email.
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Article preview format
In this section set preview options for an article. This is what the user sees before clicking to view the article itself.

Article character limit - Set how many text characters, starting from the start of the first sentence in the article, display in
the preview. Set this to 0 to display no extract from the article.
Display updated date - Select this option to display when the article was most recently updated.
Display rating - Select this option to display the article's rating.
Display number of comments  - Select this option to display the number of comments this article has.
Display number of views  - Select this option to display the number of views this article has had.

Article information block
In this section set the information that appears when the user opens the article.

Block position - Set whether the article information block, with information such as the article's ID and when it was last
updated, appears to the right or at the bottom of the article.
Display Article block - Select this option to display the article information block.
Display Private block  - Select this option to display private, role-protected information.
Display author block  - Select this option to display author information. Complete the following field to format the
information.
Use format for author block  - Format author information. For example, to display the author's informal first name and last
name, set this field to "[short_first_name] [last_name]". Tags available include:  [first_name], [last_name], [middle_name],
[short_first_name], [short_last_name], [short_middle_name], [username], [email], [phone], [id], [company].
Display number of views  - Select this option to display the number of views the article has had.
Display number of comments  - Select this option to display the number of comments the article has.

Article actions block
Block position - Set whether the actions block appears.
Float Panel - This options allows to manage list of items in Float Panel.
Display "Print" link - Select this option to display an icon the user can click to print the article.
Display "Export to PDF" link  - Select this option to display an icon the user can click to export the article as a PDF file.
Display "Save" link - This option allows to save article to a list for future reference.
Display "Pin" link - This option allows to print, export to PDF, etc. many articles at once.

Saving your settings
Click Save to save your settings. Click Set Defaults to remove any custom settings and restore system defaults.
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Change KBPublisher Look and Feel (design integration)

You can brand the knowledgebase so that it matches the rest of your website. For example, you can include your company logo and
standard buttons on each knowledgebase page.

To set up custom template:

Log on to the knowledgebase
Go the Admin Area
Click on the Settings menu and choose the Public Area -> Common  tab
Click [...] button in the Page Template field which will open new window with page settings
Add a template to Header and Footer section respectively
Add custom css styles, javascript to HEAD element section  
Click Save to save the changes
Go to Public Area to see/test your custome template settings

Notes:

You must be an administrator to do this

----------------------------------------------------------------------
This functionality works in version 5.0 and above
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[v4.5 and below] Change KBPublisher Look and Feel

The template page
If you want to brand the knowledgebase so that it matches the rest of your website. For example, you can include your company
logo and standard buttons on each knowledgebase page.

To create and use custom template:

Create an HTML page based on this example. Remember that you can add as much as you like around the various html tags,
but you must include everything in the example file.
Upload the newly created page onto your server
Log on to the knowledgebase
Go the Admin area
Click on the Settings menu and choose the Public Area -> Common  tab
In the Look & feel (format/template/style)  section, change the Template Page To Load  to the full server path to the
template
(e.g. /usr/www/html/ ..../your_template.html).

Notes:

You must be an administrator to do this
If you prefer, you can set the Template Page to load field to the URL, i.e. http://www.your_domain.com/your_template.html,
rather than to the full server path, i.e. /usr/www/html/ ..../your_template.html, if your PHP installation allows it. (On some PHP
installations this option is not allowed).
Using the URL for the template path (http://www.your_domain.com/your_template.html) cause extra lookups, which will may
affect the performance a litte, hence we recommend that you use the server path name if you can.
If you need to execute php in your template, use the full URL for the template path.

Changing associated CSS
When you modify KBPublisher to fit your site design, you will probably also need to change some css styles as well.

All cascading style sheets used in KB Publisher are in the kbp_directory/client/skin/ directory, where kbp_directory is the name the
directory under which you installed KBPublisher.  Most styles for the public area are defined in kbp_directory/client/skin/common.css.

You are welcome to change these or to add your own. We do recommend, however, that you create a new style sheet and include a
link to the new style sheet in your custom template to overwrite existing KBPublisher styles, rather than change common.css.
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User settings

Default user settings
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User defaults

The knowledgebase administrator sets user defaults when they create the knowledgebase, and can update them at any time.

Security
User setup is part of the security section in the Settings menu:

From the Settings menu choose the Public Area -> Common tab
Go to the Security/Privacy/Registering section

Here you can:

Force users to register before they access the knowledgebase
Determine whether the registration must be approved by a moderator
Determine whether users must complete a visual confirmation code before their registration is accepted
Set the default privilege and role new registered users are created with
Show or hide articles users do not have access to
Set how long before KBPublisher logs an inactive user out.
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Set default user privileges

New users can be created two ways. They can be set up by the knowledgebase administrator, or users can register themselves.

By default, when users register KBPublisher creates them with no privileges. You can change this so that new users are created with
a specific default privilege by:

From the Settings menu choose the Public Area tab
Go to the Security / Privacy / Registering section
Select the appropriate Privilege for new registered users from the drop-down list of privileges
Click Save.

All new users who register after this are created with the new default privilege.

You must have administrator access to change the settings.
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Set Default User Roles

New users can be created two ways. They can be set up by the knowledgebase administrator, or users can register themselves.

By default, KBPublisher creates registered users with no designated role. You can change this so that new users are created with a
specific role by:

First, ensure that the role exists. If it doesn't, create it first
From the Settings menu choose the Public Area -> Common tab
Go to the Security / Privacy / Registering section
Select the appropriate Role for new registered users from the drop-down list of roles
Click Save.

All users who register after this are created with the new default role.
You must have administrator access to change the settings.
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Force users to log on

To force users to log on to even see the knowledgebase, let alone read articles:

From the Settings menu choose the Public Area -> Common tab
Go to the Security/Privacy/Registering section
Check access for registered users only .

To force users to log on before they can read specific sections of the knowledgebase:

From the Articles menu choose the Categories tab
Check each category you wish to force users to log on for
Choose set private from actions with selected  at the bottom of the list of categories
This brings up privacy options for you to select from.  Check Read but do not select any roles from the list

To force users to log on before they can read specific articles in the knowledgebase:

From the Articles menu choose the Articles tab
Check each article you wish to force users to log on for
Choose set private from the actions with selected  at the bottom of the list of articles
Check read but do not select any roles from the list

You can also set private read while you are creating or editing the category or article.

What is the difference between forcing a user to register and forcing them to log on?
When you force a user to register (access for registered users only) they must log on to the knowledgebase before they can read
articles, whether the articles are marked as private or not.

When a user is not forced to register, they can always access the knowledgebase home page, even if they are not registered. They
can read articles that are not marked as private, even if they do not log on. If an article is marked as private, however, then the user
must register and log on in order to read that specific article.
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Allow Users to Register

To set up your knowledgebase so that users register themselves:

From the Settings menu choose the Public Area -> Common tab
Go to the Security/Privacy/Registering section
Check Allow registration
Click Save to save the changes.

When a user comes to the site, they will see a Register option in the top-right-hand corner of the screen (near login). They can
click on Register and will be presented with a screen of user details to fill in. What happens once they fill in the details on that
screen depends on other settings in the Security/Privacy/Registering section.

If you have specified that the user must provide visual confirmation before they can register, the user will also get a code to
type in as part of the registration process
If you checked approval required for registration  then the registration request is sent to the administrator, who must
approve it before the user can log in. If you did not check this option, the user can log in immediately (or at least, as soon as
they get the automated confirmation message)
If you specified a default privilege for new users, the user will be set up with that privilege
If you specified a default role for new users, the user will be set up with that role.
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Allow users to rate articles

You can set up KBPublisher so that users can rate articles.

From the Settings menu choose the Public Area -> Common tab
Check Allow rate articles
If you want the user to add a comment when they give a rating, check Allow feedbacks
Click Save.
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Allow Users to Post Comments

You can set up KBPublisher so that user comments appear immediately, or so that they must be approved first, or you can turn
comment functionality off altogether. You may also identify whether or not only registered users can add comments.

From the Settings menu choose the Public Area -> Articles tab
Go to the Comments section
Specify who can add comments via allow add comments
Specify whether the comments must approved before they appear via the comment approval policy
Specify whether a user must type in a visual confirmation code before they can send the comment via enable visual
confirmation to add comment
Click Save.

You must have administrator access to change the settings.
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Email settings

Setting up emails and communication
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Letter Templates

Preformatted letters
The Letter Template tab is available from the Settings -> Email menu. It controls the format of emails that are sent and received
by the knowledgebase.

Letters with green arrows are mails that are received by the knowledgebase administrator. Examples of these include 'ask a
question' emails or user registrations. Letters with red arrows are mails that are sent to users. Examples of these include registration
confirmation and password reminders.

KBPublisher provides a set number of templates. You cannot add new ones. You can, however, edit existing templates.

Editing letter templates
When you edit a letter template you are presented with an email form that you can modify to suit your own requirements.
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You can include any text you wish.

You can include template fields anywhere in the email or in the header:

The actual fields you can include depend on the letter, but some common ones are:

[support_name] -- this is the name defined in the Support Name field on the Email tab
[support_email] -- this is the email defined in the Support Email field on the Email tab
[support_mailer] -- this is the name defined in the Support Mailer field on the Email tab
[noreply_email] -- the standard "Do not reply to this email" from address
[name] -- the name of the user to whom the mail is being sent or who it is from
[username] -- that person's user name
[first_name] -- their first name
[last_name] -- their surname
[middle_name] -- their middle name
[email] -- their email address
[link] -- a link to the page that this email is about.

The field name must be enclosed by square brackets.

Some email templates also have a field called to Category Supervisor. This field is shown when the letter relates to a specific
article. If you check to Category Supervisor, and the category has a assigned supervisor, then the letter is emailed to the
supervisor rather than to the Support Mailer address.
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Set Who Receives Emails

System emails
You can designate a user, or users, to receive system emails.

From the Settings menu choose the Email -> Letter Template tab.
Type the email of the person who is to receive user communications into the From E-mail / Support E-mail field. You can
input more than one email. Separate each email address with a comma. Everyone specified here will receive system emails.
Type an appropriate name into the From Name / Support Name field . This is the name the user sees in their 'from' field
when they receive an email from KBPublisher.
Add an email address for system-generated messages to users in the No reply email field.
Add the name of the person who will receive notification of all system errors, notifications and warnings to the Admin Email
field. This field also accepts multiple email addresses. If you use multiple emails, separate each one with a comma.
Click Save.

Category emails
You can also specify a user to receive notifications about articles/files/comments in specific categories. This is used when articles or
comments need to be approved.
The 5 letters that can be sent to a category supervisor are:

Approve article (to approver)
Approve file (to approver)
Approve comment (to approver)
New rating comment
Scheduled entry

First, you need to assign a person to receive the emails:

From the Articles or Files menu choose the Categories tab
Edit the category
Click on the add new Supervisor icon
Assign a user from the list of users
OK to save the assignment.

After this, you need to tell the system that the supervisor should receive the emails.

From the Settings menu choose the Letter Template tab.
Edit the letter that is to go to the supervisor
Check to Category Supervisor
OK to save.

Feedback supervisor emails
You can also determine who receives the emails when the user requests feedback through the Ask a Question tab.

This is controlled by the feedback subjects list.

From the Tools menu choose the Lists tab
Click on Feedback Subjects
Edit the subject for which you wish to change the email to be sent
Click on the add new Supervisor icon
Click on Assign for the person you wish to receive emails. You may assign more than one person.  Click assign for each.  
Close the assign user pop-up by clicking on the 'X' in the top right corner.

User Manual v7.5 327



Change text in emails

To change the text in emails sent from, or returned to, KBPublisher:

From the Settings menu choose the Email -> Letter Template tab
Choose the email you wish to change
Click on the edit icon in the Action column
Make the change you require. See E-mail Letter templates for an explanation of fields.
Click Save to save your changes.
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Logs
The Logs menu
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Track search queries

To track what searches users have used to find information in the knowledgebase:

Log in to the Admin Area
Click on the Logs menu
Click on the Search tab

The information displayed on this screen shows:

When the search was done
The string the user typed in 
Categories they searched in
How many results were returned.

You can filter results on

Area of knowledgebase
Whether the search was successful or not
How recently searches were made
Or you can search on a specific search string.

Note: You must have administrator privileges to see log details.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Track emails

To track what emails have been sent, and whether they succeeded or failed:

Log in to the Admin Area
Click on the Logs menu
Click on the Mail Pool tab

The information displayed on this screen shows:

Date and time the mail was created 
Date and time it was sent (or tried to be sent) 
Type of mail it was
How many times the system tried to send the mail 
Whether or not the send was successful
The full log details. These are the details summarized on the mail pool tab, plus the contents of the mail that was sent/tried to
be sent. 

Note: You must have administrator privileges to see mail log details.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Track user logins

To track which users have logged in, and any bad logins:

Log in to the Admin Area
Click on the Logs menu
Click on the Logins tab

The information displayed on this screen shows:

Date and time user last logged in
User ID and username
IP address they logged in from
Type of login. Login types can be 'local', which is a standard login, 'remote', which is when the user logs in using remote
authentication, and 'login as other user', which is when someone with access logs in as another user to test changes they
have made
Whether or not the login was successful
The full log details. If the login was successful, the full log details are pretty that summarized on the logins tab. If the login was
not successful, the full log details add extra information about why the login failed.

Note: You must have administrator privileges to see login details.

Remote authentication logins

For remote authentication every last login is logged to a file called last_remote_login.log in the KBPublisher cache directory
($conf['cache_dir'] in file kb/admin/config.inc.php).
For example: /home/username/kb_cache/last_remote_login.log.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Track scheduled tasks

To track whether a scheduled task has happened as expected, what the scheduled task did, and whether there were any errors:

Log in to the Admin Area
Click on the Logs menu
Click on the Scheduled Tasks tab

The information displayed on this screen shows:

The scheduled task -- frequently, hourly, daily, weekly, and monthly -- in the range column
The time it was last executed
Whether or not the task had errored (is error)
A link to the output of the most recent scheduled task of this type. Click on the icon to see full details.

Note: You must have administrator privileges to see the log details.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Changes for release 7.0
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Setting up Social Site Authentication

Use Facebook, Google, Yandex, or VC authentication to log into KBPublisher, and your users will be spared from remembering
another password.

The system uses the email address supplied by these services to match with an existing user in KBPublisher. If no such user is found,
a new user is created.

Enabling Social Logins
1. As a user with administrator privileges, go to Settings > Authentication Provider .
2. On the Social tab, check Enable ... checkbox for required social site.
3. Provide required ID and Secret Key for the social site.
4. Click Save / Debug to verify that it works.
5. Click Save to enable social logins for checked social sites.
6. Go to your KB login screen to test real social login.

Where can I get social site ID and Secret Key?
See corresponding social site documentation for details.

Google
Facebook
Yandex
VK
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Using Social Sites Login

Social Sites authentication allows you to integrate social login systems with KBPublisher. Configuration requires only a few simple
steps.

Steps to enable Social Login
See this article for details.

Quick summary of the process
End user goes to site.
User clicks a button, such as "Login via [Google]".
Popup appears with Social Site login form or, if already logged in, goes to the next step.
Social Site Authentication checks for valid user credentials.
KBPublisher authenticates the user.

Tracking logins
You can see how your remote authentication works in the KBPublisher login logs, located under Logs > Logins.

For debugging, the most recent remote login is logged to a file called last_remote_login.log in the KBPublisher cache directory
(APP_CACHE_DIR in admin/config.inc.php). For example: /home/username/kb_cache/last_remote_login.log
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Customising page layouts

Page Design settings allows you to customize page layouts for home and download pages. You can move blocks, resize blocks, and
add custom blocks to create your preferred layout.

To set up your own page layouts go to Settings -> Public Area -> Page Design  tab and click the page you want to update.

Updating Page Layout
To move a block, drag from the middle of the block.
To resize a block, drag from the border of the block.
To add a new block to the existing layout, click [+] on the right. In the popup, click on the block and it will be added to the
layout.
To remove a block from the layout, click  on the right in the block.
To cancel your changes, click Reset.
To reset the layout to its default state, click Set Defaults.
Page Header and Menu blocks cannot be moved, resized, or removed from the page layout.

Update Block 
To update a block's properties, click  on the right in the block. Depending on the block, properties can include the title,
number of items, or custom content.

Custom Blocks
Custom blocks allow you to include any content. For example, you could include ads or announcements.
To add a custom block:

Click [+] on the right.
Click Add a custom block .
Add content, and then click Save.
Click on the block and it will be added to the layout.

Title is optional for custom blocks.
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Incoming email - Stop Evaluating Tasks

Mail stops applying rules to a message when it encounters the Stop Evaluating Tasks action.

Tasks ordering and 'Stop Evaluating Tasks' actually server a purpose when you're working with complex tasks. For example, lets say
you want to skip all tasks for auto-generated emails.
You need to create a "Stop Evaluating Tasks" tasks to make this happen.

In the below example "Create news" never trigerred if email is auto-genearetd email.

User Manual v7.5 338



User Manual v7.5 339


	Table of Contents
	User Manual v7.5
	Introduction
	What is KBPublisher?
	KBPublisher Uses
	Public Area (front-end)
	Admin Area (Back-End); Common Actions
	Searching Knowledgebase
	User privileges
	User roles
	Category types
	Ask Question and Quick Response
	Subscriptions
	Article history
	Export articles
	Custom Fields
	Mobile View
	Automations
	Workflows
	Drafts
	Set up required reading (Must Read)

	Installation
	System Requirements
	Installing KBPublisher
	Installing KBPublisher manually
	Upgrading KBPublisher
	Installing ionCube loader
	Setting Up Folder Permissions in Internet Information Services (IIS)
	Setting up scheduled tasks
	Enable searching in files
	Enable Exporting to PDF
	Enable searching spell suggest
	Setup tests

	Getting started
	Summary
	Add a Category
	Add a glossary item
	Add a user
	Final steps
	Add an Article

	Single Sign On
	SAML Authentication
	Using SAML SSO Authentication
	Setting up SAML SSO Authentication
	Configuring OneLogin as an Identity Provider

	LDAP Authentication
	Using LDAP Authentication
	Setting up LDAP Authentication

	Remote Authentication
	Using Remote Authentication
	Using Active Directory for Remote Authentication
	Different ways for Remote Authentication
	Remote Authentication scenarios
	Using Auto Authentication

	Social Sites Authentication
	Setting up Social Site Authentication
	Using Social Sites Login


	Importing
	Import users
	Import articles
	Import glossary
	Add a Local File
	Automatically Add Local Files

	Exporting
	Enable Exporting to PDF
	The Export to PDF and HTML Screens Explained
	Export Articles to PDF or HTML
	Export Articles to CVS, Excel or XML
	Generate file from export template
	Export Articles from the Public Area
	Export articles to PDF in demo mode

	News
	The News Input Screen Explained
	Add News Item
	Edit news item
	Delete news item
	Bulk update news items
	Subscribe to news
	Unsubscribe from news
	Remove scheduling

	Articles
	Articles
	The Article Input Screen Explained
	The HTML editor toolbar explained
	Quick add or update an Article
	Add an Article
	Update an article
	Delete an Article
	Add a Picture to an Article
	Assign category to article
	Link to another article (related articles)
	Attach a file to an article (attachment and embedded link)
	Article history
	The article history screen explained
	Autosave
	Articles being edited by another user
	Remove scheduling
	Add an article as a result of user feedback
	Bulk Update Articles
	Import articles
	Private Articles
	Subscribe to an article
	Unsubscribe from an article
	Add new status
	Add new article type
	Featured Articles
	Adding Code Snippets
	Set up required reading (Must Read)

	Drafts
	Drafts
	Manage Drafts
	Approve or Reject a Draft

	Categories
	What are categories?
	Category types
	Add a Category
	The Category Input Screen Explained

	Article Templates
	What are article templates?
	Using templates in articles
	Add an Article Template
	Article types as templates

	Glossary
	Glossary explained
	Add a glossary item
	Import glossary

	Comments
	Article comments
	Rating Comments
	Bulk update comments, rating comments and feedback


	Files
	What are files and how do they work?
	Add a File
	Bulk update files
	Add a Local File
	Automatically Add Local Files
	Add New File Category
	Private Files
	Assign category to a file
	Delete a file
	Enable searching in files
	Remove scheduling
	Subscribe to a file
	Unsubscribe from a file

	Feedback
	User feedback
	Ask Question and Quick Response
	Reply to feedback from a user
	Add an article as a result of user feedback
	Add New Feedback Subject
	Article comments
	The article comments screen explained
	Rating Comments
	The rating comments screen explained

	Users
	The User input screen explained
	Add a user
	Change user status
	Delete user
	Bulk update users
	Import users
	Companies
	Generating API Keys
	User Activities
	Privileges
	User privileges
	How privileges work
	Create new user privilege
	Change user privilege
	Set default user privileges
	The Privilege Screen Explained

	Roles
	User roles
	Create new user role
	Change user role
	Set Default User Roles

	My Account
	How do I change my password?
	How do I display more articles on a page?
	Change the order articles and files are displayed in
	Subscriptions
	Subscribe to an article
	Unsubscribe from an article
	Subscribe to a file
	Unsubscribe from a file
	Subscribe to news
	Unsubscribe from news


	Reports
	The Usage Report Explained
	The Views Report Explained
	The User Activity Report Explained
	Export Reports
	Statistics
	The Must Read Report Explained

	RSS
	Turn RSS feeds on or off
	Change RSS feed from single feed to separate category feeds
	Subscribe to RSS feed

	Tools
	Tags, Labels
	What are Tags?
	Tagging Content
	Bulk Add or Update Tags
	Managing Tags
	Tags in Public Area

	Custom fields
	Custom Fields
	The Custom Fields Tab Explained
	Add a new custom field
	Add a new custom field range
	Update values in a custom field range
	To see where a custom field is used
	Search in custom fields
	Bulk add or update custom fields

	Lists
	The Lists Tab Explained

	Automations
	Automations
	Manage Automations
	Creating or editing an automation (automated task)
	Incoming email automation (automated task)
	Incoming email - Stop Evaluating Tasks

	Workflows
	Workflows
	Manage Workflows
	Creating or editing a workflow
	Workflow examples


	Settings
	The Admin Tab Explained
	The Public Area Tab Explained
	The Email Tab Explained
	The Export tab explained
	The License tab explained
	How to enable Sphinx Search
	Search engine friendly URLs
	Look and feel
	Customizing Public Area
	Customising page layouts
	Customizing article display options
	Change KBPublisher Look and Feel (design integration)
	[v4.5 and below] Change KBPublisher Look and Feel

	User settings
	User defaults
	Set default user privileges
	Set Default User Roles
	Force users to log on
	Allow Users to Register
	Allow users to rate articles
	Allow Users to Post Comments

	Email settings
	Letter Templates
	Set Who Receives Emails
	Change text in emails


	Logs
	Track search queries
	Track emails
	Track user logins
	Track scheduled tasks

	Changes for release 7.0
	Setting up Social Site Authentication
	Using Social Sites Login
	Customising page layouts
	Incoming email - Stop Evaluating Tasks



